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Functionality of PALM MicroLaser Systems

1 Introduction

1.1 Functionality of PALM MicroLaser 
Systems

PALM MicroLaser Systems are modular in design 
and extremely flexible.

PALM MicroBeam

The PALM MicroBeam offers the greatest degree of 
precision in the field of non-contact laser 
microdissection and manipulation. It can be used 
in virtually all areas of molecular research.

Your PALM MicroBeam is designed to enable you to 
cut sections from your sample and detach them 
from the surrounding material under the micro-
scope, and then to catapult them into a collecting 
vessel. 

PALM MicroTweezers

With your PALM MicroTweezers, you can trap ob-
jects under the microscope and lift them away 
from the plane of the slide. It can be employed as 
stand-alone technology or in combination with 
PALM MicroBeam as the PALM CombiSystem.

PALM MicroTweezers is available in four configura-
tions:
- with a fixed laser beam
- with a 3D movable laser beam
- with one fixed and one 3D movable laser beam
- with two 3D movable laser beams

If you have purchased a system with 3D Laser 
Beam Positioning, you can move a trapped object 
with the laser beam parallel to the plane of the 
slide. The systems with two laser beams enable 
you to trap two objects at the same time and move 
one or both parallel to the plane of the slide.

PALM RoboStage

P.A.L.M. Microlaser Technologies GmbH offers var-
ious microscope stages:
- PALM RoboStage I

Motorized microscope stage for laser micro-
manipulation. High-precision work within the 
sub-micrometer area is possible, as is the 
employment of various holders for slides, Petri 
culture dishes and capillary tubes. 

- PALM RoboStage II
As a further development of PALM RoboStage I, 
it is now possible with PALM RoboStage II to 
process, not only Petri culture dishes for live 
cells, but also to process up to three slides 
simultaneously, which opens up entirely new 
possibilities, especially for work with serial sec-
tions.

Devices for positioning caps or vessels

P.A.L.M. Microlaser Technologies GmbH offers var-
ious possibilities for positioning different caps:
- PALM CapMover

The PALM CapMover has been developed for 
the rapid positioning of caps. The cap, for which 
various inserts are available, is positioned with 
the highest precision over the sample to be col-
lected.

- PALM RoboMover 
The PALM RoboMover is our special P.A.L.M. 
solution for working at high throughput rate. 
Time-saving, automatic sample capture and 
additional sorting functions of the captured 
samples, enable above all, deployment in the 
"routine laboratory". The PALM RoboMover 
makes automatic positioning of caps over your 
sample possible. There are various inserts (col-
lectors) available, each of which contain one or 
more vessels. All of the PALM RoboMover func-
tions can be controlled by the PALM RoboSoft-
ware. 

Fluorescence Unit

With the addition of a fluorescence unit the PALM 
MicroBeam System can be used as a fluorescence 
microscope. According to the equipment (basic or 
advanced), this module can be used for non-simul-
taneous application of fluorescence and laser func-
tion or even for simultaneous laser function under 
fluorescence illumination.
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PALM RoboSoftware

1.2 PALM RoboSoftware

The PALM RoboSoftware is designed to facilitate 
operation and control of PALM MicroLaser Sys-
tems. 

The PALM RoboSoftware places at your disposal all 
the functions you require for precise control of the 
following functions: 
- Display of the microscope image recorded by a 

video camera on the monitor.
- Software-controlled movement of the stage.
- Definition and processing of lines and areas 

(elements) for marking and further processing 
with the laser.

- Measurement of dimensions of the sample 
parts (length and area). The measuring func-
tion offers an approximate value only and must 
be calibrated by the operator with the help, for 
example, of an ocular micrometer.

- Saving and loading of the geometry and posi-
tion of defined elements.

- Export of the element properties: sequential 
number, type, number of laser operations per-
formed, size of area, position, etc.

- Storage of the portion of the microscope image 
viewable on the monitor, either with or without 
the elements included in that portion.

- Loading and saving of settings: movement 
speed of the stage, laser settings, pre-selected 
folders for storing images and elements.

- Processing of the defined elements with the 
laser: automatic cutting along defined lines fol-
lowed by catapulting.

- Processing of a series of samples with the UV 
laser; i.e. the areas to be cut and catapulted 
are defined on one sample and can be trans-
ferred to other samples.

- If you have purchased a system with a motor-
ized microscope, you can also create settings 
for the microscope via PALM RoboSoftware. 

The software can be upgraded in line with your 
specific requirements, e.g. with automatic image 
recognition software or special functions, e.g. for 
Time Lapse experiments.

1.3 Information Center

The function of the "Information Center" program 
is to display and post-process the sample data 
generated using the PALM RoboSoftware. The In-
formation Center recognizes two operating modes: 
File Mode and Database Mode (refer also to chap-
ter 1.6 "File Mode and Database Mode"". Database 
Mode is available only when an appropriate soft-
ware license has been purchased).

The standard version of the "Information Center" 
program (file-based File Mode) can be used for or-
ganizing the stored microscope images. You can 
thus view the stored images, display them in the 
form of a slideshow, save them in a different for-
mat as well as display and edit information that 
was saved with the images.

In the upgraded version of the program (file-based 
and database-based: File Mode and Database 
Mode) you can access even more powerful func-
tions for documenting your work than those in-
cluded in the standard version. If you are working 
with the PALM RoboSoftware in Database Mode 
(refer to chapter 1.7 "Launching and Exiting the 
Program""), not only the images you are saving 
are stored in a database, but also the elements 
you draw, information on samples, experiments 
and microdissection operations. You can also enter 
additional information to be attached to the imag-
es, or you can archive all images and elements for 
the same project together.

In the upgraded version of the Information Center 
you can switch at any time between Database 
Mode and File Mode.
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About this User Manual

1.4 About this User Manual

1.4.1 Contents

This User Manual includes instructions on how to 
move your stage with PALM RoboSoftware, a de-
scription of the steps that are essential before us-
ing the laser functions, and instructions for 
performing them.

Each chapter begins with a brief summary of the 
functions that it covers, followed by instructions 
for using and executing the functions.

The instructions are organized so that they can be 
followed step-by-step. However, you should al-
ways read the summary at the start of each chap-
ter first and familiarize yourself with all the 
operational tasks of a section before you put them 
into practice. A laser function carried out by mis-
take or with incorrect settings could destroy your 
sample. Until you gain experience with the pro-
gram functions, work on samples that are no long-
er required for testing.

This User Manual is prepared on the assumption 
that you have basic computer skills and that you 
can use a computer mouse.

1.4.2 Conventions

To help you find your way around the text, it has 
been organized into distinctive sections.
- Indented paragraphs with a dash provide a 

swift overview of various functions or proper-
ties of PALM RoboSoftware.

• Indented and bulleted paragraphs provide 
instructions for executing certain functions. 

Menu names, menu commands, and the names of 
icon buttons and windows are set in inverted com-
mas. In addition, you will always be referred to the 
menu or bar where the command or button is lo-
cated.

Special markers in the left margin indicate text 
that you must not fail to read:

1.5 Installation

The PALM RoboSoftware is already installed on the 
computer upon delivery or initial operation of your 
system. If you experience problems, or if you want 
to work with another computer, please contact 
P.A.L.M. Microlaser Technologies GmbH. 

Info:
This manual describes all the functions, which 
are available to control all possible options 
(refer to chapter 1.1 "Functionality of PALM 
MicroLaser Systems"). 
Like PALM MicroLaser Systems, the PALM Ro-
boSoftware has been designed on a modular 
basis. During system installation by P.A.L.M. 
Microlaser Technologies GmbH, it will be 
adapted exactly to your system configuration, 
i.e., the program will provide those tools and 
commands which you require to control your 
particular system. Tools and commands 
which relate to components which have not 
been installed, will not appear.

Caution!
This indicates a potentially dangerous situa-
tion. You must observe the precautions 
marked like this to avoid injury or damage. 

Note!
This indicates important information. Read 
this information to maintain your system's 
high level of performance and safety, and to 
prevent malfunction or damage to your sam-
ple.

Info:
This indicates tips on correct use and offers 
useful notes for getting the best use of PALM 
RoboSoftware.
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File Mode and Database Mode

1.6 File Mode and Database Mode

The PALM RoboSoftware recognizes two operating 
modes: File Mode and Database Mode. File Mode is 
always available. Database Mode can only be used 
if an appropriate license has been purchased for 
the PALM RoboSoftware.

In File Mode you can save microscope images and 
elements in folders on a data carrier (e.g. your lo-
cal hard disk). Elements are geometric figures that 
you draw. You may, for instance, identify areas for 
processing with the laser.

In Database Mode, the PALM RoboSoftware is 
linked with a database. If you save images, then 
they are stored in the database. Furthermore, any 
elements that you draw are automatically stored in 
the database in exactly the same way as informa-
tion on samples, experiments and microdissection 
operations. The "Information Center" allows you to 
create databases, and to display and edit their 
contents (read the section in the manual about the 
"Information Center" for more details).

1.7 Launching and Exiting the Program

To launch PALM RoboSoftware:

• Click on the "PALM Robo" icon button on your 
desktop (if you have a desktop shortcut), or
click on "Programs>Palm>PALMRobo" in the 
Windows Start menu.

If your system does not include a database license, 
then the PALM RoboSoftware will be launched. 

If your system does include a database license, 
then you can choose whether to work in Database 
or File Mode (refer to chapter 1.6 "File Mode and 
Database Mode""). Depending on the initial set-
tings (refer to chapter 3.1 "Launching Settings"") 
the PALM RoboSoftware will be launched.
- either in File Mode,
- or in Database Mode with the database pre-

selected under Settings, 
- or there will be a dialog for you to specify which 

mode you wish to start in.

• In this case you should select the database you 
wish to work with and click the "DB Mode" but-
ton, or click on the "File Mode" button if you 
wish to work in File Mode.

To exit PALM RoboSoftware:

• Click on "Exit Palm Robo" in the "File" menu, or
click on the Close button in the top right corner 
of the window, or
press ALT+F4 on the keyboard.

Note!
When the PALM RoboSoftware is launched 
you can choose between database and File 
Modes. Once the program is running this is no 
longer possible. Once the program is running 
it is also not possible to change the database. 
You should exit the PALM RoboSoftware and 
restart it if you wish to change to a different 
mode or database. If necessary you must first 
modify the initial settings as described in 
chapter 3.1 "Launching Settings"".

Info:
When you exit the program, a dialog box may 
appear prompting you to confirm whether you 
want to save your settings or your elements 
(only in File Mode) for future use. Refer to 
chapter 3.4 "Saving and Loading Settings" or 
8.2 "Saving and Loading Elements in File Mode" 
for instructions on how to do this.
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Launching other Programs from PALM RoboSoftware

1.8 Launching other Programs from 
PALM RoboSoftware

PALM RoboSoftware has interfaces with other pro-
grams which means that these programs can be 
launched directly from PALM RoboSoftware. The 
programs concerned are programs for organizing 
and editing images and detecting structure:
- Information Center

(a component of the PALM MicroLaser Systems)
- Imaging Software 

(any image editing program)
- Image Processing Software: Metafer

(can be accessed via P.A.L.M.)
- AxioVision 

(can be accessed via P.A.L.M.)
- Cellenger 

(can be accessed via P.A.L.M.)

1.8.1 Information Center

The PALM Information Center is a component of 
PALM MicroLaser Systems. Its functionality is de-
scribed briefly in chapter 1.3 "Information Cen-
ter"". Further details can be found in the Manual of 
the Information Center.

To launch the "Information Center" program:

• Click on the "Information Center" icon button in 
"Archive Tools", or 
click on menu item "Open Information 
Center ... " in the "File" menu of the PALM 
RoboSoftware main window, or
press F3 on the keyboard.

The "Information Center" program is launched. 
The "Information Center" manual explains how to 
operate this program.

1.8.2 Imaging Software

You can incorporate an image processing program 
of your choice such as Adobe PhotoShop or ACD 
Systems ACDSee (referred to simply as "Imaging 
Software" from now on) into the PALM RoboSoft-
ware. Refer to chapter 3.7 "Incorporating an Im-
aging Editing Program" for instructions on how to 
do this. 

To launch the Imaging Software:

• Click on the "Imaging Software" icon button in 
Archive Tools, or
click on menu item "Open Imaging ... " in the 
"File" menu of the PALM RoboSoftware main 
window, or
press F2.

The Imaging Software you have incorporated will 
be launched. Instructions for working with this 
program are the subject of the program’s user 
manual.

1.8.3 AxioVision and Cellenger

To allow you to enhance your system P.A.L.M. of-
fers not only "Metafer" but also certain other ap-
proved image processing programs which, for 
instance, enable you to localize specific objects or 
structures within your microscope image with an 
automated search function: these programs are 
"AxioVision" and "Cellenger". Both of these pro-
grams can be activated in Navigator (refer to 
chapter 6.4 "Analyzing Images Using the 
"Cellenger" Software"" and chapter 6.5 "Analyzing 
Images Using the AxioVision Software"").

Information Center

Info:
The image processing software is not a PALM 
product. Neither does P.A.L.M. supply such 
software.

Imaging Software
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Launching other Programs from PALM RoboSoftware

1.8.4 Image Processing Software

The program "Metafer", a program for automatic 
detection of structures on your sample, is desig-
nated here as image processing software.

To launch the Image Processing Software:

• Click on menu item "Open Image 
Processing ... " in the "File" menu of PALM 
RoboSoftware, or
click on the "Image Processing" icon button.

If the "Image Processing" icon button is not dis-
played, follow the instructions in chapter 2.2 "Cus-
tomizing the User Interface" to switch on this 
display.

The Image Processing Software will be launched. 
Instructions for working with this program are the 
subject of the program’s user manual.

Image Processing

Info:
If you have decided to purchase a system 
without Imaging Software, the symbol de-
scribed above does not appear in your PALM 
RoboSoftware and the menu command is in-
active.
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The PALM RoboSoftware Layout

2 Program Layout and Operation

2.1 The PALM RoboSoftware Layout

When the program has been launched, the main 
window of the PALM RoboSoftware as depicted 
above will appear, showing the camera image, the 
Menu Bar, various icon bars and tools, as well as 
the Status Bar. 
The icon bars, the tools and the Status Bar can be 
toggled on and off, as shown in chapter 2.2 "Cus-
tomizing the User Interface".

In the area of the camera image you will see vari-
ous markings and information: 
- Red crosshairs; these mark the exact center of 

the image. 
- A green solid triangle (the UV Laser Marker), a 

red square and (if you purchased the Double-
Beam System) a green square (the IR Laser 
Markers). The Laser Markers indicate the target 
for the laser.

- You will see a dotted line rectangle on the bor-
der of the image - this is the "Scroll Rectangle".

Menus

Speed 
Tools

Archive
Tools

Laser
Tools

Graphic
Tools

Fluorescence 
Tool

Lens Tool

Switch IR 
Laser On/

Off

Cut Tools

Tool Bar

Start 
UV Laser

Device 
Tool Bar

Microscope 
Tools

Image Process-
ing Tool

Time Lapse 
Tool

Status BarColor Palette

UV Laser, 
IR Laser 
Status

Info:
The possible options (refer to chapter 1.1 "Func-
tionality of PALM MicroLaser Systems") which 
are available, are dependent upon the configu-
ration of your system. This can be adapted to 
your personal requirements. Please contact 
P.A.L.M. Microlaser Technologies GmbH, if you 
wish to upgrade your system.

Info:
If the camera image does not appear when the 
program is launched, check that all connections 
to the microscope and also the settings on the 
microscope have been made correctly.



14 PALM RoboSoftware 3.1-0106 (EN)

The PALM RoboSoftware Layout

- At the bottom on the left a scale bar and Copy-
right Note (if specified) are displayed. (chapter 
9.1 "Inserting a Copyright Note" explains the 
procedure).

The Status Bar at the bottom of the program win-
dow provides you with information on a number of 
current settings. Some of the fields feature a win-
dow that opens when the field is double-clicked.

- If you double-click on the field, the "PALM Robo 
Information" window will open (refer to chapter 
2.4.5 "PALM Robo Information").

- The second field indicates which slide is being 
shown on the monitor (this only applies when 
you are using a slide holder that accommodates 
more than one slide), or a message is displayed 
whilst elements are being calculated by the 
PALM RoboSoftware.
If you double-click on the field, the "Navigator" 
window will open (refer to chapter 6 "PALM 
Navigator").

- The third field shows the name of the current 
active setup file (file extension .set). If you 
have not saved or loaded any settings, which 
means that you are working with the "factory 
defaults", this field is empty.

- The fourth field shows either the number of the 
drawn elements or the number of the element 
presently positioned at the center of the image 
(x of ...) and the number of all existing ele-
ments (... of y).
If you double-click on the field, the "Element 
List" window will open (Chapter 7.3 "The "Ele-
ment List" Window" describes how to use this 
window).

- The fifth field shows the current program mode 
(Cursor Mode, Stage Mode, Scrolling, Calibra-
tion, Laser-Point, Continuous, Position, Laser 
ON, 3D-1, 3D-2). If you are just in the process 
of drawing or editing an element, its current 
size is indicated. If no action is currently in 
progress, then "Idle" is displayed.

- The field on the right shows the coordinates of 
the unit currently being moved or most recently 
moved.
Stage:
current coordinates relative to the point of ori-
gin of the drawing plane (x/y). When the stage 
is actually moving, the green ball in this field 
changes to yellow.
The point of origin of the drawing plane is per-
manently preset (refer to chapter 5.4 "The Ref-
erence Position of the Stage").
3D Offset:
Coordinates of the laser focus point relative to 
the point of origin of the 3D adjustment. 
You can change the point of origin of the 3D 
adjustment.
RoboMover:
Coordinates of the RoboMovers.

If you double-click in the field, the "States" win-
dow will open. Amongst other things, this win-
dow displays the coordinates of all units (refer 
to chapter 2.5 "Status Display").

Info:
The crosshairs, the scroll rectangle, the scale 
bar and the Copyright Note and also the inclu-
sion and appearance of the Laser Markers can 
all be turned on/off or modified, as explained in 
chapter 2.2 "Customizing the User Interface".
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2.2 Customizing the User Interface

PALM RoboSoftware offers a number of ways to 
customize the appearance of the program window 
to meet your requirements. 
- You can change the size of the program win-

dow. The aspect ratio of the microscope image 
remains unaltered.

- You can display or hide all icon bars, tools and 
the Status Bar.

- You can reposition all icon bars; you can re-
arrange the respective positions of adjacent 
icon bars both horizontally and vertically.

- You can display or hide the Crosshairs, the 
Laser Markers, the Scroll Rectangle, the Scale 
Bar and the Copyright Note.

- You can change the appearance of the Laser 
Markers.

These changes are retained after the program has 
been restarted.

You resize the program window in the same way as 
in all Windows programs.

To display or hide a bar or a tool using menu 
commands:

• In "View>Menus", click on the 
name of the bar or tool that you want to show 
or hide.

A tick beside the name indicates that the bar or the 
tool is shown.

Some icon bars and tools can also be displayed or 
hidden using keyboard shortcuts.

To display or hide a bar or tool using key-
board shortcuts:

• Press one of the following keyboard combina-
tions:

To move an icon bar:

• click on the vertical white bar on the left edge 
of the icon bar that you want to move, and

• drag and drop the bar in the desired position. 
Release the mouse button.

To switch the Scroll Rectangle or the screen 
center display on or off:

• In the "View" menu, click on "Scroll Rectangle" 
or "Screen Center".

A tick in front of the menu entry indicates that the 
Scroll Rectangle or the screen center is being 
shown. These settings will be retained after you 
exit and relaunch the program.

To show or hide the Scale Bar:

• Click on menu item "Yardstick" in the "View" 
menu.

A tick on the left of the menu entry indicates that 
the Scale Bar is displayed. This setting will be re-
tained after you exit and relaunch the program.

The size of the Scale Bar is dictated by the PALM 
RoboSoftware depending on the magnification set-
ting; this cannot be modified.

Info:
Please note that the following possible set-
tings described here, may not be available, 
depending upon the configuration of your 
PALM MicroLaser System.

Ctrl+G to display/hide the Graphic Tool-
bar

Ctrl+U to display/hide Cut Tools

Ctrl+P to display/hide the Color Palette

Ctrl+L to display/hide Laser Tools

Ctrl+E to display/hide Speed Tools

Note!
The scale is dependent on the calibration (re-
fer to chapter 4 "Calibrating the System").
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To show or hide the Copyright Note:

• Click on menu item "Copyright" in the "View" 
menu.

A tick on the left of the menu entry indicates that 
the Copyright Note is displayed. This setting will be 
retained after you exit and relaunch the program.

In this way, you can switch the display of a 
Laser Marker, on or off:

• In the "Laser-Marker" menu, click on menu 
item "View Laser-Marker".

A submenu opens containing a list of all available 
Laser Markers.
• Click on the name of the Laser Marker you want 

to show or hide.

These settings will be retained after you exit and 
relaunch the program.

To change the appearance of a Laser Marker:

• In the "Laser-Marker" menu, click on menu 
item "Layout Laser-Marker".

A submenu opens containing a list of all Laser 
Markers.

Click on the name of the Laser Markers whose ap-
pearance you want to change. This opens the "La-
ser-Marker" window.

The top section of the window contains three se-
lection fields. In the "Laser Marker" field you can 
select the Laser Marker whose appearance you 
want to change. The Laser Marker you chose in the 
menu for opening the window is selected by de-
fault.

If you want to change the appearance of more 
than one Laser Marker, you can change from one 
to the other here.

• If you want to change the shape of the Laser 
Marker, open the "Type" selection list by click-
ing on the arrow in the left border of the field 
and select the shape you want.

• If you want to change the style of the Laser 
Marker, open the "Style" selection list by click-
ing on the arrow in the right border of the field 
and select the style you want.

Info:
Don't forget that the Copyright Note can only 
be displayed if you have defined it in advance 
(this procedure is explained in chapter 9.1 
"Inserting a Copyright Note").
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• To change the height and width of the Laser 
Marker, enter the appropriate figures in the 
Height and Width fields, or change the existing 
settings by clicking the arrow buttons on the 
left side of the fields.

• If you want to change the line thickness of the 
border, enter a numerical value in the field for 
"line", or change the value set there by clicking 
on the arrow buttons to the left of the field.

• To change the color of the Laser Marker, click 
on the "Color" Button.

This opens the "Color" window.

• Choose a color or define a new color.
• Close the "Color" window by clicking on "OK".
• Close the "Laser-Marker" window by clicking on 

"OK".

2.3 Operation

All program functions are accessible via the menu 
bar or the "Graphic Toolbar". Many frequently used 
functions can also be activated via buttons in the 
icon bars or by means of special tools or keyboard 
commands.

2.3.1 Mouse

You will almost always be working with the prima-
ry mouse button, that is the left mouse button in 
the default configuration. If it is necessary to use 
the secondary mouse button, the right button in 
the default configuration, this will be indicated ex-
plicitly.

2.3.2 Keyboard Shortcuts

There are additional keyboard shortcuts for sever-
al functions. These are summarized in Appendix B: 
Keyboard Shortcuts. 

2.3.3 Context Menu

Several functions can also be accessed via the 
Context Menu

To open the context menu:

• Right click on any dot in the image.

As soon as you have selected a command or when 
you left-click anywhere outside the context menu, 
the context menu will close.

Info:
The line thickness setting only has an effect if 
you have selected "line" as the style.
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2.3.4 Software Modes

PALM RoboSoftware works in a number of modes: 
Cursor Mode, Stage Mode, Freeze Mode, Scrolling, 
Calibration, Laser-Point, Continuous, 
Position, Laser ON, 3D-1, 3D-2. The active mode 
is displayed on the Status Bar. You can, and in fact 
must, switch between Cursor Mode and Stage 
Mode or Freeze Mode, and between Cursor Mode 
and 3D-1 or 3D-2 Mode manually. All other modes 
are activated/deactivated automatically by the 
program when the corresponding functions are se-
lected.
- Cursor Mode: This is the standard mode which 

opens by default when the program is 
launched. In Cursor Mode you can open menus, 
select functions, click on icon buttons or draw 
elements.

- Stage Mode: In Stage Mode you can synchro-
nize the movement of the stage with that of the 
mouse. Chapter 5.1.1 "Positioning the Stage 
with the Mouse: Stage Mode" includes instruc-
tions on how to proceed and how to switch 
between Cursor Mode and Stage Mode. 
In Stage Mode, you can only access commands 
and functions that can be operated with key-
board commands.

- Freeze Mode: In Freeze Mode the movement of 
the stage and the microscope image on the 
screen is frozen. 
In Freeze Mode, all functions that cause or 
require movement of the stage (such as scroll-
ing, positioning of elements, targeting specific 
points, positioning a Laser Marker, laser func-
tions) are blocked. 
This function is particularly useful when work-
ing with fluorescence (refer to chapter 12.5 
"Freeze Mode").

- 3D-1 Mode and 3D-2 Mode (only if you have 
purchased a system with one or two 3D mov-
able IR laser beams): In 3D-1 [3D-2] Mode you 
move the IR laser beam synchronously with the 
mouse. Chapter 11.8 "The 3D Laser Beam Posi-
tioning" includes instructions on how to pro-
ceed and how to switch between Cursor Mode 
and 3D Mode. 

2.4 Help and Information about PALM 
RoboSoftware

PALM RoboSoftware includes a general Help Func-
tion (PALM Robo Help), as well as a tutorial for sev-
eral very important functions: the PALM Robo 
Instructor. You can also call up information about 
the program and the manufacturer.

2.4.1 Online Help

Online Help provides information about the 
program layout and the meaning of the icon but-
tons, the menu commands and the tools.

To open the Online Help:

• Press F1, or
click on "PALM Robo Help" in the "Help" menu.

The Help window opens.
• Click on the point in the Help window about 

which you have questions, or open the glos-
sary. To navigate, you can also use the context 
menu: Open the context menu by right-clicking 
anywhere in the Help window and choose 
"Back" or "Forward" depending on whether you 
want to page backwards or forwards.

To close the Help window:

• Right-click on the title bar. A context menu will 
open. Click on the "Close" item here, or
press key combination "Alt+F4".

The Help window will close.

2.4.2 The PALM Robo Instructor

The PALM Robo Instructor explains in detail how to 
carry out the following functions:
- Calibrating the System
- Defining the Lens Offset
- Saving elements in a file
- Retrieving elements from a file.

Info:
This section refers to the software modes of 
the PALM RoboSoftware. These are totally 
unrelated to the Database and File operating 
modes.

Info:
All of these functions are also explained in de-
tail in this User Manual (chapter 4 "Calibrat-
ing the System" and chapter 8.2 "Saving and 
Loading Elements in File Mode"). 
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To open the PALM Robo Instructor:

• Click on "PALM Robo Instructor" in the "Help" 
menu.

The "PALM Robo Instructor" window will open.

• Click on the function about which you want 
more detailed information.

The "PALM Robo Help" window opens; the required 
help topic is displayed.

The "PALM Robo Instructor" window stays open. If 
you arrange both windows side by side on your 
monitor, you can select several or all topics in the 
Instructor one after the other and have them dis-
played in the Help window.

To continue working with PALM RoboSoftware, you 
must close the "PALM Robo Instructor" window 
again. You can leave the "PALM Robo Help" win-
dow open.
• Click on "OK" in the "PALM Robo Instructor" 

window, or click on the Close button in the top 
right corner.

2.4.3 Program and Manufacturer

To view information about the program and 
the manufacturer:

• Click on "About" in the Tool Bar or
click on "About PALM Robo ... " in the Help menu.

A window opens with information about the ver-
sion number and the manufacturer.

• Close the window by clicking on "OK".

About

Info:
You can click on "eMail" and "Internet" to ac-
cess the manufacturer's Website or send an e-
mail via your e-mail program, as long as you 
are connected to the network.
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2.4.4 System Information

To display a range of information about the 
system:

• Click on "PALM Robo Systeminfo ... " in the 
Help menu.

• A window containing information about your 
system will open.

2.4.5 PALM Robo Information

The "PALM Robo Information" window shows all 
the messages output by the program both when it 
is launched and whilst it is running.

To open the "PALM Robo Information" window:

• Double-click in the field at the leftmost end of 
the Status Bar.

The "PALM Robo Information" with its message 
history is opened.
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2.5 Status Display

The PALM RoboSoftware "States" window provides 
you with details of the current status of your sys-
tem components. 

To open the "States" window:

• Double-click in the field at the rightmost end of 
the Status Bar. 

The system components are shown in the left-
hand column, and the current status in the right-
hand column. Columns "X", "Y" and "Z" provide 
information on the current coordinates of each 
component.
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3 Settings

When working with PALM RoboSoftware, you will 
create various settings. If you
- draw elements
- move the stage
- activate the laser
- save elements, images and settings.

You will also make various general settings which 
enable you to adjust the PALM RoboSoftware to 
your specific requirements.

All settings can be changed at any time while you 
are working.

All of your settings will be retained until they are 
actively changed again, even if you exit the pro-
gram and relaunch it. For lasting reliability you can 
also save your settings in a file. If you want to 
work on the same or a similar sample in future, 
you can load these settings again and work with 
them. 

All factory default settings can be restored at any 
time.

The following section provides instructions for 
- configure settings for launching PALM 

RoboSoftware
- switch software over for different slideholders 

(only PALM RoboStage II)
- turn automatic focusing on and off for saved 

and reloaded elements
- configure settings for the saving of settings
- saving and loading settings. 

You can also find information on 
- unlocking software components purchased 

later
- setting a short-term alarm.

All other settings are explained in detail 
elsewhere:
- Settings for moving the stage: chapter 5.3 

"Setting Speed".
- Settings for drawing elements: chapter 7.8 

"Changing Colors and Line Thickness".
- Settings for the laser functions: chapter 4 "Cal-

ibrating the System", chapter 10.5 "Specifying 
Laser Settings" and chapter 11 "Tweezers (Op-
tion)".

- Settings for saving elements: chapter 8.1 "Set-
tings for Saving Elements in File Mode".

- Settings for saving images: chapter 9 "Saving 
Images".

3.1 Launching Settings

If your system does not include database function-
ality, you will always be working in File Mode. In 
this case there is no need to configure the launch 
settings.

If your system does include database functionality, 
you can choose whether to work in Database
Mode or File Mode. The PALM RoboSoftware allows 
you to specify which mode the program should 
start in:
- File Mode: the program will start up in File 

Mode; database functionality is not available.
- Database Mode with selectable database; when 

the program is launched you can select which 
database you would like to use, or whether you 
wish to work in File Mode.

- Database Mode with pre-selected database: 
you can specify a database for PALM RoboSoft-
ware to open automatically when it is launched.

To specify which mode PALM RoboSoftware 
should start up in:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. The "Configuration" tab will be displayed.

• In the "Operating Mode" section select the 
mode for PALM RoboSoftware to operate in 
when launched.

Info:
The procedure for creating a database is de-
scribed in the Information Center Manual.



24 PALM RoboSoftware 3.1-0106 (EN)

Setting Slideholder

If you have chosen "Database Mode with pre-se-
lected DB": 
• Choose the database you wish to work with 

(using either the selection list or the button 

).

• If required, enter the relevant User ID and 
password.

• Close this window by clicking on "OK".

3.2 Setting Slideholder

PALM RoboStage supports a variety of different in-
serts: slides, Petri dishes or capillaries. Several 
windows in the PALM RoboSoftware contain tabs 
which depict the insert or which provide a separate 
tab for each slide (refer to chapter 6 "PALM Navi-
gator" or chapter 7.3 "The "Element List" Win-
dow"). The software must be notified about which 
insert you are using.

To set the type of slideholder that is being 
used:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. The "Configuration" tab will be displayed.

• In the "Stage" section choose the slideholder 
you are using.

Close this window by clicking on "OK".

Note!
You can protect your database with a pass-
word and user ID (see Information Center 
Manual). If you enter this information here, 
then the PALM RoboSoftware will be 
automatically linked with the selected data-
base every time it is launched. This means 
that every user who starts the PALM Ro-
boSoftware will have access to your data-
base.

To prevent unauthorized access to the data-
base it is therefore not advisable to enter 
the User ID and password here in the launch 
settings. These will then be requested each 
time the PALM RoboSoftware is launched.

Note!
It is not possible to switch between File and 
Database Mode or to change database from 
within the PALM RoboSoftware. You should 
exit from the PALM RoboSoftware and restart 
it if you wish to change to a different mode or 
database. If necessary, you must change the 
launch settings as described above.
If more than one user is working on the sys-
tem and using various different databases or 
modes, you are advised to choose the start-
up setting "Database Mode with selectable 
DB". 
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3.3 Turning on Automatic Focusing for 
Elements

In addition to the coordinates describing its posi-
tion on the drawing plane (x and y coordinates), 
each element also has a z coordinate. This z coor-
dinate is represented by the focus value of the mo-
torized microscope. When you save elements, this 
z coordinate is also stored with each element (re-
fer to chapter 8 "Saving and Printing Elements" for 
details of how to store elements).

As you approach elements, the focus is automati-
cally set to the appropriate value. 

However, focusing is also temperature-dependent. 
This means that if the temperature is different 
when an element is approached than it was when 
the element was drawn, there is a possibility that 
the focus setting will be incorrect. Correct focusing 
is only possible if the work area has a stable tem-
perature and if your system has been moderated 
for a sufficient length of time (see Zeiss micro-
scope manual for further information). The fluctu-
ation in room temperature must not exceed 2 
degrees, and your system should be moderated 
for a minimum of four hours.

In order to avoid focusing problems you can turn 
the automatic mode on and off; the system will 
then automatically use a stored value.

To turn automatic (stored value) focusing on 
and off:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Elements" tab.

• Tick the check box "Go to the element z-focus" 
if focusing is to be carried out automatically.

3.4 Saving and Loading Settings

You can save your settings in a file and reload 
them for future work. This also means that a back-
up copy is created of all the settings you have 
made.

To save settings, you can
- specify a folder.

When you save your settings later, this folder 
will be selected automatically. However, you do 
not have to accept this specification. You can 
also save your settings later in another folder. 
You can also create a new folder when saving.

- specify, whether the settings should be saved 
automatically when the program is closed.

To specify a folder for saving the settings:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. The "Configuration" tab will be displayed.

The name and full path of the currently set folder 
appears in the "Folder" field of the "Saving Set-
tings" section. Now you can either specify a folder 
via the "Folder" field or via the button to the right 
of the field, or create a new folder.

If you want to specify a folder in the "Folder" field:
• Enter the name and full path of a folder in the 

"Folder" field.

If you wish to select a folder using the button:
• Click on the button . 

The "Setting Folder" window opens. A directory 
tree structure is displayed in the window, and the 
currently set folder appears underneath in the 
"Folder" field.
• Select the desired folder or create a new folder.
• Close the "Setting folder" window by clicking on 

"OK".

You are back in the "Configuration" register in the 
"Preferences and Configuration" window.

Info:
You can also enter the name of a folder that 
does not yet exist. It will be created automat-
ically when you exit the window. 
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To save your settings automatically when 
exiting the program:

• To toggle this function off or on, tick the "Save 
settings on program exit" check box in the 
"Saving settings" section of the "Configuration" 
tab in the "Preferences and Configuration" win-
dow.

A tick in the checkbox indicates that the function is 
enabled.

To save your settings:

• Click on "Save Settings ... " in the "Setup" menu.

The "Save Settings ..." window opens. The folder 
that you have specified for your settings files 
opens automatically.
• Select a different folder to store your settings 

files as necessary.
• Enter a name for your file and click on "Save".

The window will close. The new file name will ap-
pear in the Status Bar.

To load a settings file:

• Click on "Load Settings ... " in the "Setup" 
menu.

The "Load Settings" window opens.
• Select the settings file you want to load and 

click on the "Open" button.

The window will close. The name of the settings file 
will appear in the Status Bar.

Info:
The PALM RoboSoftware essentially saves the 
settings which are valid on exiting the pro-
gram. These settings are automatically load-
ed at the next start and remain valid until you 
change them or load a previously saved set-
tings file.
The function described here saves your set-
tings in a file that can be reloaded any time - 
even if you have changed the settings in the 
meantime (see note below).

Note!
The default setting "Save Settings on pro-
gram exit" is effective only, if you 
- have saved your settings once already 

during your work, or 
- have loaded a settings file. 
If you subsequently change the settings, they 
will be saved automatically to the current 
settings file when you exit the program. (The 
name of the current settings file appears in 
the Status Bar.)
The current file will also be overwritten.
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3.5 Restoring Settings

You can restore the factory default settings at any 
time. 

To restore settings:

• Click on "Load Factory Defaults ... " in the 
"Setup" menu.

A prompt will appear: "Do you really want to take 
factory settings?"
• Confirm the prompt by clicking on "Yes".

The Status Bar no longer displays the name of a 
settings file. All the settings you have made are 
now replaced by the factory default settings.

3.6 Unlocking Add-On Software Compo-
nents

PALM RoboSoftware contains a number of compo-
nents that need to be unlocked before use. 

When your system is first set up, all the software 
components that you have purchased are already 
unlocked. If you purchase additional components 
later you will receive a license key that can be used 
to unlock them.

To unlock add-on software components:

• Click on the "About" icon button in the Tool Bar, 
or
click on "About PALM Robo ... " in the Help 
menu.

This opens the window "About PALM Robo".

• Click the "Enter New License" button in the 
"License" area.

A window will open up.
• Enter your new license key, then click the "OK" 

button.

The new license key is displayed in the "License 
key" field in the "About PALM Robo" window; the 
new software component can now be used.

Note!
If you restore the settings, all those settings 
which you created will be deleted including any 
change in the position of the Laser Marker. 

About

Info:
If you enter an invalid license key by mistake, 
your previous key will be entered automatically.
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3.7 Incorporating an Imaging Editing 
Program

You can incorporate an image management and 
editing program (e.g. Adobe Photoshop or ACD 
Systems ACDSee) in such a way that it can be 
launched from within the PALM RoboSoftware. This 
type of software will referred to as "Imaging Soft-
ware" from now on. You only must define the pro-
gram path in the PALM RoboSoftware.

To define the path to an Imaging Software:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Images" tab.

• Click on the button with three dots in section 
"Imaging Software". 

The "Select the imaging software" window opens.
• Select the desired program and close the win-

dow by clicking on "Open".

In the "Configuration Path" field the program path 
is now entered.
• Close the "Preferences and Configuration" win-

dow by clicking on "OK".

Chapter 1.8.2 "Imaging Software" explains how 
the imaging software can be launched.

3.8 Short-Term Alarm

The PALM RoboSoftware features a short-term 
alarm which can be set for a pre-defined time (1, 
2, 3, 5 or 10 minutes) or for any time of your 
choice (in seconds and minutes). There is also an 
option to enter a message text. At the end of the 
specified period a brief audible tone is sounded 
and a message window is displayed showing any 
text that you may have entered.

You may wish to use this short-term alarm as a 
timekeeper in time-critical operations or as a re-
minder to switch off the IR laser with temperature-
sensitive samples or to switch off the fluorescent 
illumination with samples sensitive to fluorescence 
before the sample begins to suffer any damage.

To set the short-term alarm:

• Click the "Alarm Bell" icon button on the Tool 
Bar.

The "Alarm Bell" window opens.

• Select the required time and enter a message if 
you want to.

• Start the alarm timer by clicking the "OK" but-
ton.

Info:
The image processing software is not a PALM 
product. Neither does P.A.L.M. supply such 
software.

Alarm Bell



PALM RoboSoftware 3.1-0106 (EN) 29

Set Image Parameters

3.9 Set Image Parameters

You can modify the way in which your microscope 
image is displayed in order to make any areas that 
are of particular interest for your work stand out 
more clearly. You may, for instance, want to run 
an analysis under "Cellenger" or "AxioVision" (see 
preceding chapter) because of the clearer results 
they produce. 

Facilities for adjustment are available in the "Life-
Image" window. You can also avail yourself there 
of the facility to read colors and brightness values 
from your image and display them.

So it is worth trying to obtain a optimum result from 
the camera in the first place. The settings can be 
seen immediately in the live image, but cannot be 
seen in the Navigator (refer to chapter 6 "PALM 

Navigator") until the image has been scanned.

To set the image parameters:

• Click on the "Life image tools" icon button in the 
Tool Bar.

This opens the "LifeImage" window. In the "View 
settings" area you will find sliders for setting vari-
ous parameters. The "Measurement tools" area 
provides information about the image.
• Alter the parameters in the "View Settings" 

area to produce the desired result (move the 
sliders, click on the arrow icon buttons or enter 
the values in the relevant fields).
- Contrast: When contrast is increased, light 

parts of the image become lighter and dark 
parts become darker, i.e. differences in 
brightness are accentuated. Reducing the 
contrast has the opposite effect.

- Brightness: the entire image becomes 
lighter or darker. You should be aware that 
if the brightness setting is altered too much 
the light parts of the image may become 
completely white or the dark parts com-
pletely black.

- Saturation: changes color saturation. 
Reducing this setting results in a weakening 
of the colors leading ultimately to a black/
white image; increasing it results in 
extremely intensive colors.

- Hue: changes the coloration of your image. 
Imagine every selectable color arranged in a 
circle, from blue through violet to red, 
orange, yellow, green and cyan, then back 
to blue again. When you change this setting, 
the colors are shifted in this circle, e.g. blue 
becomes violet, violet becomes red, etc. and 
cyan becomes blue. The more you change 
this setting, the greater the shift in colors.

- Gamma: corrects the linear nature of the 
brightness pattern between black and white.

To set the image parameters back to their 
default values:

• Click on the "Reset to default" button in the 
"View settings" section.

All parameters are reset to their default values.

Info:
Any changes made here will only affect the 
image on the screen, and not the original 
camera image, in other words you are not re-
configuring any camera settings.

Info:
You should bear in mind that one conse-
quence of changing the image parameters is 
that there may be a delay before the image 
appears on the screen, because each time a 
change is made (e.g. the stage is moved) the 
original camera image must be recalculated.

Life image tools
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To display the color values and the bright-
ness of individual points in the image:

• Click on the "Pickup" button in the "Pixeldata" 
section.

• Click on the point in the image whose color val-
ues and brightness you wish to display.

The fields "Red", "Green" and "Blue" show the 
brightness values for the three primary colors and 
their ratio to one another, while the "Brightness" 
field shows the brightness of the selected point in 
the image.

To display the lowest and highest brightness 
value for the entire image:

• Click on the "Refresh" button in the "Image-
data" section.
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4 Calibrating the System

Recalibration is only necessary, if, despite exact 
positioning of the Laser Marker and correct choice 
of objective, differences occur between the drawn 
contours and those processed by the laser.

Carry out a recalibration as described in chapters 
4.1 to 4.5 and 4.7. You can reset the calibration to 
the factory default setting at any time (refer to 
chapter 4.6 or 4.8).

4.1 Preliminary Remarks

To achieve the desired results with the laser func-
tions, the following points must be fulfilled:
- the program must be set to the microscope's 

magnification setting,
- and the movement of the stage and the IR laser 

(if you have installed a system with 3D Laser 
Beam Positioning) must have been calibrated,

- the Laser Markers (in the default setting, the 
green triangle or the red and green squares in 
the middle of the monitor) must have been 
aligned with the laser foci, and

- if the magnification is changed, any deviations 
through the objectives must be compensated 
(Lens Offset). 

Calibrating with the software establishes a rela-
tionship between the dots in the image and the ac-
tual positions of the stage. This ensures that 
automatic laser functions are performed at pre-
cisely the required locations.

The Laser Markers must mark the points where the 
laser beams strike the sample. To check the cor-
rect setting of the Laser Markers, you must release 
the laser. Hold a sample that you no longer need 
for examination, or one containing areas that are 
no longer needed for examination ready. 
A slide that has been colored with a black felt pen 
is particularly helpful for setting and checking the 
IR Laser Marker.

You must check the positions of the Laser Markers 
after every magnification change, and correct 
them as necessary.

Note! 
The system is calibrated by the manufacturer 
for the objectives with which it is supplied. It is 
therefore not usually necessary to recalibrate 
(only applies to the supplied objective or such 
objectives marked with the P.A.L.M. logo).
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4.2 Setting the Magnification

Before you start work, you must set the micro-
scope magnification in PALM RoboSoftware.

To select the required magnification:

• Click on the triangle at the right edge of the 
field in the Lens menu.

A list will open displaying the available magnifica-
tions settings.
• Click on the option corresponding to the mag-

nification that has been set on the microscope.
• Adjust the microscope to the desired magnifi-

cation (only necessary for a manual micro-
scope; on motorized microscopes adjustment is 
automatic).

4.3 Setting the Laser Marker

In the default configuration of the program, the 
Laser Markers are represented as a solid, green 
equilateral triangle (UV Laser Marker) in the center 
of the monitor and a red (IR-1 Laser Marker) or 
green (IR-2 Laser Marker, Double Beam System 
only) square. The apex (of the triangle) or the cen-
ter (of the squares) should indicate the point at 
which the respective laser beam will strike the 
sample upon release.

To set a Laser Marker position correctly, you must 
release the laser and determine its actual focus 
point. Then you must set the associated Laser 
Marker to the focus point of the laser.

In order for you to be able to check the position of 
a Laser Marker and adjust it if necessary, the Laser 
Marker must be displayed.
• Verify that the Laser Marker whose position you 

want to check is displayed, and if necessary 
enable the display (click on the "View Laser 
Marker" item in the "Laser Marker" menu; a 
submenu will open. Here you select the Laser 
Marker you want to check.). 

Info:
Depending on the lenses provided on your mi-
croscope, the selection list in your program 
may include entries other than those shown in 
the list above.

Note! 
Note that the IR laser can only be used in con-
junction with 63x and 100x lenses.

Info:
You will also find a drop-down box for selecting 
the magnification in the "PALM Robo Speed", 
"LPC Parameter", "PALM Robo Laser Settings" 
and PALM Robo IR Laser Settings windows.

Note! 
To obtain a correct display of the drawn ele-
ments and to achieve a correct laser function, 
the setting in the Lens Menu must match the 
magnification that is selected on your micro-
scope. If the settings do not correspond to each 
other, the actual cut lines and catapult points 
of the laser will not be correctly displayed on 
the monitor.

Note!
PALM RoboSoftware calculates the cutting 
functions of the UV laser from the position of 
the Laser Marker. The position of the Laser 
Marker should therefore always match that of 
actual laser focus. Only then the correct results 
can be achieved with the automatic laser 
functions. You should therefore check the posi-
tion of the Laser Marker before you start work. 
For the IR laser also, you can only achieve ac-
curate results if the IR Laser Marker is exactly 
aligned with the laser focus.
Remember that the position of the Laser Mark-
ers may vary for use with different objectives.
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To determine the focus point of the UV laser:

• Using any of the methods described in chapter 
5 "Positioning the Stage" move the stage so 
that an area of your sample which you do not 
require for your work appears in the middle of 
the monitor, or 
insert a membrane-coated slide.

• Activate Stage Mode, if not already active (click 
on the "Stage Mode" button in the Tool Bar or 
press F7).

• Release the laser with a single short application 
of pressure to the footswitch.

• Check the result. You should see a small, 
almost circular area where material has been 
removed. This is most easily visible on the 
membrane.

To determine the focus point of the IR lasers:

• Insert a slide that has been colored with a black 
felt pen.

• Switch the IR laser on briefly (toggle the "IR" 
button in the right border of the program win-
dow to switch the laser on and off).

• Check the result. You should see a small, 
almost circular area where color has been 
removed.

To set the position of a Laser Marker:

• In the "Laser-Marker" menu, click on menu 
item "Position Laser-Marker".

A submenu opens containing a list of all available 
Laser Markers.
• Click on the name of the Laser Marker whose 

position you want to change.

Depending on your selection, you will be prompted 
to "Click Cursor at new UV Laser Position!" or 
"Click Cursor at new IR Laser Position!".
• Click in the center of the laser focus for that 

laser beam.

The message "UV-Laser-Position is set!" or "IR-La-
ser-Position is set" will appear. This message will 
disappear automatically after a few seconds.

Stage

Info:
In some circumstances you will not see any ef-
fect from laser activation, or there will be a 
large hole in your sample. In this case, check 
that there is nothing obstructing the laser 
beam in the microscope's laser light path or 
conduct preliminary tests to determine the op-
timum settings for laser energy and focus. For 
instructions on how to do this, refer to chapter 
10.6 "Finding Suitable Laser Settings".

Info:
In some circumstances you will not see any ef-
fect from laser activation, or there will be a 
large hole in your sample. In this case, check 
that there is nothing obstructing the laser 
beam in the microscope's laser light path or try 
again with different settings for laser power 
and focus (instructions on making these setting 
are included in chapter 11.2 "Setting IR Laser 
Power and Focus").

Note!
Be sure to assign the Laser Markers to the cor-
rect laser beams.
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4.4 Calibrating the Movement of the 
Stage

Calibration is done in several steps. PALM Ro-
boSoftware will guide you through this process.

To perform the calibration:

• Insert a sample and focus the image.
• Set the chosen magnification for the micro-

scope, as described in chapter 4.2 "Setting the 
Magnification".

• In Stage Mode, choose a low to medium speed 
setting for the stage (refer to chapter 5.3 "Set-
ting Speed").

• Click on "New Calibration" in the "Setup>Cali-
bration" menu.

A submenu will open.
• Click on menu item "Stage".

A message appears: "Step 1 of 2: Click any point 
for moving to screen center".
• Choose any dot, preferably as small but as sig-

nificant as possible, in your image. Note this 
dot and click on it with the cursor tip.

The cursor will disappear and the program will 
switch automatically to Stage Mode. The following 
message will appear: "Step 2 of 2: Move this point 
to screen center and click again!".
• Use the mouse to move your selected point to 

the crosshairs at the image center and click the 
left mouse button.

The cursor will reappear; the program automati-
cally switches out of Stage Mode. The following 
message will appear: "Calibration is finished. 

Check position of Laser Marker." This message will 
disappear automatically after a few seconds. 
Check the position of the Laser Marker as de-
scribed in chapter 4.3 "Setting the Laser Marker", 
if you did not already do this before the calibration.

You can check the calibration by drawing an ele-
ment and activating the automatic laser "Cut" 
function. Calibration is correct when the cut line 
exactly follows the element you have drawn (for 
instructions on working with these functions, refer 
to chapter 7 "Drawing and Measuring" and chapter 
10 "Cutting and Catapulting").

Note!
The menu entries "3D-1" and "3D-2" appear 
only if you have installed a system with one or 
two 3D movable IR laser beams.

Note!
Do not use the "Invert stage motion" function 
when calibrating (refer also to chapter 5.1.1 
"Positioning the Stage with the Mouse: Stage 
Mode").

Note!
The farther the dot is from the image center 
(both vertically and horizontally), the more ac-
curate your calibration will be.

Note!
The calibration always applies only to a magni-
fication that has been set before the calibra-
tion. If you intend to work with various 
magnifications, you must recalibrate for each 
change of magnification.
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4.5 Calibrating the 3D Offset

Recalibration is necessary if the position of the La-
ser Marker and the active laser position do not be-
have together in a proportionally consistent 
manner, when in motion. 

If they do move together in a proportionally con-
sistent manner, but do not coincide, only the Laser 
Marker must be readjusted (refer to chapter 4.3 
"Setting the Laser Marker").

Calibration is done in several steps. PALM Ro-
boSoftware will guide you through this process.

To perform the calibration:

• Insert a sample and focus the image.

• Follow the instructions in chapter 4.2 "Setting 
the Magnification" to set the magnification cho-
sen for the microscope in the Lens menu.

• If it is hidden, enable the screen center display 
(click on item "Screen Center" in the "View" 
menu).

• For the 3D Laser Beam Positioning, choose a 
low to medium speed setting ("3D"; for instruc-
tions on how to proceed, please refer to chapter 
11.8.1 "Setting the Speed of the 3D Laser 
Beam Positioning").

• Choose low power and focus settings for laser 
beam "IR-1" as described in chapter 11.2 "Set-
ting IR Laser Power and Focus".

• Activate the IR laser (click on the "IR" button on 
the right border of the monitor).

• Adjust the power and focus so that you can see 
an effect of the laser beam (if you are using a 
slide colored with a black felt pen, a hole in the 
colored coating will be visible at the appropriate 
settings).

• Switch to 3D-1 Mode (click on item "3D-1 
Mode" in the "Move" menu).

The cursor will disappear; every movement of the 
mouse will be reflected in a movement of the laser 
beam.
• Move the laser beam by dragging the mouse 

into a corner of the image in your image win-
dow.

• Double click there to exit 3D-1 Mode again.

• Click on "New Calibration" in the "Setup>Cali-
bration" menu.

A submenu will open.
• Click on menu item "3D-1".

The following message will appear: "Step 1 of 2: 
Click Cursor at actual 3D-1 Position!". 
• Click on the actual position of the laser beam 

with the mouse.

The following message will appear: "Step 2 of 2: 
Move this point to screen center and click again!".
• The program will switch automatically to 3D-1 

Mode. Use the mouse to move the laser beam 
to the crosshairs at the image center and click 
the left mouse button.

The cursor will reappear; the program automati-
cally switches out of 3D-1 Mode. The following 
message will appear: "Calibration finished!" This 
message will disappear automatically after a few 
seconds.

If you have purchased a system with two 3D mov-
able laser beams, calibrate the second laser beam, 
IR-2, in the same way as for IR-1.

Note!
Calibrating the 3D Laser Beam Positioning is 
only necessary (or indeed possible) if you have 
purchased a system that includes this function.
In Double Beam Systems with two 3D movable 
laser beams, both offsets (3D-1 and 3D-2) 
must be calibrated.

Note!
Before you carry out the calibration, you must 
have set the Laser Markers as described in 
chapter 4.3 "Setting the Laser Marker". 

Info:
The 3D Laser Beam Positioning can only be cal-
ibrated with the IR laser switched on. Accord-
ingly, you should use a sample that you no 
longer need for your work. 
A slide that has been colored with a black felt 
pen is particularly suitable.

Note! 
Note that you can only use the IR laser in con-
junction with oil objectives (60x), 63x and 
100x.

Note!
The farther the dot is from the image center 
(both vertically and horizontally), the more ac-
curate your calibration will be. 

Note!
The calibration always applies only to a magni-
fication that has been set before the calibra-
tion. If you intend to work with various 
magnifications, you must recalibrate for each 
change of magnification.
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4.6 Resetting Calibration

You can reset the calibration to the factory default 
setting at any time.

To reset the calibration:

• Click on "Factory Calibration" in the 
"Setup>Calibration" menu.

A message appears: "Do you really want to reset 
to Factory Calibration for this Lens?".
• Confirm with "Yes".

The manufacturer's default calibration is restored 
immediately.

4.7 Adjusting the Lens Offset

If you have drawn elements with one magnifica-
tion and then select another magnification (a dif-
ferent objective), the microscope image on the 
monitor may appear to be shifted slightly, al-
though the stage has not been moved. Your 
elements are no longer in the correct position. The 
automatic laser functions will then not process ex-
actly the areas you wish. 
You must compensate for this by setting the Lens 
Offset.

To adjust the Lens Offset:

• Move the stage so that at least one element is 
displayed on the monitor.

• If it is not yet active, select the Pointer Tool in 
the Graphic Toolbar.

• Click on menu item "New Lens-Offset" in the 
"Setup>Calibration" menu.

All available elements are automatically selected 
and surrounded by a selection rectangle (the se-
lection rectangle is indicated by a white line). 

Note!
These differences between the objectives have, 
in the case of those supplied and those marked 
with the P.A.L.M. Logo, been compensated by 
a factory default setting of the Lens Offset.
You must only compensate the Lens Offset, if a 
shifting of the elements occurs when altering 
the magnification.

Info:
If you did not draw an element before changing 
the objective you do not need to define the 
Lens Offset. However, if you still select this 
function, you will receive the following mes-
sage: "You must draw some Figures for defin-
ing the Lens Offset". Click on "OK" as necessary 
to confirm this message.

Pointer Tool

Info:
If you have drawn elements that are currently 
positioned outside of the monitor section, some 
or all of the borderlines of the selection rectan-
gle will also be outside the monitor section. In 
this case the border lines are not visible. 
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You will receive the following prompt: "Step 1 of 2: 
Click Selection Rectangle".

• Click on any dot within the selection rectangle 
and hold the mouse button down.

You will receive the following message: "Step 2 of 
2: Now move the Figure to the new position!"
• Move the element or elements (holding down 

the mouse button) to the correct position and 
release the mouse button.

Then, even elements that are outside the current 
monitor section will be moved. 
The following message will appear: "New Lens Off-
set is set!" This message will disappear automati-
cally after a few seconds.

4.8 Resetting the Lens Offset

You can restore the default factory settings for the 
Lens Offset at any time.

To reset the Lens Offset:

• Click on menu item "Factory Lens-Offset" in the 
"Setup>Calibration" menu.

A prompt will appear: "Do you really want to reset 
to Factory Lens Offset for this Lens?"
• Confirm with "Yes".

The default factory settings for the Lens Offset will 
be restored immediately.

Note!
If you click inside the rectangle and inadvert-
ently do not hold the mouse button down, the 
selected elements will not be moved to the cor-
rect position. In this case, reset the Lens Offset 
as explained in the following chapter 4.8 "Re-
setting the Lens Offset" and start the operation 
again.

Note!
The Lens Offset will also be reset if you restore 
the factory default settings (refer also to chap-
ter 3.5 "Restoring Settings").
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5 Positioning the Stage

PALM RoboSoftware offers various methods of 
moving the stage: 
- with the mouse (Stage Mode and Scroll)
- with the scroll bars below and to the right of the 

microscope image, 
- with the keyboard (arrow keys), 
- via commands that target predefined positions 

or elements (positioning), or 

- with the PALM Navigator (refer to chapter 6.3 
"Positioning the Microscope Stage").

When the automatic UV laser functions are start-
ed, the stage is automatically moved along the de-
fined cut lines or from dot to dot.

You can set the speed to suit the various methods 
of moving the stage (refer to chapter 5.3 "Setting 
Speed").

In order to prevent the stage from being moved in-
advertently, you can freeze its movement in any 
position, i.e., disable all functions that would cause 
the stage to move.

The program distinguishes accordingly between 
the various movement modes and the Freeze 
Mode. The active mode is displayed on the Status 
Bar. You can and must disable Stage Mode and 
Freeze Mode yourself. To use the other movement 
methods you must be in Cursor Mode: the modes 
are automatically entered as soon as you select 
the appropriate functions and automatically exited 
at the end of the movement task.

You can immediately interrupt the movement of 
the stage, for example in case of an emergency.

The speed with which the stage is moved can be 
programmed separately for each movement type.

5.1 Movement Types

5.1.1 Positioning the Stage with the 
Mouse: Stage Mode

In Stage Mode you control the movement of the 
stage synchronal with the mouse. Each mouse 
action is translated into a movement of the stage. 
You can perform movements in any required direc-
tion. 

If you are using an objective that inverts the im-
age, a mouse movement to the right in Stage 
Mode will appear on the monitor as a movement to 
the left. If you select "Invert Stage Motion", the 
stage will be moved in the opposite direction to the 
mouse movement. In this case the motion of the 
image on the monitor is in the same direction as 
the movement of the mouse.

To invert stage movement:

• Click on menu item "Invert stage motion" in the 
"Move" menu, or
open the context menu by clicking the right 
mouse button and select menu item "Invert 
stage motion".

A tick beside this menu item indicates that the 
function is enabled.

Info:
You must invert the movement of the stage be-
fore switching to Stage Mode. You cannot ac-
cess this command when you are in Stage 
Mode.

Note!
Do not use the function "Invert stage motion" 
if you want to calibrate the system.
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To switch to Stage Mode:

• Click on the "Stage" icon button in the Tool Bar, 
or
click on menu item "Stage Mode" in the "Move" 
menu, or 
open the context menu and click on menu item 
"Stage Mode", or
press F7 on the keyboard.

To switch from Stage Mode back to Cursor 
Mode:

• Click once with the left mouse button, or
Press "ESC" on the keyboard, or
press F7 on the keyboard.

5.1.2 Positioning the Stage with the 
Mouse: Scroll

In Cursor Mode, you can use the scroll function to 
move the stage.
• Move the cursor towards an edge of the image 

outside the Scroll Rectangle (but still within the 
image itself), if you want to move the stage 
horizontally or vertically, or 
Move the cursor into a corner of the image out-
side the Scroll Rectangle, if you want to move 
the stage diagonally.

As soon as you move into the area outside the 
Scroll Rectangle, the cursor becomes a broad 
white arrow.
• Press and hold the mouse button down.

The stage is moved in the direction of the arrow.

You can also change the direction of movement 
during the movement itself by moving the cursor 
from an image edge towards an adjacent corner or 
vice versa.
• Release the mouse button when you have 

found the required area of your sample and 
positioned it in the correct place. 

The stage stops moving.

The Scroll function is only active as long as the 
cursor is outside the Scroll Rectangle. Movement 
of the stage is therefore also stopped when you 
drag the cursor into the Scroll Rectangle with the 
mouse button depressed.

Stage

Info:
The cursor is not displayed in Stage Mode. In 
Stage Mode you can only change the speed and 
energy or power of the stage and the focus of 
the laser by means of keyboard commands 
(note that you can only change the settings for 
the laser beam that is selected in Laser Tools). 
You cannot access any other functions. 

Info:
If the Scroll Rectangle is not displayed, you can 
activate it by clicking on "Scroll Rectangle" in 
the "View" menu.
Scrolling with the mouse also works when the 
Scroll Rectangle is not displayed.
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5.1.3 Positioning the Stage Using the 
Scroll Bars

Scroll bars are located on the bottom and left edg-
es of the microscope image. With these you can 
move the stage.

If you want to move the stage gradually:
• Click once on one of the arrow icon buttons on 

the scroll bar.

If you want to move the stage over a larger dis-
tance:
• Click once on one of the arrow icon buttons and 

hold the mouse button depressed until the 
stage has reached the desired position, 
or 
Click on the position cursor on the scroll bar 
and drag it to the desired position.

If you want to move the stage in steps of one im-
age width or height:
• Click beside the position cursor on the scroll 

bar.

5.1.4 Positioning the Stage with the 
Keyboard

• Press one of the four arrow keys. The stage will 
continue to move until you release the key. 

This allows you to move the stage up, down, and 
to the left and right. If you press two arrow keys 
simultaneously (e.g., ↑→), you can also move the 
stage diagonally.

5.1.5 Positioning the Stage with the 
Centering Tool

The Centering Tool can be used to shift any point 
on the microscope image into the center.

• Click on the Centering Tool in the graphics tool-
bar.

• Click on the point in the image that is to be 
moved to the center.

The centering tool will continue as the active tool 
until you click on any other tool on the graphics 
toolbar.

5.1.6 Moving the Stage during an Auto-
matic UV Laser Function

As soon as you activate one of the automatic UV 
laser functions, the stage automatically moves 
along the programmed cut lines or from dot to dot. 
You do not have to select any particular type of 
movement in this case. 

5.1.7 Further Possibilities for Position-
ing the Stage

Aside from the aforementioned possibilities, you 
can move or precisely position the stage using the 
following methods:
- Centering elements: The stage is so positioned 

that a previously selected element will be dis-
played in the center of the monitor. Refer to 
chapter 7.5 "Centering Elements on the Moni-
tor" for instructions on how to do this.

- To move to the Load Position (refer to chapter 
5.6 "The Load Position"). When the stage is in 
the Load Position, you can easily change the 
slide and the slideholder (PALM RoboStage 
Type II only).

- To move to the Check Point (refer to chapter 
5.5 "The Check Point"). When the microscope 
stage is at the check point, you can observe 
catapulted samples in the collection device 
under the microscope.

- Navigating with PALM Navigator: With one 
mouse click, you can freely center positions on 
the monitor. Refer to chapter 6.3 "Positioning 
the Microscope Stage" for instructions on work-
ing with this program.

Note!
With the Scroll function you can move elements 
while simultaneously positioning the stage: If 
you have selected elements or groups of ele-
ments on the screen and the scroll arrow is 
within the selection rectangle, these elements 
or groups of elements will also be moved. By 
this method, you can move elements or groups 
of elements over greater distances quickly.
If you do not want to move elements or groups 
of elements,
- deselect all elements and groups of ele-

ments (refer to chapter 7.6.1 "Selecting and 
Deselecting Elements on the Monitor"), or

- apply another function to position the stage, 
e.g., the scroll bars (refer to chapter 5.1.3), 
or

- make sure that the scroll arrow is outside 
the selection rectangle.
Note that you may not be able to see the 
selection rectangle, if elements are selected 
which are outside the current monitor dis-
play.

Centre



42 PALM RoboSoftware 3.1-0106 (EN)

Stopping the Stage in an Emergency

5.2 Stopping the Stage in an Emergency

You can stop the movement of the stage at any 
time, for example in an emergency or in the event 
of a malfunction. An icon button and a menu com-
mand are provided so that you can stop the move-
ment in both the main window of PALM 
RoboSoftware (refer to chapter 2 "Program Layout 
and Operation") and in the "Element List" window 
(refer to chapter 7.3 "The "Element List" Win-
dow").

To stop all current movements with one key-
board shortcut:

• Press "Esc" on the keyboard.

To stop all current movement in main window:

• Click on the "Stop" icon button in the Tool Bar, 
or
click on the "Stop" entry in the "Move" menu, or
open the context menu by right-clicking the 
mouse and then click on menu item "Stop".

To stop all current movement in the "Element 
List" window:

• Click on the "Stop" icon button in the Icon Bar.

All current operations are stopped immediately. 
Repair the malfunction if necessary.

Stop

Stop

Info:
You can still use the icon button and the menu 
command when the "Element List" window is 
open.

Note!
The "Stop" function stops all current opera-
tions, i.e., any UV laser functions that happen 
to be running. The "Continue" function (refer to 
chapter 10.8 "Stop/Continue") starts the UV 
laser functions even if you only moved the 
stage without laser function before the stop-
page.
Therefore, you should never use the "Continue" 
command to resume a movement of the stage 
in which the laser function was not activated, 
because this will always switch the UV laser on 
as well (instead, you should use one of the op-
tions described in chapters 5.1.1 to 5.1.4 and 
5.1.7).
The "Stop" function has no effect on the IR la-
ser.
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5.3 Setting Speed

You can set the speed separately for every type of 
stage movement:
- Stage: Movement speed in Stage Mode (move 

using mouse).
- Arrow (keys): Movement speed using arrow 

keys. For movement with the arrow keys (as 
was described for "Position") you can set higher 
speeds than for the other movement types. 
This movement type is therefore particularly 
suitable for rapid movements over larger dis-
tances.

- Scroll: Speed of movement when scrolling 
(moving the stage by left-clicking the mouse 
outside the Scroll Rectangle).

- Position: Speed for automatic targeting of ele-
ments and defined positions (Check-Point, 
Load Position) and speed for automatic laser 
function "LPC"; the defined dots for this func-
tion are targeted sequentially at the set speed. 
For this movement type (as was described for 
"Arrow"), you can set much higher speeds than 
for other movement types.

- Cut: Speed for automatic laser function "Cut".
- LPC: Speed for automatic laser function 

"AutoLPC"; the defined dots for this function 
are targeted sequentially at the set speed.

You can save the speed settings together with oth-
er parameters in a settings file. Refer to chapter 
3.4 "Saving and Loading Settings" for instructions 
on how to do this.

You have the following options for setting the 
movement speed of the stage:
- via the "PALM Robo Speed" window, which you 

open with a menu command or a keyboard 
shortcut.

- with the "Speed Tools" tool
- with keyboard or menu commands: (Speed 

slower/Speed faster). These setting options are 
intended particularly to allow changes with a 
movement operation in progress. 
For speed changes entered with keyboard or 
menu commands, you can define an increment. 
Every time the corresponding keyboard or 
menu command is entered, the speed is 
increased or decreased by this value.

You can set the speeds of all types of movements 
in the "PALM Robo Speed" window and with the 
"Speed Tools" tool.

Speed changes with keyboard or menu commands 
always refer to the type of movement that is cur-
rently selected in the "Speed Tools" tool.

Before you initiate a movement of the stage, all 
three setting options are available for all move-
ment types. While the stage is moving, you can 
only change the speed of the "Cut" movement type 
using the "Speed Tools" tool. In the case of the 
other movement types, the speed can be changed 
with keyboard commands.

To select the unit for speed setting:

For the speed setting you can select between two 
different units: percent and µm/sec.

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window with 
the "Configuration" tab opens.
• Click in Radio Button "Logic" (units: percent) or 

"Micrometer / sec" (units: µm/sec) in section 
"Metric".

• Close the window.

Note!
The settings that you enter always apply to 
the magnification that you have set in the 
program. As soon as you have set another 
magnification, the values that were last used 
or the factory defaults are automatically ap-
plied. Therefore, prior to setting the speed, 
first select the magnification that you want to 
work with.

Info:
If you have selected too fast a speed for Cut 
Mode, it may happen that your sample is not 
cut through completely. In this case, reduce 
the cut speed.
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To change the speed using the "PALM 

RoboSpeed" window:

• Click on "Setup Speed ... " in the "Move" menu, 
or
press F8 on the keyboard.

The "PALM Robo Speed" window will open. There 
are tabs located in the bottom part of the window 
that you can use to set the speed for the various 
movement types (the last two tabs are used for 
setting the speed of the 3D Laser Beam Positioning 
for the IR laser; refer to chapter 11.8.1 "Setting 
the Speed of the 3D Laser Beam Positioning").

Set speeds for all movement types in the same 
way:
• Select the tab of the movement type for which 

you want to change the speed.
• Enter the desired value with the slider, or

Enter the desired value in the "Actual Speed:" 
field.

• Close this window by clicking on "OK".

To change the speed of the "Speed Tools" 
tool:

• Open the "Speed Tools" tool if it is not displayed 
(click on the menu item "Speed Tools" in 
"View>Menu" or press key combination 
Ctrl+E).

• Click on the arrow beside the field under 
"Selected Speed".

A list of the different movement types will open.

• Select the movement type for which you want 
to change the speed.

Movement types "3D" and "3DArrow" will only ap-
pear if you have purchased the PALM CombiSys-
tem with 3D Laser Beam Positioning. They are 
used to set the speed of the 3D Laser Beam Posi-
tioning for the IR laser (refer to chapter 11.8.1 
"Setting the Speed of the 3D Laser Beam 
Positioning").

The Speed Tool for the selected movement type is 
shown (in the example shown above: Scroll). The 
maximum selectable speed is dependent upon the 
chosen movement type.

• Enter the desired value with the slider, or
click on one of the arrow buttons below the 
slider repeatedly (or click once and hold the 
mouse button down) until the desired value is 
reached, or
enter the desired value in the field below the 
slider.
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To change the speed with menu commands 
or with keyboard shortcuts:

• If you want to reduce the speed, press key 
combination Ctrl+S, or
click on menu item "Speed Slower" in the 
"Move" menu.

• If you want to increase the speed, press key 
combination Ctrl+F, or
click on menu item "Speed Faster" in the 
"Move" menu.

You can specify a value (increment) by which the 
speed is increased or decreased when you make 
this change via key combinations.

To enter an increment for changing the speed 
with a keyboard shortcut or a menu command:

• Click on "Setup Speed ... " in the "Move" menu, 
or
press F8 on the keyboard.

The "PALM Robo Speed" window will open.
• Select the tab associated with the movement 

type for which you want to specify an increment 
(the last two tabs are used for setting the speed 
of the 3D Laser Beam Positioning for the IR 
laser; refer to chapter 11.8.1 "Setting the 
Speed of the 3D Laser Beam Positioning").

• Enter an increment in the "Speed Delta: for 
faster/slower functions" field.

• Close this window by clicking on "OK".

Info:
Changes with keyboard or menu commands al-
ways refer to the type of movement that is cur-
rently selected in the "Speed Tools" tool. 
Therefore, activate the tool display before car-
rying out any speed changes with keyboard 
shortcuts or menu commands. Otherwise you 
will not be able to see which movement type 
the changed speed setting will affect.
If a movement is in progress, the selection in 
Speed Tools is automatically changed to the 
current movement type, and the speed chang-
es you make are automatically applied to the 
current motion.
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5.4 The Reference Position of the Stage

In the drawing plane, PALM RoboSoftware requires 
a Reference Position for calculating the coordi-
nates of your elements. This reference point with 
its coordinates 0/0 is stipulated by the PALM 
RoboSoftware: With each start of the program the 
stage is moved to the end positions in x- and y-di-
rection. This position is defined as reference point.

The point of origin is particularly important when 
you have drawn elements and have saved them 
for later use. The automatic positioning of the 
stage to the reference point ensures that on re-
loading your elements they will appear at the same 
positions at which you drew them. To work with 
saved elements, you need only insert the respec-
tive sample into the slideholder and reload your el-
ements.

To set the reference position of the stage:

Normally, you will not have to determine the Ref-
erence Position yourself. If, however, a disruption 
should occur (e.g., you may have moved the stage 
unintentionally by hand), you can reset the Refer-
ence Position of the stage:

• Click on menu item "Reference the Stage" in 
the "Move" menu.

Info:
The Reference Position is retained for as long 
as the controller unit remains switched on, 
even if you shut down and restart the PALM Ro-
boSoftware. 

Note!
Make sure that you reinsert the slide exactly 
as you had it inserted during previous pro-
cessing, i.e. not tilted or even rotated 180°.

Info:
It may also happen that the drawn elements 
shift after you change objectives: If the optical 
axes of both objectives do not match exactly, 
the microscope image on the monitor will be 
displayed as slightly offset. In this case, you 
will have to redefine the Lens Offset. Refer to 
chapter 4.7 "Adjusting the Lens Offset" for in-
structions on how to do this.

Note!
Note that the Reference Position for the stage 
has no relationship to the definition of a Ref-
erence Position for the 3D-variable IR laser 
beam (refer to chapter 11.4 "Defining a Ref-
erence Position").



PALM RoboSoftware 3.1-0106 (EN) 47

The Check Point

5.5 The Check Point

When you catapult samples into a collection device 
using the automatic laser functions, you can then 
observe the contents of the collection device under 
the microscope. For this purpose PALM RoboStage 
has a notch through which the microscope objec-
tive can be moved upwards. The corresponding 
position of the stage is referred to as the Check 
Point. You can automatically target the Check 
Point with a menu command

To move the stage to the Check Point:

• If you do not have a motorized microscope: 
Move the objective down as far as possible.

• Click on the "Check Point" icon button in the 
Tool Bar, or
press key combination Ctrl+K, or
Click on menu item "Goto Check-Point" in the 
"Move" menu.

The stage is moved so that the Check Point is po-
sitioned in the center of the monitor. 

To return the stage to its original position:

• If you do not have a motorized microscope: 
Move the objective down as far as possible.

• Click on the "Check Point" icon button in the 
Tool Bar, or
press key combination Ctrl+K, or

• Click on menu item "Goto Check-Point" in the 
"Move" menu.

The following message will appear: "Clear Path-
way, Objective must be down". 
• Click on "OK" in the message window.

The message will disappear and the stage will be 
returned to the position it was in before it was au-
tomatically moved to target the Check Point.

Caution!
Set the objective to the lowest possible posi-
tion, before you move the stage to or from the 
Check Point! If the objective is set too high, the 
stage will collide with it. This can cause serious 
damage to the objective and to your sample (if 
you have purchased a system with motorized 
microscope, the objective is moved automati-
cally).

Check Point

Note!
To avoid damage to the objective or to the 
sample: Move the stage back again to the 
original position, after observing the cap. 

For this proceed solely as described below.

Check Point
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5.6 The Load Position

When the stage is in the Load Position, you can 
easily change the slide and the slideholder (PALM 
RoboStage Type II only).

To move the stage to the Load Position:

• If you do not have a motorized microscope: 
Move the objective down as far as possible.

• Click on the "Load Position" icon button in the 
Tool Bar, or
Click on menu item "Goto Loadposition" in the 
"Move" menu.

The stage is moved to the Load Position. The 
"PALM Robo Select Slideholder" window will open.

• Change the slideholder and/or the slide and 
choose the corresponding entry from the "Sli-
deholder" field.

To return the stage to its original position:

• If you do not have a motorized microscope: 
Move the objective down as far as possible.

• Click on "Return to the working area" in the 
"PALM Robo Select Slideholder" window.

The stage will be returned to the position it was in 
before it was automatically moved to target the 
Load Position.

Caution!
Set the objective to the lowest possible posi-
tion, before you move the stage to or from the 
Load Position! If the objective is set too high, 
the stage will collide with the it. This can cause 
serious damage to the objective and to your 
sample (if you have purchased a system with 
motorized microscope, the objective is moved 
automatically).

Load Position

Note!
To avoid damage to the objective or to the 
sample: Move the stage back again to the 
original position, after changing the slide and 
the slideholder.

For this proceed solely as described below.
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6 PALM Navigator

The PALM Navigator will provide you with an over-
view of your sample or a section of your choice. 
You scan your sample and get an image in the 
PALM Navigator window. With one mouse click on 
any spot within the scanned image, you can posi-
tion the stage to this spot and display particular ar-
eas of your sample on the monitor very rapidly.

From within the proof scan you can select an area 
and scan this at an enlarged size. 

You can save and reload the scan. The scan is 
saved with its coordinates. This means that you 
can work with the reloaded image in exactly the 
same way as with a new scan.

The Navigator window can be resized. If the win-
dow is resized, the scanned image is likewise in-
creased or reduced in size. 

You can set a parameter to specify that your ele-
ments will appear on the scans.

If your system includes PALM RoboStage Typ II 
and you employ the corresponding slideholder, 
you can produce scans of several samples and 
change between them in the display.

If your system includes the "Cellenger" or "AxioVi-
sion" software, you can transfer the scanned sec-
tion directly to these programs for analysis. To 
facilitate analysis, the "Life Image" window en-
ables you to modify various parameters for the im-
age (contrast, brightness, saturation, color, 
gamma value). These facilities are described in 
chapters 6.4 "Analyzing Images Using the 
"Cellenger" Software", 6.5 "Analyzing Images Us-
ing the AxioVision Software" and 3.9 "Set Image 
Parameters".

6.1 Start and Quit PALM Navigator

To start PALM Navigator:

• Click on menu item "Navigator Window" in the 
"View" menu.

The "PALM Navigator" window opens. 
• Select the "Navigation" tab, if not already 

selected.

An image of your slideholder appears. 

To quit PALM Navigator:

• Click on menu command "Close" in the PALM 
Navigator window.

Info:
The exact appearance is dependent upon the 
type of slideholder you have inserted in the 
stage (the picture shows, for example, the 
3 Slide Holder, which can accept three slides; 
Slide 2 is currently selected).
Note that the type of slideholder must also be 
set in the PALM RoboSoftware. Refer to chap-
ter 3.2 "Setting Slideholder" for instructions 
on how to do this.

Info:
If you are working in Database Mode, the 
slides for which you have not yet entered any 
data (refer to chapter 7.1.2 "Working in Da-
tabase Mode") are shown shaded. 
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6.2 Scanning a Sample with PALM 
Navigator

To scan your sample (proof scan):

• Choose the desired magnification.

• Insert a slide and focus the image.

• Select (in the "PALM Navigator" window) the 
required slide, if necessary: 
Click on the slide, or 
click on one of the arrow keys at the top right 
side, to change from one slide to another.

• Click on the "New Slide" button to delete an 
image which may be present.

• With the mouse, pull up a rectangle that sur-
rounds the area which you want to scan.

• Select the "Scan" tab.

Displayed on the tab is a monotone area with the 
same proportions as the rectangle you dragged 
out.

As soon as you execute the scan command (see 
below), the sample will be scanned, section-by-
section. For this, the focus setting will be applied 
which was valid before the command was sent. 
You can choose whether the focus setting should 
be corrected for each scanned section: automati-
cally (only if you have a motorized microscope with 
automatic focusing) or manual.

• Activate the "Use Autofocus" checkbox if you 
have a motorized microscope with automatic 
focusing that you want to use, or
activate the "suspend scan for focus" checkbox, 
if you want to manually readjust the focus for 
each section to be scanned.

• Click on the "Scan Slide" button.

Info:
The duration of the scan is dependent upon 
the magnification set on the microscope. Set 
on a high magnification (e.g., 100x), the scan 
operation would take several hours. There-
fore, choose a low magnification at first, e.g., 
2.5x or 5x. In this way, you can produce a 
proof scan within a few minutes.
Magnification and required area are to be 
synchronized.

Note!
If your system is equipped with a manual mi-
croscope: make sure that you have set the 
same magnification on the microscope as is in 
the PALM RoboSoftware (refer to chapter 4.2 
"Setting the Magnification"; with a motorized 
microscope, the magnification will be auto-
matically set to that selected in the software).

Info:
If you readjust the focus for each section to 
be scanned, you will get a far sharper overall 
result. However, the duration of the scanning 
operation will increase considerably.
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The selected section will be scanned. You can fol-
low the progress in the window. "Slide Section" will 
be displayed at the upper right of the window.

To scan sections of the proof scan:

• With the mouse, pull up a rectangle that sur-
rounds the area in the proof scan which you 
want to scan. 

• Click on the "Rescan" button.

The selected section will be scanned. At the upper 
right of the window "Section 1" appears.

To interrupt scan progress:

• Click on the "Stop" icon button (in the main 
window of the PALM RoboSoftware), or 
Press the "Esc" key on the keyboard.

Scanning progress is cancelled. The partially fin-
ished scan will then be lost.

To change between the proof scan and the 
scan of the section:

• Click on the arrow button at the upper right of 
the window.

Whether you now see the section (1) or the proof 
scan (Slide Section), is indicated below the button.

To display your elements in the scan:

• Check the "Draw Elements" box in order to dis-
play all elements with the exception of text ele-
ments.

• Check the "Draw Marker Elements" box in order 
to display text elements.

The elements appear both in the overview scan 
and the section scan.

Info:
You can pull up a frame in the scan of a sec-
tion in order to scan the area once more. The 
previously scanned section will then be lost.

Stop
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To save the scanned image:

• Click on "Save Thumbnail" button.

The "Save scanned picture" window opens.
• Choose the file format in which you want to 

save the image (the formats JPEG, TIFF and 
Windows Bitmap are available).

• Choose the folder in which you want to save 
your image.

• Enter a name for the image.
• Click on the "Save" button.

To load the scanned image:

• Click on "Load Thumbnail" button.

The "Open scanned picture" window opens.
• Choose the file format you used to save the 

scanned image.
• Select the image you want.
• Click on the "Open" button.

The image is loaded and displayed.

6.3 Positioning the Microscope Stage

• If not already done, scan your sample, as 
described in chapter 6.2 "Scanning a Sample 
with PALM Navigator".

• With a mouse click or with the arrow button, 
select the slide which you want to observe.

• Click on the spot which should be displayed on 
the monitor.

The stage will be positioned on the desired spot.

Info:
Text elements serve for marking and informa-
tion purposes; they do not describe a section 
of your sample in the way, for instance, that 
freehand elements do. They therefore always 
appear the same size on the screen irrespec-
tive of the magnification setting. If you have 
chosen a low level of magnification it is there-
fore possible that text elements may cover 
areas that are significant for you. In this case 
you can turn off the text elements; other ele-
ments will continue to be displayed.

Info:
You may, for instance, use text elements to 
mark the area on the sample that you wish to 
scan. In this way the section of interest can 
be found more easily on the overview scan.

Info:
You can position the stage by clicking on the 
proof scan. To do this, change to the tab "Scan" 
and select "Slide Section" or "Section 1".
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6.4 Analyzing Images Using the 
"Cellenger" Software

The "Cellenger" software enables images of sam-
ples to be analyzed using sets of rules that have 
been defined in advance, and also allows elements 
to be generated. This helps with routine operations 
to automate the selection of the areas of interest.

• Scan the section of your sample that you wish 
to analyze, as described in chapter 6.2 "Scan-
ning a Sample with PALM Navigator".

• Select the "Cellenger Analyze" tab.

• From the "Analyze Ruleset" selection list, 
choose the set of rules you wish to use for anal-
ysis.

A number of sliders for setting various parameters 
now appear on the left-hand side of the window.

As a rule one does not know at first which param-
eter settings will deliver the optimum analysis re-
sult.
• Configure initial values for the parameters.
• Click on the "Test" button.

The parameter settings are tested with the current 
microscope image. The result is displayed below 
the buttons on the right-hand side of the window.
• Optimize the parameter values if necessary.

If you have found the optimum values:
• Click on "Analyze ROI“ button (ROI: Region of 

interest).

Your sample is analyzed.

Info:
You can only avail yourself of this analytical 
facility if your system includes the "Cellenger" 
software. Please contact P.A.L.M. Microlaser 
Technologies GmbH, if you wish to upgrade 
your system.

Info:
The parameters that you can set here depend 
on which set of rules you have chosen.
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6.5 Analyzing Images Using the Axio-
Vision Software

The "AxioVision" software enables images of sam-
ples to be analyzed using scripts that have been 
defined in advance, and also allows elements to be 
generated. This helps with routine operations to 
automate the selection of the areas of interest.

• Scan the section of your sample that you wish 
to analyze, as described in chapter 6.2 "Scan-
ning a Sample with PALM Navigator".

• Select the "AxioVision Analyze" tab.

You see the same scanned image as on the "Scan" 
tab. If you have switched on the display of ele-
ments as described on Page 51, then your ele-
ments will also be displayed here.

The AxioVision program allows you to create and 
save scripts that you can then use to analyze your 
sample. The AxioVision manual explains how to 
use the program.
• If you wish to call up AxioVision, click the 

"Adjust parameters" button.

Scripts created in AxioVision are shown in the Nav-
igator's "Analyze scripts" selection list.
• From the "Analyze scripts" selection list, choose 

the script you wish to use for analysis.
• Click on "Analyze ROI" button (ROI: Region of 

interest).

Your sample is analyzed.

Info:
You can only avail yourself of this analytical 
facility if your system includes the "AxioVi-
sion" software. Please contact P.A.L.M. Micro-
laser Technologies GmbH, if you wish to 
upgrade your system.
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The automatic laser functions allow you to cut 
along defined lines and catapult individual points 
or areas out of your sample. For a summary of the 
automatic laser functions refer to chapter 10 "Cut-
ting and Catapulting". 

Before you use these laser functions you must de-
fine these cut lines or areas; they are called ele-
ments. PALM RoboSoftware offers you a range of 
tools in the Graphic Toolbar for drawing elements.

You can draw elements one after another for dif-
ferent laser functions; for example, elements that 
are to be cut and catapulted completely (Robo-
LPC), beside those that are only to be cut (Cut), or 
those that are only to be catapulted (LPC). You can 
specify which laser function is to be applied prior 
to releasing the laser. For instructions on how to 
do this, refer to chapter 10.7 "Releasing the Auto-
matic Laser Functions". Elements for which the se-
lected laser function cannot be applied are 
ignored.

The display of the elements on the monitor de-
pends on which laser function is currently select-
ed: the selection of the laser function also serves 
as a preview. Elements that can be processed in 
the selected laser function are represented by thi-
cker lines or filled dots; elements that cannot be 
processed are represented by thin lines and dots 
that are not filled (circles). In the preview, dots 
and lines that are calculated by the program are 
also displayed (lines that enclose open elements 
as well as AutoLPC and RoboLPC dots). In chapter 
10.4 "Preview of the Automatic Laser Functions" 
you will find further explanations and examples of 
the preview.

Previously drawn elements can be changed by 
their shape and size, they can be numbered, anno-
tated and deleted again. You can calculate their 
area or length and you can select colors and line 
thicknesses in which your elements are to be dis-
played.

You can save your elements as a set, or load a pre-
viously saved set of elements. In addition, you can 
save the properties of your elements in a file, re-
load them in another program and process them 
further. For instructions on how to do this, refer to 
chapter 8 "Saving and Printing Elements".

If your system includes database functionality and 
if you are working in Database Mode, then your el-
ements will be saved automatically in a database 
and can be reloaded from there (refer to chapter 
1.7 "Launching and Exiting the Program" and the 
"Information Center" manual). 

You can also save extracts of the microscope im-
age with the superimposed elements in a file for 
documentation purposes. Elements stored in this 
way cannot be reloaded into the PALM RoboSoft-
ware. For instructions on how to do this, refer to 
chapter 9.3 "Saving Images Manually" and chapter 
9.4 "Saving Images Automatically during a Laser 
Function".

In order to draw elements you must display the 
section of your sample on the monitor that you 
want to process. Refer to chapter 5 "Positioning 
the Stage" for instructions on how to move the st-
age in order to display the required section of your 
sample on the monitor. However, you can also 
draw elements that extend beyond the section dis-
played on the monitor. Chapter 7.2.1 "Drawing in 
the Various Program Modes" includes instructions 
on the factors you must consider for this. 

When processing elements you will often be work-
ing with the "Element List" window. This window 
provides a summary of your elements and their 
properties and allows you to make changes to 
them and to perform various program commands. 
Refer to chapter 7.3 "The "Element List" Window" 
for a description of the options offered by this win-
dow.

Note!
The measuring functions of the PALM Ro-
boSoftware and the scale bar are not calibrated 
at the factory; they are an estimated value 
only. P.A.L.M. does not guarantee the accuracy 
of the performed measurements. 
The measuring functions have to be checked 
and, if necessary, calibrated by the user (for 
example, with a ocular micrometer).
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7.1 Creating a New Set of Elements

The procedure varies according to which mode you 
are working in - Database Mode or File Mode.

7.1.1 Working in File Mode

You can start drawing elements as soon as you 
have launched the program and adjusted the sam-
ple in the microscope.

If you have already drawn elements during your 
current session and you want to process another 
sample, you must first, after saving it if you wish, 
remove the existing element set from the monitor.

To prepare a new sample for processing in 
File Mode:

• If you want to save previously drawn elements 
for later work, save them as described in chap-
ter 8.2 "Saving and Loading Elements in File 
Mode".

• Click on menu item "New Elements" in the "File" 
menu of the main window, or
click on item "New Elements" in the "File" menu 
in the "Element List" window, (chapter 7.3 "The 
"Element List" Window" includes instructions 
for opening this window) or 
press the keyboard combination "Ctrl+N".

If any elements are displayed on the monitor, they 
will be removed without a request for confirma-
tion. 

If there are no elements on the monitor, the 
"File>New Elements" command has no effect.

7.1.2 Working in Database Mode

In Database Mode, after the program has been 
launched you can initially draw only a single ele-
ment using the Freehand Tool (refer to chapter 
7.2.3 "The Freehand Tool") in order to test the la-
ser settings for instance. To distinguish it from 
other elements, this element is displayed on the 
monitor with a dashed line.

Before you can draw elements you must enter var-
ious details of your sample and your project. With-
out this data your elements cannot be saved in the 
database.

When this data is entered, distinctions are made 
between three hierarchical levels which you might 
use in the following way (see illustration overleaf):
- Source: represents the tissue sample that you 

wish to process.

- Specimen: represents a tissue sample that is 
placed on the slide for processing.

- Experiment: represents the specific examina-
tion that you intend to perform on the tisuue 
sample.

If you would like to create a new set of objects for 
the same slide, you should enter a new "experi-
ment". If you would like to work with a different 
slide you must enter the required data in the 
"Specimen" section. If you would like to work with 
a different tissue sample, you must describe it in 
the "Source" section.

Info:
Database Mode is only an option if your system 
is configured accordingly. Please contact 
P.A.L.M. Microlaser Technologies GmbH, to up-
grade your system if required.

Info:
When the program is launched you decide 
whether you want to work in File Mode or Da-
tabase Mode (refer to chapter 1.7 "Launching 
and Exiting the Program"). It is not possible to 
switch between these two modes whilst the 
program is running. If you want to change 
mode you must first shut down the PALM Ro-
boSoftware and then relaunch it. If necessary 
you must first modify the initial settings as de-
scribed in chapter 3.1 "Launching Settings".
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To prepare a new sample for processing in 
Database Mode:

• Click on "Enter/Select Data..." in the "File" 
menu in either the main window or the "Ele-
ment List" window, or click on the "Enter/Select 
Data..." icon button.

The "Please select or enter data!" window opens.

• Enter the details for your sample. Start with the 
uppermost field and move down one field at a 
time.

The "more" buttons bring up further fields for you 
to enter additional details of your source, your 
sample and/or your experiment. 
• Click the "more" button in the area for which 

you have supplementary information to enter.

One of the windows "Source Data Details", "Spec-
imen Data Details" or "Experiment Data Details" 
will open.

The first field in each of these windows is pre-pop-
ulated with the "Label" entries from the window 
"Please select or enter data!".

If you have added your own additional fields to the 
database, these will also appear in the "Data De-
tails" windows (the "Information Center" manual 
explains how to create additional fields).
• Enter the details you wish to record, then close 

the window by clicking the "OK" button.
• Proceed in the same way for each slide position 

if you wish to work with more than one slide.
• If you want to catapult samples: select the 

"Collection Device Data" tab.

Enter/Select Data ...

Info:
If you are using a multiple slideholder, a sepa-
rate tab will be displayed for each slideholder 
position (as well as a tab for entering data for 
the catapulted samples). When you open this 
window, the tab for the currently active slide is 
displayed.
If you wish to draw elements for more than one 
slide, you must enter data for each slide to be 
processed. 

Info:
All fields shown in blue must be filled in before 
you can start working. Other fields may be left 
blank.

Info:
If you would like to resume work on an existing 
experiment or with an existing sample you can 
specify this using the selection lists for the "La-
bel" fields.
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• Enter details of your collection device (Cap-
Mover, RoboMover).

The "more" button provides access to further fields 
for entering supplementary details. 
• Click on the "more" button.

The "Collection Device Data Details" window 
opens.

• Enter the details you wish to record, then close 
the window by clicking the "OK" button.

The "Please select or enter data!" window will be 
displayed again.
• Click on "OK".

The window will close. Now you can draw ele-
ments.

7.2 Drawing New Elements

PALM RoboSoftware provides a range of tools for 
drawing elements.
- Freehand, Line, Rectangle and Circle Tool: With 

these tools you can draw shapes, along which 
you can later cut with the "Cut" laser function, 
or the area content of which you can catapult 
later with the "AutoLPC" or "RoboLPC" auto-
matic laser functions. Elements drawn using 
these tools are collectively designated ele-
ments of type "Figure".

- Dot Tool: Use the Dot Tool to mark individual 
cells for subsequent catapulting with the "LPC" 
laser function.

- AutoCircle Tool: Use this tool to mark areas in 
your sample, which you can then catapult. Un-
like the Dot Tool, the AutoCircle Tool is used to 
draw a circle with a variable radius. With the 
"AutoCircle" laser function the area is cut out 
along the circumference of the circle and cata-
pulted, subsequently.

- Ruler: Use the Ruler to measure zonal lengths. 
The zone is shown as a line.

- Text Tool (Text): With the Text Tool you can 
identify individual areas of your sample, so 
that, for example, they can be easily located 
again, and annotated. These comments are 
then displayed at the specified position on the 
monitor.

- Reference Point Tool: Use this tool to define ref-
erence points. For example, you need them for 
the "Serial Section" function (refer to chapter 
10.9 "The "Serial Sections" Function").

"Ruler", "Text" and "Reference Point" type ele-
ments have no effect on the laser functions.

The elements are displayed on the monitor as col-
ored lines, dots or areas. You can preset the colors 
and line thickness or the dot sizes for display, and 
you can change them later. Refer to chapter 7.8 
"Changing Colors and Line Thickness" for instruc-
tions on how to do this.

The display of the elements on the monitor also 
serves as a preview for the various laser functions. 
The display of your elements thus also depends on 
the laser function that has been selected. When 
the program is launched, the laser function "Cut" 

Info:
If you want to catapult, the fields shown in blue 
must be filled in. Otherwise these fields may be 
left blank.
If you wish to resume work on an existing ex-
periment or with an existing sample you can do 
this using the selection list for the fields.

Info:
Slide positions for which you have entered in-
formation are represented in the Navigator as 
white areas. Positions for which no data has 
been entered are shown shaded (see illustra-
tion in chapter 6.1 "Start and Quit PALM Navi-
gator").

Note!
It is sometimes not possible for the laser to 
process elements located very close to the 
edge of the slide. If you draw elements here, 
they will be deleted automatically by the PALM 
RoboSoftware.
When installing your sample on the slide make 
sure that the areas to be processed do not 
come too close to the edge of the slide.
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is enabled by default. When you switch among the 
tools for drawing "Figure", "Dot", and "AutoCircle" 
elements, PALM RoboSoftware also switches auto-
matically between the laser functions "Cut", "LPC" 
and "AutoCircle"; the display on the monitor is also 
altered accordingly. Chapter 10.3 "Selection of Au-
tomatic Laser Functions" includes instructions on 
selecting a different laser function yourself, and 
chapter 10.4 "Preview of the Automatic Laser 
Functions" describes the changes in the display of 
elements on the monitor.

The program automatically assigns a number to 
each drawn element. If you have not changed the 
default setting this number is displayed. Refer to 
chapter 7.7.4 "Updating the Element Numbering" 
for instructions on how to show or hide these num-
bers.

To activate one of the graphic tools:

• Click on the icon of the desired graphic tool in 
the Graphic Toolbar.

The icon button appears to be "pressed"; the cur-
sor changes to a shape that symbolizes the tool in 
use. An appropriate laser function for the tool in 
use is also selected (with the exception of the text 
tool and ruler): For tools with which you draw cut 
lines, this is the "Cut" function, for the "Dot" tool it 
is the "LPC" function and for the "AutoCircle" tool 
it is the "AutoCircle" function.

The starting point of the element to be drawn is 
the point of the line tools, and the center of the 
crosshairs in the case of the circle and rectangle 
tools. LPC dots are set at the tip of the cursor; this 
is also where the center point of AutoCircle ele-
ments are set.

The tool selected remains active until you select 
another drawing tool or another function. You can 
see which graphic tool is currently in use by the 
appearance of the cursor and of the associated 
icon button; the button in question appears "de-
pressed".

7.2.1 Drawing in the Various Program 
Modes

As is described in chapter 2.3.4 "Software Modes" 
PALM RoboSoftware works in a number of modes. 
You can draw elements in Cursor Mode and in 
Freeze Mode. Cursor Mode is the default mode for 
PALM RoboSoftware; it is set automatically when 
the program is launched. Chapter 12.5 "Freeze 
Mode" includes instructions for switching into and 
out of Freeze Mode.

In both modes, you can draw elements inside the 
Scroll Rectangle without limitations and with all 
graphic tools (you can switch the display of the 
Scroll Rectangle on and off using menu command 
"View>Scroll Rectangle"). Outside the boundary of 
the Scroll Rectangle, you can also draw with all 
graphic tools in Freeze Mode, and with all graphic 
tools except the Freehand Tool in Cursor Mode:
- If you are in Freeze Mode and move outside the 

Scroll Rectangle with the mouse while drawing, 
the stage does not follow the movement. How-
ever, you can continue to draw even beyond the 
border of the visible image. You can check the 
result by exiting Freeze Mode again and moving 
the stage so that your element is displayed in its 
entirety on the monitor. However, this practice 
of drawing outside the border in Freeze Mode is 
not to be recommended because it means that 
you have no control over your drawing.

- If you are in Cursor Mode and you move outside 
the Scroll Rectangle with the mouse while 
drawing, the stage follows the movement auto-
matically for all tools except the Freehand Tool 
(for instructions on how to draw outside the 
Scroll Rectangle with the Freehand Tool, refer 
to chapter 7.2.3 "The Freehand Tool").

Select a low scrolling speed for the stage, so 
that the movement of the image on the monitor 
can be easily followed with the naked eye.

7.2.2 The Reference Point Tool

With the Reference Point Tool you define reference 
points on your sample. For example, you need 
them for the "Serial Sections" function (refer to 
chapter 10.9 "The "Serial Sections" Function").
• Select the Reference Point Tool in the Graphic 

Toolbar.
• Click on that point in your image at which you 

want to set a reference point.

7.2.3 The Freehand Tool

Use the Freehand Tool to draw irregularly shaped 
elements.
• Select the Freehand Tool in the Graphic Toolbar.
• Move the cursor to the dot where you want to 

begin your drawing.
• Hold the mouse button down while you draw the 

required shape and release it at the end dot.

Info:
This section is concerned with the software 
modes in the PALM RoboSoftware. These are 
totally unrelated to the Database and File oper-
ating modes.

Reference Tool (Reference Point)

Freehand Tool
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7.2.4 The Line Tool

Use the Line Tool to draw straight lines. 
• Select the Line Tool in the Graphic Toolbar.

If you select "Quadratic Attribute" as well, the 
drawing function is limited to horizontal and 
vertical lines.

You now have two options for drawing your line:
• Click on the point where you want to start your 

line and hold the mouse button down. 
• Move the cursor with the mouse button held 

down (the line is displayed). 
• Release the mouse button if you want to set a 

corner point and press it again when you want 
to continue drawing your line. The continuation 
of the line is displayed.

• Double click on the dot where you want to end 
your line.

or
• Click once on the dot where you want to start 

your line. 
• Click once on the point at which you want to set 

a corner dot.
• Double click on the dot where you want to end 

your line.

7.2.5 The Rectangle Tool

Use the Rectangle Tool to draw rectangles. The dot 
at which you begin your drawing becomes a corner 
of the rectangle.
• Select the Rectangle Tool in the Graphic Toolbar.

If you select "Quadratic Attribute" as well, the 
drawing function is limited to squares. 
If you select "Centric Attribute" as well, the dot 
at which you begin your drawing becomes the 
center point of the rectangle or the square.

• Move the cursor to the dot where you want to 
begin your drawing.

• With the mouse button pressed down, drag the 
rectangle or square out until it is the desired 
size and then release the mouse button.

7.2.6 The Circle Tool

Use the Circle Tool to draw circles or ellipses. The 
dot at which you begin your drawing becomes a 
corner of a perceived rectangle enclosing the circle 
or the ellipse.
• Select the Circle Tool in the Graphic Toolbar.

If you select "Quadratic Attribute" as well, the 
drawing function is limited to circles. 
If you select "Centric Attribute" as well, the dot 
at which you begin your drawing becomes the 
center point of the ellipse or the circle.

• Move the cursor to the dot where you want to 
begin your drawing.

• With the mouse button pressed down, drag the 
oval or circle out until it is the desired size and 
then release the mouse button.

7.2.7 The Dot Tool

Use the Dot Tool to mark, for example, individual 
cells that are to be catapulted with the "AutoLPC" 
automatic laser function.
• Select the Dot Tool in the Graphic Toolbar.
• Click roughly in the middle of the cell you later 

want to catapult.

The selected location is displayed as a dot.

Info:
If you are in Cursor Mode, you can only use the 
Freehand Tool inside the Scroll Rectangle. 
When you reach the edge of this rectangle, the 
line stops automatically. The program switches 
to Scroll Mode, the stage is moved. 
As soon as you release the mouse button and 
the stage stops moving, you can continue the 
line as explained in chapter 7.7 "Processing El-
ements".
In Freeze Mode, however, you can continue to 
draw with the Freehand Tool outside the Scroll 
Rectangle (for a detailed explanation, refer to 
chapter 7.2.1 "Drawing in the Various Program 
Modes").

Line Tool

Quadratic Attribute

Rectangle Tool 

Quadratic Attribute

Centric Attribute

Circle Tool

Quadratic Attribute

Centric Attribute

Dot Tool
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7.2.8 The AutoCircle Tool

Use the AutoCircle Tool to quickly mark individual 
areas on your sample. The tool draws a circle and 
the center of the circle with a click of the mouse. 
When you release the "AutoCircle" laser function, 
the marked area is cut out along the circumference 
of the circle and is catapulted into your cap by a 
laser pulse to the center of the circle.

You can adjust the diameter of the circle.

To adjust the diameter of the AutoCircle circle:

• Click on the "LPC-Parameter ... " entry in the 
"Laser" menu.

The "LPC Parameters ... " window opens.
• Enter the desired radius in µm in the "AutoCir-

cle" field.
• Close this window by clicking on "OK".

To draw an AutoCircle type element:

• Select the AutoCircle Tool in the Graphic Toolbar.
• Click close to the middle of the area that you 

want to cut out in a circle and catapult later.

The selected site is indicated by a dot, which is 
surrounded by a circle.

7.2.9 The Text Tool

Use the Text Tool to add markings with or without 
textual comments to your image. The marked sites 
are displayed as flags, the comments in a rectangle. 
Comments are always displayed on one line. You can 
select or subsequently change the color of the com-
ment background and flag, as described in chapter 
7.8 "Changing Colors and Line Thickness". 

Text elements are ignored by the laser functions.

To place a marking: 

• Select the Text Tool in the Graphic Toolbar.
• Click on the point at which you want to place 

your marking.

A marking will appear as a flag at the selected site. 
The "Text Element" window opens.
• If you want to add a comment to your marking, 

enter the desired comment. Close the window 
by clicking on "OK".
If you do not want to add a comment, close the 
window by clicking on "Cancel".

Your comment will appear at the foot of the flag.

You can also assign a name to the element (this 
procedure is described in chapter 7.7.5 "Adding a 
Name or a Comment to Elements"). In this case, 
the name of the text element is shown in place of 
the element number.

AutoCircle Tool

Note!
Elements that have already been drawn are 
not affected when this setting is changed.

Note!
The radius of an element that has been drawn 
cannot be altered subsequently. Therefore, if 
your setting proves to be unsuitable, you 
must delete the element, change the radius 
as described above, and draw a new element.

Info:
If you have set a high magnification and/or a 
large radius, it may happen that the circle ex-
tends beyond the section of the microscope im-
age displayed on the monitor and therefore is 
not visible. You will then see only the center 
point of the element.

Text
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7.3 The "Element List" Window

The "Element List" window provides a summary in 
table format of all selected elements. You can 
check various parameters, change them, and acti-
vate various functions.

To open the "Element List" window:

• Click on menu item "Element List" in the "View" 
menu, or click in the Status Bar on the field 
showing the number of elements.

Depending on the slideholder used you will find at 
least two tabs: one for displaying totals and one or 
more for your slide(s) (in the example shown there 
is one tab each for the 3 slides in a 3-slide holder).

The window can be resized. If not all of the table's 
columns are in view, use the scroll bar to move 
across the table.

7.3.1 Items Shown on the Slide Tab

The "Show Types" field allows you to decide 
whether all elements or only the elements of spe-
cific types are to be listed (Lines, Freehands, Dots, 
AutoCircles, Rulers, Text, References, etc.).

Information on individual elements in the columns 
of the table:
- Color: color in which the element is displayed 

on the monitor

- Nr: sequential number of the element

- Name: name of the Elements (you can enter 
and edit the name via the menu command "Edit 
> Change")

- Type: element type (Line, Freehand, Dot, Auto-
Circle, Ruler, Text, Reference, etc.)

- cut, shot: number of "cut" and "shot" laser 
functions performed

- Area (µm2): area of the elements of type "Fig-
ure" and "AutoCircle" (for elements of other 
types, an area value has no meaning)

- Grp: name of the group, if the element belongs 
to an element group

- Comment: possibly a comment entered by you 
(for element types "Reference" "Reference" is 
automatically entered here). You can edit this 
entry via the menu command "Edit > Change".

- H x W: height and width of the elements

- Position: coordinates of the element

Selected elements are shown on a blue background, 
while elements that have already been processed by 
the laser are shown on a green background.
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7.3.2 Items Shown on the Summary Tab

The "Show Types" field allows you to decide 
whether all elements or only the elements of spe-
cific types are to be listed. (Lines, Freehands, 
Dots, AutoCircles, Rulers, Texts, References, etc.).

If you are using a multiple slideholder (e.g. 3-slide 
holder) you can use the field "Show summary for" 
to specify whether total values are to be shown for 
only one slide or for all the slides combined.

The elements are grouped in the table by color and 
element type:
- Color: color in which the elements are dis-

played on the monitor

- Type of elements: element type (figure con-
tains all elements formed with a line)

- Number of elements: number of elements 
whose color matches "Color" column and type 
matches "Type of Elements" column.

- Area (µm2): Area of the elements (only ele-
ments of type "Figure" and "AutoCircle"; for el-
ements of other types, an area value has no 
meaning)

- Remarks: specifies how many elements exist, 
and of what type in the relevant color 

The following summary information for all ele-
ments can be found below the table: 
- total number of elements

- the total area of all elements of type "Figure" in 
the wider sense and "AutoCircle"
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To specify which slide the total values should 
be shown for:

(only for multiple slideholder)

• Click on the arrow on the right by the "Show 
summary for:" field on the "Summary" tab.

A list containing all the slides will open (example 
shows the 3-slide holder).
• Click on the name of the slide for which you 

would like total values to be displayed, or
click on "over all" if total values for all slides are 
to be displayed together. 

Total values for the selected slide or for all slides 
together are displayed. 

7.3.3 Change Items Shown

To specify which element types are to be 
listed:

• Click on the arrow to the right of the "Show 
Types" field.

A list containing all the element types will open.
• If you want to enable or disable a listing of all 

element types in the table, click in the "All" 
checkbox, or
click in the checkboxes in front of the types you 
want to include or exclude from the list. 

A check in the checkbox indicates that the respec-
tive element type will be listed in the table.
• Click on the arrow to the right of the "Show 

Types" field to close the selection list.

Only the selected element types continue to be 
displayed. 

To change the table format of "Element List" 
window:

To change the column width 
• Move the cursor in the table header to the col-

umn dividing line on the right of the column the 
width of which you want to change.

The cursor changes to a double-headed arrow with 
a diagonal line.
• Keeping the left mouse button depressed, pull 

the border to the required width, 

or
• double-click on the column separator line in the 

table header.
The column width is set to the smallest width 
that still allows all entries to be read.

To change the sort sequence,
• click on the title of the column you want to use 

as the sort criterion. Click on the column title 
again to reverse the sort sequence.

A triangle with the apex pointing up or down ap-
pears in the table header for the corresponding 
column. This indicates that the entries in this col-
umn are sorted in ascending or descending order.

Info:
Enabling or disabling the listing of element 
types does not affect the display of the ele-
ments on the monitor in any way. Refer to 
chapter 7.4 "Displaying and Hiding Elements" 
for instructions on how to show or hide these 
numbers.
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7.3.4 Functions in the "Element List" 
Window:

- Creating a new set of elements
(File Mode)

- Saving elements

- Loading saved elements

- Export information of the elements

- Import information of the elements

- Printing of elements to a file or on a printer

- Selecting and deselecting elements

- Changing properties of the elements

- Deleting single elements or all elements (only 
elements that have not yet been processed 
with the laser can be deleted)

- Updating the Element Numbering

- Forming and editing groups of elements

- Centering elements on the monitor

- Working with the "Serial Sections" function (re-
fer to chapter 10.9 "The "Serial Sections" Func-
tion")

- Selecting elements for laser functions

- Selection of laser function

- Starting the laser function

- Stopping a running laser function.

7.4 Displaying and Hiding Elements

All elements are displayed in the default configu-
ration of PALM RoboSoftware. You can hide the el-
ements.

To display or hide elements:

• Click on the "Graphic on/off" icon in the Graphic 
Toolbar, or 

• Click on menu item "Show Elements" in the 
"View" menu.

Both commands work as a toggle.

Info:
All the functions listed are available via menu 
commands or icon buttons in the PALM Ro-
boSoftware main window. 

Info:
Even when the "Element List" window is open, 
you can still access all the functions that are of-
fered in the PALM RoboSoftware main window. 
This means that you do not have to close the 
"Element List" to continue working. 

Graphic on/off

Info:
If the display has been switched off, then it is 
switched back on automatically when new ele-
ments are drawn.
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7.5 Centering Elements on the Monitor

The image on the monitor only represents a sec-
tion of your sample. If you have drawn multiple el-
ements, usually not all of these are visible on your 
monitor at the same time. If you want to view a 
particular element, you can either find it by mov-
ing the stage or you can have PALM RoboSoftware 
display it for you automatically at the center of the 
image.

Certain elements can be centered automatically 
using icon buttons or menu commands:
- the first or last element drawn; 

- the element drawn immediately before or after 
the element currently centered.

You can center any element using the "Element 
List".

To center specific elements using icon but-
tons:

• Click on one of these buttons in the Tool Bar:
"First Element",
"Last Element", 
"Previous Element" or 
"Next Element".

The required element is centered on the monitor.

To center defined elements using menu com-
mands:

• Click on one of these commands in the "Move" 
menu:
"Goto First Element", 
"Goto Prev Element",
"Goto Next Element" or 
"Goto Last Element".

The required element is centered on the monitor.

To center a defined element using the "Ele-
ment List":

• Open the "Element List" in one of the modes 
described in chapter 7.3 "The "Element List" 
Window".

• Select the element you want to center (click in 
the corresponding row with the element you 
want to select; but do not click in the checkbox 
on the left border).

• Click on the "Goto" icon button, or
• click on menu command "Goto" in the "Ele-

ment" menu.

The desired element will be centered on the monitor.

To center an element by moving the stage:

To center an element, you can also scroll over the 
sample or position the stage with the arrow keys 
(refer to chapter 5 "Positioning the Stage" for in-
struction on how to do this). However, these meth-
ods can only help the process if you know where 
your element is.

First Element Last Element

Previous 
Element

Next Element

Goto

Info:
You can change the movement speed of the 
stage when targeting the desired element. Re-
fer to chapter 5.3 "Setting Speed" for instruc-
tions on how to proceed (Speed for the 
"Position" movement type).
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7.6 Selecting and Deselecting Elements

You can select elements either on the monitor or 
in the "Element List" window. Which method you 
should choose, depends on the next operation you 
want to do with the selected elements: 
- If you want to edit elements as described in 

chapter 7.7.2 "Editing Elements", you have to 
select them on the monitor.

- For all other operations with elements you can 
select them on the monitor or in the "Element 
List" window. 
It is often more simply to do this in the "Ele-
ment List" window, because here you have an 
overview of all drawn elements.

With both methods you can select a single ele-
ment, multiple or all elements. 

7.6.1 Selecting and Deselecting Ele-
ments on the Monitor

On the monitor selected elements are displayed 
with a surrounding white rectangle. At all corners 
and in the center of each rectangle side a white 
square is displayed. 

To select all elements:

• Click on menu item "Select All" in the "Edit" 
menu (main window), or
press key combination Ctrl+A.

The keyboard command works as a toggle. With 
this command you can select all elements only if 
no element was selected before, ie, their effect de-
pends on the previously applied settings: 
- If all elements were deselected, they will now 

be selected.

- If single or all elements were previously select-
ed, they will now be deselected.

To select a single element:

• Select the Pointer Tool in the Graphic Toolbar.
• Click once with the mouse on the element, or 

move the cursor with the mouse button 
depressed to pull up a rectangle that surrounds 
the element you require entirely or partly.

If your elements are overlapping, you might not be 
able to select a single element with the described 
methods without selecting adjacent elements also. 
• In this case keep the Ctrl key pressed and click 

on the desired element until it is selected: with 
each click the next of the stacked elements will 
be selected.

To select multiple elements:

• Select the Pointer Tool in the Graphic Toolbar.
• Click with the mouse on the first element you 

want to select.
• Press and hold down key "Shift"; click on all 

other elements you want to select as well.

To stop selection of elements:

• Click on menu item "DeSelect All" in the "Edit" 
menu, or
press key combination Ctrl+A, or
if it is not yet active, select the Pointer Tool in 
the Graphic Toolbar and click anywhere outside 
the selection rectangle. 

All elements will be deselected.

Note!
Note that the elements selected on the mon-
itor are not selected in the "Element List" win-
dow and vice versa.

Info:
The white selection rectangle partly covers the 
lines of the elements. You cannot see the se-
lected element completely; if you have select-
ed a rectangular element for example, you see 
the selection rectangle only.

Pointer Tool

Ctrl key + Pointer Tool

Shift key + Pointer Tool

Info:
If elements outside of the image section dis-
played on the monitor are selected, it is possi-
ble that you do not see the selection rectangle 
as it is larger than the monitor. In this case you 
cannot deselect the elements with one mouse 
click.

Info:
If you want to deselect only single of multiple 
selected elements, first you have to deselect all 
elements; then select the desired elements 
again.
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7.6.2 Selecting and Deselecting 
Elements in the "Element List" 
Window

The selected elements in the "Elements List" win-
dow are highlighted in blue.

To select or deselect all elements:

• Click on menu item "Select All" or "DeSelect All" 
in the "Edit" menu, or

To select or deselect single elements:

• If you want to select a single element, click on 
the corresponding entry in the table of the "Ele-
ment List" window.
If you want to select multiple elements, keep 
the "Ctrl" or "Shift" keys pressed and click on 
the corresponding entries successively.

• If you want to deselect the elements, click in an 
empty line in the table.

7.7 Processing Elements

You can process and change drawn elements in to-
tal or in part in various ways: you can 
- delete elements or restore deleted elements 

(refer to chapter 7.7.1),

- edit elements (refer to chapter 7.7.2),

- copy elements (refer to chapter 7.7.3),

- update the numbering of the elements (if you 
have deleted some elements; refer to chapter 
7.7.4),

- add comments to the elements or edit existing 
comments (refer to chapter 7.7.5),

- change the color in which the elements are dis-
played on the monitor (refer to chapter 7.8.3).

7.7.1 Deleting Elements and Restoring 
Deleted Elements

You can delete all elements at once or only the last 
drawn element or one or more selected elements. 

To delete all current elements:

• Click on the "Delete all unprocessed elements" 
icon button, or
click on menu item "Delete all unprocessed ele-
ments" in the "Edit" menu (in the main window 
or in the "Element List" window), or 
press key combination Ctrl+Y.

A prompt appears: "Do you really want to delete 
all Elements?"
• Confirm the prompt by clicking "OK".

Any elements that have not yet been processed by 
the laser are deleted.

Info:
With this method you can select groups of ele-
ments of the same type and color by clicking on 
the corresponding entry in the table on the 
"Summary" tab. Depending on the choice 
made in the "Show summary for" field (refer to 
chapter 7.3.2 "Items Shown on the Summary 
Tab"), either all elements or the elements on 
one slide are shown.

Info:
Elements that have already been processed by 
the laser cannot be deleted.

Delete all unprocessed elements 
(main window)

Delete all unprocessed elements 
("Element List" window)
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To delete the last drawn element:

• Click on the "Delete last element" icon button, 
or 
press the backspace key on the keyboard, or
click on menu item "Delete last element" in the 
"Edit" menu. 

To delete any elements:

There are several options available:
• Select the element you want to delete on the 

monitor (with Pointer Tool) or in the "Element 
List" window and press key "Del",

or

• Select the element you want to delete on the 
monitor and click on menu item "Delete 
selected elements" in the "Edit" menu of the 
main window,

or
• Select the element you want to delete in the 

"Element List" window and click on menu item 
"Delete selected elements" in the "Edit" menu.

The element will be deleted.

If you select multiple elements, you can also de-
lete multiple elements simultaneously with this 
command.

To restore deleted elements:

• Click on menu item "Undelete" in the "Edit" 
menu (in the main window of the PALM 
RoboSoftware), or
press key combination "Alt+Backspace".

The last performed deletion command is undone. 

Info:
If you are working in File Mode (refer to chapter 
1.6 "File Mode and Database Mode"), you can 
also delete all elements by clicking on "New El-
ements" on the "File" menu. In this case, any 
elements that have already been processed by 
the laser will also be deleted.
If you are working in Database Mode and cre-
ate a new record group (refer to chapter 7.1.2 
"Working in Database Mode") or select a new 
record group (see 8.3 "Saving and Loading El-
ements in Database Mode"), your elements will 
likewise disappear from the screen. They are, 
however, saved in the database and can be re-
trieved at any time.

Delete last element

Info:
You can repeat this function many times. Each 
time, the latest of the remaining elements will 
be deleted.

Info:
If the last element to be drawn has already 
been processed with the laser, you can no long-
er delete it. In this case the icon button and/or 
menu command is/are disabled.

Info:
If you have deleted several elements, you can 
call up the function repeatedly. 
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7.7.2 Editing Elements

There are a number of ways for you to change 
drawn elements at a later time. The options avail-
able to you depend on the type of the element.

"Figure" elements (lines, rectangles, ellipses) and 
"AutoCircle" elements:
- You can move these elements.

- You can change their shape.

- You can extend lines.

- You can merge two elements into one.

"Dot" elements, "Ruler" elements (measuring 
lines) and "Reference" elements:
- You can move these elements.

"Text" elements:
- You can move these elements.

- You can change the text.

You can restore changed elements (see section 
"To Restore Edited Elements" in this chapter).

Elements are treated by PALM RoboSoftware as 
polygons; they consist of straight lines and dots, 
the anchor points. Each element consists of at 
least two anchor points and a line. 

With some functions for editing elements you can 
work more precisely if the anchor points are visible.

To show or hide the anchor points of the ele-
ments:

• Click on menu item "Show Points" in the "View" 
menu.

The menu command works as a toggle.

The anchor points are displayed as white squares 
and are numbered.

To move elements:

• Select the element you want to move.
• Drag the Pointer on the element you want to 

move. The cursor changes to a fourfold headed 
arrow.

• With the Pointer Tool, click anywhere in the ele-
ment or in the Selection Rectangle (if one 
exists) and drag the element to its new position 
with the mouse button held down.

• Release the mouse button.

To continue elements (lines, rectangles, 
ellipses)

• Select the Freehand Tool
• Press and hold the Ctrl key.

Info:
Note that you need to select the element you 
want to edit on the monitor (not in the "Ele-
ment List" window).

Pointer Tool

Info:
If you have selected multiple elements or an el-
ement group, all selected elements or all ele-
ments of the groups respectively are moved.

Note!
Select the laser function "Cut" before continu-
ing the element (refer to chapter 10.3 "Selec-
tion of Automatic Laser Functions" for 
instructions on how to proceed). Otherwise you 
will not obtain the desired result.

Ctrl key + Freehand Tool
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• Move the cursor to the start or finish dot of the 
element that you want to continue (the start 
and finish dots of an element are indicated by a 
small square with thick black lines and the 
same color as the element). 

• Keeping the mouse button depressed, draw the 
desired extension.

To join two elements (lines, rectangles, 
ellipses):

• Select the Freehand Tool
• Press and hold the Ctrl key.
• Move the cursor to the start or finish dot of the 

first element (the start and finish dots of an ele-
ment are indicated by a small square with thick 
black lines and the same color as the element). 

• Keeping the mouse button depressed, draw the 
connecting line to the start or end dot of the 
second element.

As soon as you have reached the start or finish 
dot, a small square with thick lines in the color of 
the element appears here.

Both elements are joined and are assigned a num-
ber as a new element.

To change the shape of elements (lines, 
rectangles, ellipses, AutoCircle):

• Select the Freehand Tool
• Press and hold the Ctrl key.
• Move the cursor to the area you want to edit. 

The nearest anchor point of the element is indicat-
ed by a rectangle with black lines.
• Keeping the mouse button depressed, draw the 

changed line. 

As soon as you have reached the element again, 
the nearest anchor point is displayed as a rectan-
gle with black lines and the color of the element.
• First release the mouse button, then the Ctrl 

key.

Note!
Please take care that a square with thick black 
lines is displayed. A square with thin black lines 
indicates an anchor point of the element. If you 
continue drawing from one of these points, you 
change the shape of the consisting elements 
(see  "To change the shape of elements (lines, 
rectangles, ellipses, AutoCircle):" below in this 
chapter).

Note!
Select the laser function "Cut" before joining 
the elements (refer to chapter 10.3 "Selection 
of Automatic Laser Functions" for instructions 
on how to proceed). Otherwise you will not ob-
tain the desired result.

Ctrl key + Freehand Tool

Info:
If you have added a comment to each of the 
two elements you want to join, the comment of 
the element with the higher sequential number 
is deleted by joining; the comment on the ele-
ment with the lower sequential number is as-
signed to the new element.
If the elements you have joined were in two 
different colors, the new element will be dis-
played in the color of the element that had the 
lower sequential number.

Note!
Select the laser function "Cut" before changing 
the shapes of the elements (refer to chapter 
10.3 "Selection of Automatic Laser Functions" 
for instructions on how to proceed). Otherwise 
you will not obtain the desired result.

Ctrl key + Freehand Tool
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The new drawn line is joined with the displayed an-
chor point (see above). The previous line between 
start and end dot of the correction is deleted.

To stretch elements (lines, rectangles, 
ellipses, AutoCircle):

• Select the element you want to stretch.
• Drag the Pointer on one of the squares at the 

corners or sides of the selection rectangle.

The cursor changes to a double-headed arrow.
• Pull with depressed mouse button.

The selected element is stretched. The square op-
posite to the selected square serves as a bench 
mark.

To rotate elements (lines, rectangles, 
ellipses, AutoCircle):

• Select the element you want to rotate.
• Drag the Pointer on one of the squares at the 

corners of the selection rectangle.
• Press and hold the Ctrl key.

The cursor changes to a circular arrow.
• Pull with depressed mouse button.

The selected element is rotated. The square oppo-
site to the selected square serves as point of rota-
tion.

To rotate and stretch elements (lines, rect-
angles, ellipses, AutoCircle):

• Select the element you want to stretch and 
rotate.

• Drag the Pointer on one of the squares at the 
corners of the selection rectangle.

• Press and hold the Ctrl and Shift keys.

The cursor changes to a circular arrow.
• Pull with depressed mouse button.

The selected element is rotated and stretched. The 
square opposite to the selected square serves as a 
bench mark.

To restore a changed element:

• Select the element you want to restore.
• Click on menu item "Restore" in the "Edit" menu.

The last changed element will be restored.

7.7.3 Copying Elements

You can copy any element and insert the copy in 
your image. 

To copy elements:

• Select the element you want to copy, either in 
the main window or in the "Element List" win-
dow (refer to chapter 7.6 "Selecting and Dese-
lecting Elements").

• Click on menu item "Copy" in the "Edit" menu 
(in the main window or in the "Element List" 
window).

• Click on menu item "Paste" in the "Edit" menu 
(in the main window or in the "Element List" 
window).

Note!
If you first release the Ctrl key and then the 
mouse button, the element between the start 
dot of your correction and the end dot of the el-
ement is removed (see below)!

Pointer Tool

Info:
The original proportions of the elements are 
not retained when stretching the elements.

Ctrl key + Pointer Tool

Ctrl key + Shift key + Pointer Tool

Note!
If you have joined two elements and if you use 
the function "Restore" for the new developed 
element, the original element with the lower 
number is restored. The original element with 
the higher number cannot be restored.
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A copy of the element will be pasted; the copy is 
selected. 
• Move the copy to the required position.

7.7.4 Updating the Element Numbering

PALM RoboSoftware numbers all the elements that 
you draw: As soon as you have drawn a new ele-
ment, it is assigned a number automatically. This 
number is increased by one for each additional el-
ement. If you delete elements, the remaining ele-
ments keep their respective numbers. If you want 
to renumber your elements sequentially, you can 
perform a renumbering operation.

You can enable and disable the numbering display. 
In the default configuration of the software, the 
numbering is displayed. 

To show or hide the numbering of the ele-
ments:

• Click on the "Number on/off" icon button or
click on menu item "Show Numbers" in the 
"View" menu.

To update the numbering of your elements:

• Click on menu item "Renumber all" in the "Edit" 
menu (in the main window or in the "Element 
List" window), or
click on the "Renumber" button (in the "Ele-
ment List" window), or 
open the context menu and click on menu item 
"Renumber all", or

All elements will be numbered sequentially.

7.7.5 Adding a Name or a Comment to 
Elements

You can add a name and/or a comment to all ele-
ments (not only text elements). The name of an el-
ement is displayed at its start dot for the number 
as well as in the "Element List" window in the 
"Name" column. A comment is displayed in the "El-
ement List" window in the "Comment" column.

You can edit a name or a comment at any time. 
Proceed as you would for writing a name or com-
ment.

To add a name or comment to an element:

If you do not have the "Element List" window open:

• Select the element to which you want to add a 
name or a comment.

• Click on menu item "Change" in the "Edit" 
menu.

The "Element Properties" window will open.
• Enter your name in the "Name" field or your 

comment in the "Comment" field.
• To close the "Element properties" window, click 

"OK".

Info:
If you want to work with the keyboard short-
cuts "Ctrl+C" and "Ctrl+V", you have to se-
lect the element you want to copy on the 
monitor, not in the "Element List" window.

Info:
You can also select and copy multiple ele-
ments at the same time.

Number on/off

Renumber
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If you have the "Element List" window open:

• Click in the "Element List" window on the ele-
ment you want to name or annotate.

• Click on the "Change" icon button, or
Click on menu item "Change" in the "Edit" 
menu.

The "Element Properties" window will open.
• Enter your name in the "Name" field or your 

comment in the "Comment" field.
• To close the "Element properties" window, click 

"OK".

7.8 Changing Colors and Line Thickness

You can change the colors and line thicknesses 
with which the elements and laser dots are dis-
played on the monitor. The new settings apply to 
new elements drawn thereafter. The changed set-
tings are retained after the program is closed 
down. If you restore the factory defaults (refer 
also to chapter 3.5 "Restoring Settings"), all the 
changes you made to color and line thickness set-
tings will also be lost.

For elements that have already been drawn, colors 
and line thicknesses can also be changed later. 

7.8.1 Selecting Colors for Elements to be 
Drawn New

PALM RoboSoftware includes a Color Palette and a 
window in which you can select the colors you 
want available. There are 18 colors and three 
shades of gray (besides black and white) available. 
- In the Color Palette, you can select a line or dot 

color for drawing new lines or dot elements. 
Working with this palette is particularly advan-
tageous if you want to draw multiple elements 
of the same type which are to be in various col-
ors.

- In the "Colors" window, you can specify colors 
for all element types (Line, Dot, Ruler and Text) 
concurrently. These settings are overwritten 
later by any subsequent changes to the Color 
Palette. In addition, you can select colors for 
the laser function preview. 

However, you cannot draw any further ele-
ments or carry out any other functions until you 
have closed this window.
The settings in the "Colors" window can be 
saved with your other settings in a file to be 
loaded later (refer also to chapter 3.4 "Saving 
and Loading Settings").

Change

Info:
Select the colors so that they contrast strongly 
with your sample. This way your elements will 
be more readily recognizable.
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To change the color settings with the Color 
Palette for new elements you want to draw:

• In case the Color Palette is hidden:
Click on the "Color Palette" icon button on the 
Tool Bar or choose "Color Palette" from 
"View>Menus".

The Color Palette will be displayed.

• Select the Graphic tool with which you want to 
draw the next element.

• Left-click on the desired color in the Color Pal-
ette to select it.

• Draw the required element(s).

The newly drawn elements are displayed in the de-
sired color.

To change the color settings in the "Colors" 
window for new elements you want to draw:

• Click on "Colors" in the Graphic Toolbar. 

The "Colors" window will open.

In the left pane of the window you will see a list of 
element properties whose color can be changed.
• From the "Elements" list in the left window 

pane, select the element the color of which you 
want to change.
- Cut-Line: Color of the lines along which the 

laser is to cut.

- Cut-Area: Color of the element areas if you 
activate the function for showing or calculat-
ing areas (refer also to chapter 7.10 "Mea-
suring").

- LPC-Dot: Color of the dots the laser beam 
touches with the automatic laser function 
"LPC" in order to catapult the area.

- AutoCircle: Color of the circle that the laser 
cuts out and color of the point at which the 
laser strikes the sample to catapult the cut 
area in the automatic "AutoCircle" function.

- AutoLPC-Dot: Color of the dots the laser 
beam touches in the automatic function 
"AutoLPC".

Color Palette Show/Hide

Info:
The selected color only applies to the type of el-
ements that you selected prior to choosing the 
color. If, for example, you have selected a color 
for "Line" type elements and then change to 
the "Dot" graphic tool, new elements of this 
type will be displayed in the color that is select-
ed in the "Colors" window for "LPC Dot"!

Colors
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- RoboLPC-Line: If an open element is envi-
sioned for the "RoboLPC" laser function, but 
the distance between the two finish dots is 
greater than the value specified in "Distance 
of RoboLPC joint" (refer also to chapter 10.5 
"Specifying Laser Settings"), the distance is 
automatically shortened to the preset value. 
This automatically determined line is dis-
played in the color selected here.

Lines that close open elements are also dis-
played in this color if the functions 
"Close&Cut" or "Close&Cut+AutoLPC" are 
selected.

- RoboLPC-Dot: Color of the dot the laser 
beam touches with the automatic laser func-
tion "RoboLPC" in order to catapult the de-
tached area.

- Ruler-Line: Color of the lines for measuring 
(refer also to chapter 7.10 "Measuring").

- Text-Field: Background color of text ele-
ments (the text itself is always black).

- Number-Field: Background color of the field 
with the element number and, where appli-
cable, the comment (number and comment 
are always black).

• Select the desired color from the Color Palette 
in the right window pane.

• Proceed using the same method for all ele-
ments whose color you want to change.

• Close this window by clicking on "OK".

7.8.2 Selecting Line and Dot Thickness 
for Elements to be Drawn New

• Click on the "Lines" icon button.

This opens the "Thickness" window. 

In the three fields in this window you can set val-
ues for the parameters
- Line thickness (1...20): Thickness of "Figure" 

elements,

- Dot thickness (1...50): Diameter of "Dot" ele-
ments,

- Ruler thickness (1...50): Thickness of measur-
ing lines

in pixels.
• Enter the desired values in the corresponding 

fields and confirm your entries by clicking "OK".

Lines

Info:
The set thickness of the lines or dots is not re-
lated to the width of the laser cut line or the di-
ameter of the laser beam. These are dependent 
on the laser parameters setting: laser energy, 
laser focus and movement speed of the stage; 
refer also to chapter 10.5 "Specifying Laser 
Settings".

Info:
Under certain conditions, you may not see the 
effect of a changed line thickness on the mon-
itor: If a laser function that is not used to cut is 
currently set ("LPC" or "AutoLPC") the cut lines 
are displayed as hairlines regardless of the 
specified line thickness.
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7.8.3 Changing Colors of Elements that 
have already been Drawn

the colors of elements that have already been 
drawn can be changed
- using menu commands in the main window,

- via commands in the "Element List", or 

- using an icon button and the Color Palette.

To change the color using a menu command:

• Select the element whose color you want to 
change (in the main window or "Element List" 
window).

• Click on menu item "Change" in the "Edit" 
menu (in the main window or in the "Element 
List" window).

The "Element Properties" window will open.
• Click on the arrow at the top of the "Color" field.

A list opens to display all available colors.

• Click on the desired color and close the window 
by clicking "OK".

The selected element is displayed in the chosen 
color.

To change the color using an icon button and 
the Color Palette:

• In case the Color Palette is hidden:
Click on the "Color Palette" icon button on the 
Tool Bar or choose "Color Palette" from 
"View>Menus".

• Click on the "Change Figure Color" icon button.
• Click on the desired color in the Color Palette.
• Click on the element whose color you want to 

change.
• Click on any other tool on the graphics toolbar 

to turn off the "Change Color" function again.

To change the color of the comment 
background for text elements:

• Select the Text Tool in the Graphic Tools.
• Choose the desired background color from the 

Color Palette.

The background color will be changed.

Info:
For text elements the color of the flag can be 
changed as described below.

Info:
You can only change the color of one element 
at a time. If you have selected multiple ele-
ments or parts of multiple elements, only the 
color of the element with the lowest number of 
all the selected elements is changed.

Info:
For text elements the color of the flag can be 
changed as described below.

Color Palette Show/Hide

Change Figure Color

Info:
If you follow the procedure described below 
you will change the background color of all the 
existing text elements. It is not possible to 
change the background color of one individual 
text element.
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7.9 Working with Element Groups

You can merge multiple elements into a group. For 
example, you need element groups for the "Serial 
Sections" function (refer to chapter 10.9 "The "Se-
rial Sections" Function").

An element group can contain any element types. 
In the "Element List" window groups are processed 
as elements: for each group a separate entry is 
displayed.

You can edit an element group similar to editing 
single elements: You can 
- move, stretch, straighten and rotate or copy 

the entire group (refer to chapter 7.7 "Process-
ing Elements").

- edit or delete single elements within a group 
like ungrouped elements (refer to chapter 7.7 
"Processing Elements").

- center a group of elements on the monitor by a 
menu command (refer to chapter 7.5 "Center-
ing Elements on the Monitor").

- add elements to a group.

- remove elements from a group.

To merge multiple elements into a group:

• Select the elements you want to merge into a 
group either on the monitor or in the "Element 
List" window.

• Click on menu item "Create Group" in the "Edit" 
menu (in the main window or in the "Element 
List" window).

The selected elements are merged into a group. A 
new entry for the group appears in the "Element 
List" window. For the elements belonging to the 
group the name of the group is entered in the 
"Grp" column (the group name is assigned auto-
matically by the PALM RoboSoftware ("Grp04" in 
the example shown above)). 

To the element number of each element contained 
in a group the group number is prefixed. All ele-
ments of the group are displayed with a surround-
ing dashed rectangle. 

Info:
If you want to merge elements into a group, 
add elements to an existing group or remove 
elements from a group, you can use the menu 
commands in the main window of the PALM Ro-
boSoftware or in the "Element List" window af-
ter selecting the elements. 
Note that you have to use the corresponding 
menu command in the main window, if you 
have selected the elements on the monitor. If 
you have, however, selected the elements in 
the "Element List" window, you need to use the 
corresponding menu command in this window.
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To add other elements to a group:

• Select the elements you want to add to a group 
either on the monitor on in the "Element List" 
window.

• Click on menu item "Add to Group" in the "Edit" 
menu (in the main window or in the "Element 
List" window).

If you have created only one element group so far, 
the elements will be added to this group. If you 
have created more than one group, the "Groups" 
window will open.
• Click on the desired group to which the ele-

ments should be added and close the window 
by clicking on "OK".

To remove elements from a group:

• Select the elements you want to remove from 
the group either on the monitor or in the "Ele-
ment List" window.

• Click on menu item "Remove from Group" in 
the "Edit" menu (in the main window or in the 
"Element List" window).

To ungroup elements:

• In the "Element List" window, select the group 
you want to ungroup (do not select the ele-
ments).

• Click on menu item "Delete selected" in the 
"Edit" menu.

The selected group is ungrouped, the elements are 
retained.
• click on the "Renumber" icon button to update 

the numbering of the remaining elements.

To select single elements within a group:

on the monitor:

• Press and hold the Ctrl key.
• Click on the element within the group, that you 

want to select.

The element will be selected.

in the "Element List" window:
• Click on the element you want to select.

Ctrl key + Pointer Tool
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7.10 Measuring

PALM RoboSoftware provides functions for calcu-
lating the length of lines or the size of areas. Area 
sizes are only calculated for elements of type "Fig-
ure" (Line, Freehand, Rectangle or Circle) and "Au-
toCircle". There is no point in showing area sizes 
for any of the other element types.

To measure the length of lines:

• Click on the "Ruler" icon button in the Graphic 
Toolbar, or
If you select "Quadratic Attribute" as well, the 
drawing function is limited to horizontal and 
vertical lines.

The cursor changes to a white arrow.
• Click on the start dot of the line whose length 

you want to determine and keep the mouse 
button depressed.

• With the mouse button depressed, move the 
cursor to the end dot of the line to be measured 
and release the mouse button.

The line will be displayed on the monitor as a line 
with a display of its length in µm.

To show and hide area sizes:

• Click on the "Areas" icon button in the Graphic 
Toolbar.

Area sizes of all drawn "Figure" and "AutoCircle" 
type elements will be shown in µm². At the same 
time, the areas measured will be displayed with a 
transparent color marking.
• To hide the area display, click again on the 

"Areas" icon button in the Graphic Toolbar.

Note!
The measuring functions of the PALM Ro-
boSoftware are not calibrated at the factory; 
they are an estimated value only. P.A.L.M. 
does not guarantee the accuracy of the per-
formed measurements. 
The measuring functions have to be checked 
and, if necessary, calibrated by the user (for 
example, with a ocular micrometer).
Correct determination of lengths and areas re-
quires that your system is correctly calibrated. 
If in doubt, refer to chapter 4.4 "Calibrating the 
Movement of the Stage".

Ruler

Quadratic Attribute

Element areas

Note!
If elements are not drawn closed, the start and 
end points of the elements are connected by a 
straight line for calculating the area.

Info:
Only the area of elements of type "Figure" and 
"AutoCircle" is indicated. The displayed size of 
"Dot" type elements has no relation to the di-
ameter of the laser beam or the size of the cat-
apulted area; the display of an area size for 
these elements therefore has no practical use.



PALM RoboSoftware 3.1-0106 (EN) 81

Settings for Saving Elements in File Mode

8 Saving and Printing Elements

PALM RoboSoftware has a number of options for 
saving, exporting or printing the elements you 
have drawn or their properties,
- to load them into the PALM RoboSoftware later 

on again.
This allows to reuse a sample in the stage and 
superimposing the associated elements on the 
monitor.

- to observe and edit the element properties in 
another program.

- to enable the element properties to be archived 
as a printout. 

To help you with this, three functions are available 
that generate the different output formats: 
- "Save Elements" generates a binary file. That 

binary file can be reloaded or reimported into 
the PALM RoboSoftware (refer to chapter 8.2 
"Saving and Loading Elements in File Mode").

- "Export Elements ... " generates a text file. 
That text file can be reloaded or reimported into 
the PALM RoboSoftware and opened with any 
text editor. You can then choose to view, print 
or edit the data (refer to chapter 8.4 "Exporting 
and Importing Elements")
The file contains all the properties of the ele-
ments that are displayed in the "Element List" 
window (display color, number, element type, 
number of laser actions carried out, area size, 
comment, position) and the coordinates of their 
anchor points. 

- "Print Elements ..." prints your elements on a 
printer or generates an Excel import file. You 
can open such a file with Microsoft Excel or with 
another corresponding program. The file con-
tains all element properties, as you have 
defined with printing of the elements (refer to 
chapter 8.5 "Printing Elements").

8.1 Settings for Saving Elements in File 
Mode

To save elements you can 
- specify a folder.

When you save your settings later, this folder 
will be selected automatically. However, you do 
not have to accept this specification. You can 
also save your elements later in another folder. 
You can also create a new folder when saving.

- determine whether an element file which has 
already been saved but subsequently changed, 
is to be saved automatically when you exit the 
program, or that the changes made are to be 
rejected.

The settings for saving elements can be car-
ried out in this way:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Elements" tab.

The name and full path of the currently set folder 
appear in the "Folder" field of the "Saving Ele-
ments" section. Now you can either specify a fold-
er via the "Folder" field or via the button to the 
right of the field, or create a new folder.

Info:
In Database Mode (refer to chapter 1.6 "File 
Mode and Database Mode") your elements 
are automatically saved in the database. The 
menu commands "Save Elements..." and 
"Open Elements..." are therefore not avail-
able if you are working in Database Mode. 
Chapter 8.3 "Saving and Loading Elements in 
Database Mode" explains how you can reload 
elements from the database.

Info:
When you save images you can specify that 
they are to be saved along with superimposed 
elements (refer to chapter 9 "Saving Imag-
es"). However, it is always only an image of 
the elements that is stored, and you cannot 
load or import it back into the PALM 
RoboSoftware window again. 
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If you want to specify a folder in the "Folder" field:
• Enter the name and full path of a folder in the 

"Folder" field.

• Click on "OK".

If you wish to select a folder using a button:
• Click on the button . 

The "Element folder" window will open. A directory 
tree structure is displayed in the window, and the 
currently set folder appears underneath in the 
"Folder" field.
• Select the desired folder or create a new folder.
• Close the "Element folder" window by clicking 

on "OK".

You are back in the "Elements" register in the 
"Preferences and Configuration" window.

• Click on the checkbox in front of the "Save Ele-
ment-files automatically" option in the "Saving 
Elements" section to enable or disable this 
function.

A tick in the checkbox indicates that this function 
is enabled: then the program is closed, an ele-
ments file will be saved with the name you have 
assigned containing the changes you have made 
since it was last saved (e.g., new elements drawn 
or previous elements deleted).
• Close the "Preferences and Configuration" win-

dow by clicking on "OK".

8.2 Saving and Loading Elements in File 
Mode

In order to be able to use your elements later, you 
must save them separately from your images.

To save your elements in a file:

In the PALM RoboSoftware main window or in the 
"Element List" window:

• Click on the "Save Elements" icon button in the 
Tool Bar, or
click on menu item "Save Elements ... " in the 
"File" menu.

The "Save elements to file" window opens. The ex-
act appearance of this window depends on which 
slideholder you are using (chapter 3.2 "Setting Sli-
deholder" explains how you should notify the soft-
ware of which insert you are using). The 
illustrations below show the windows for the Petri 
dish holder and the 3-slide holder.

Info:
You can also enter the name of a folder that 
does not yet exist. It will be created automat-
ically when you exit the window. 

Info:
In the "Element List" window, you can set the 
display so that only selected types of element 
are displayed in the window (i.e. elements of 
other types do not appear in the "Element List" 
table; refer to chapter 7.3 "The "Element List" 
Window"). This has no effect on the Save oper-
ation: all existing elements will be saved under 
all circumstances.

Save elements
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If you are using a slideholder that can accommo-
date more than one slide, this window can be used 
to save the elements for one or more slides at the 
same time. The elements for each slide are saved 
in a separate file so that they can be reloaded sep-
arately (see next section "To load an elements 
file:"). The window also enables you to enter a 
common name that is used automatically for all 
files before a suffix is added to produce a unique 
file name.
• If you wish to save the elements for all slides: 

Tick the check box "all active", enter a common 
file name in the adjacent field to the right 
("Test" in the example shown above) and then 
click the "OK" button.

• If you wish to save the elements for one or 
more slides: 
Tick the corresponding check boxes ("Slide1", 
"Slide2" and/or "Slide3" in the example), enter 
a file name for each and then click the "OK" 
button.

Your elements will be saved in the specified folder 
(chapter 8.1 "Settings for Saving Elements in File 
Mode" explains how you can specify a different 
folder).

If you wish to save your elements in a folder other 
than the specified folder:

• Click on the button . 

The "Please enter/select a file name" window opens.
• Select the desired folder, enter a file name and 

then click the "Save" button.

The elements are saved and the folder closes.

To load an elements file:

• Click on menu item "Open Elements ... " in the 
"File" menu (in the PALM RoboSoftware main 
window or in the "Element List" window).

The "Load Elements from file" window opens. The 
exact appearance of this window depends on which 
slideholder you are using (chapter 3.2 "Setting Sli-
deholder" explains how you should notify the soft-
ware of which insert you are using). The following 
description applies to the 3-slide holder. You can 
follow the same procedure for other slideholders.

If you are using a slideholder that can accommo-
date more than one slide, this window can be used 
to load the elements for one or more slides at the 
same time.
• If you have saved the elements for several or 

all slides with the same name and now want to 
load them: 
Check the "all active" box, enter the common 
file name in the adjacent field to the right, if 
necessary uncheck the check box for slides for 
which you do not wish to load elements, and 
then click the "OK" button.

Your elements will be loaded for all the selected 
slides.
• If you wish to load the element files for one or 

more slides, and those files were saved with 
different names: 
Check the relevant check boxes ("Slide1", 
"Slide2" and/or "Slide3" in the example), enter 
a file name for each (you may be able to select 

the desired file using the button ), and then 
click the "OK" button.

Info:
If you have drawn and saved elements for a 
slide and now wish to continue working on the 
same slide, you need not necessarily insert it at 
the same position it occupied when the ele-
ments were saved. 
If, for instance, you had the slide inserted at 
position 1, you could now also insert it at posi-
tion 2. You must bear in mind, however, that 
the elements you had saved for position 1 must 
now be loaded for position 2.
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You can also reload the most recently saved ele-
ments using the list of most recently used element 
files on the "File" menu (if you haven't saved any 
elements, this list will be empty):

• In the "File" menu click on the name of the ele-
ment file listed there which you wish to reload.

The loaded elements will appear on your monitor, 
and the name of the elements file will be displayed 
in the title bar of the program window. Any ele-
ments that were already on the monitor will be de-
leted.

8.3 Saving and Loading Elements in 
Database Mode

In Database Mode you do not need to save your el-
ements manually: every drawn element is saved 
immediately and automatically in the database.

To load elements from the database:

• Click on "Enter/Select Data..." in the "File" 
menu in either the main window or the "Ele-
ment List" window, or 
click on the "DATA" icon button.

The "Please select or enter data!" window opens.

• If you are using a slideholder that can accom-
modate more than one slide: select the tab for 
the slide for which you wish to load elements.

In the "Source Data", "Specimen Data" and "Ex-
periment Data" sections of the selection lists in the 
"Label" fields you will find all the entries that you 
have written to the database (refer to chapter 
7.1.2 "Working in Database Mode").
• Open these selection lists one at a time (start-

ing at the top) and select the desired entry.
• Close this window by clicking on "OK".

Your elements are displayed on the monitor and in 
the "Element List" window.

Info:
This method can also be used to transfer ele-
ments from one sample to another, in that you 
draw and save elements for one slide and then 
load them for a different slide (for two consec-
utive tissue samples, for instance). Remember, 
though, that the position and probably also the 
shape of the elements will not be exactly right 
for the second sample, and you will have adjust 
the position and shape by hand. 
It is therefore recommended when transferring 
elements from one slide to another that this is 
done using the "Serial Sections" function (refer 
to chapter 10.9 "The "Serial Sections" Func-
tion"). This function adjusts the position and 
shape of elements automatically.

Info:
If you have used a slideholder that can ac-
commodate more than one slide, then the po-
sition occupied by the slide when the 
elements were saved is shown to the right of 
the file name. However, you can also load the 
elements file for a different position. 

Note!
Take particular care to insert your sample care-
fully and correctly. If the slide is canted or 
twisted, the loaded elements will not match to 
the corresponding structures of your sample. 

Enter/Select Data ...
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8.4 Exporting and Importing Elements

With the "Export" function you create a file that 
can be opened in any text editor.

To export elements:

In the PALM RoboSoftware main window:
• Click on menu item "Export Elements ... " in 

the "File" menu.

The "Element List" window:
• Click on the "Export" icon button, or 

click on menu item "Export Elements" in the 
"File" menu.

The "Export Elements" window will open. The pro-
posed saving location is the folder selected the last 
time you used this function. 
• Select a folder to store your elements as neces-

sary.

• If you have saved your elements previously, 
the name of the file in which they are saved is 
offered by default. If you want to overwrite this 
file, do not change the name in the input field, 
or 
enter a new name for your element file. 

• Click on the "Save" button.

You can now open the file with a text editor and 
read it, print it, or edit and save it again.

To import your elements:

• Click on menu item "Import Elements ... " in 
the "File" menu (in the PALM RoboSoftware 
main window or in the "Element List" window).

The "Import Elements" window will open.
• If necessary, open the folder in which you have 

saved the file. 
• From the displayed list, select the file you want 

to load and click on the "Open" button.

The imported elements are displayed on your 
monitor. Any elements that were already on the 
monitor will be deleted.

Info:
The functions "Export Elements" and "Import 
Elements" are intended primarily for exchang-
ing data with other programs.
If you are working in File Mode, the "Save Ele-
ments" function is recommended for saving el-
ements which you later want to reload into the 
PALM RoboSoftware (refer to chapter 8.2 "Sav-
ing and Loading Elements in File Mode"). 
In Database Mode you do not need to save the 
elements explicitly: they are saved automati-
cally in the database, and can be reloaded from 
there (refer to chapter 8.3 "Saving and Loading 
Elements in Database Mode").

Info:
In the "Element List" window, you can specify 
that only elements of selected types are to be 
displayed in the window (i.e. elements of other 
types are not included in the table in the "Ele-
ment List"; refer to chapter 7.3 "The "Element 
List" Window"). This has no effect on the Save 
operation: all existing elements will be saved 
under all circumstances.

Info:
If you are using a slideholder that can accom-
modate more than one slide, all the existing el-
ements are saved in one file irrespective of 
which sample you have drawn them for.

Export Elements
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8.5 Printing Elements

The "Print Elements..." function can be used to ei-
ther print your elements on a printer or to gener-
ate an Excel import file. 

To print your elements:

• Click on menu item "Print Elements ... " in the 
"File" menu (in the PALM RoboSoftware main 
window or in the "Element List" window).

The "Print Elements" window will open.

• Choose "Elements", if you want to print all ele-
ments or the selected ones only (the option 
"selected" is available if only certain elements 
are selected only.

• In the "Types" list select the element types, 
that should be contained in your file.

You can select which kind of element properties 
the file should contain.

• In the "Attributes" list select the desired entry.

As soon as you select the first entry, the "Select 
Attributes and Define Columns" window opens.

• Select the desired columns and column order 
and click on "OK" to close the window.

• In the list "Sorted by" select the element prop-
erty, to which the list should be sorted.

You can select whether the file should contain ele-
ment summaries:
- "Print Summary !" records the number of the 

elements and the sum of the sizes of their areas 
for each type and color to the file.

- "Print Totals !" records the total number of ele-
ments and their total area to the file.

• If you wish, check the "print Summary!" and 
"print Totals!" boxes.

• In the "Print to:" section you should specify 
whether you want to output the elements on a 
printer or save them in a file.

• Click on "OK".

If you have chosen "File...", the "Print Elements to 
File" window will open. 
• Enter a name for your file, select a folder if nec-

essary and click on "OK".

Your elements will be printed to a file.
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9 Saving Images

You can save the portion of the stage that is cur-
rently displayed on the monitor. You can save in 
three ways: 
- manual saving: every time you enter the corre-

sponding command, the current image will be 
saved. For instructions on how to do this, refer 
to chapter 9.3 "Saving Images Manually".

- automatic saving: every time you release a 
laser function, an image will be saved for each 
element that has been processed with the laser 
before and/or after processing. Enabling and 
disabling automatic saving is described in chap-
ter 9.4 "Saving Images Automatically during a 
Laser Function".

- Time Lapse function (optional): this can be 
used to automatically store series of images or 
video sequences. You can specify the time 
interval between images in a series and the 
duration of a recording.
How to work with the Time Lapse function is 
described in chapter 9.5 "Saving Images and 
Videos Using the Time Lapse Function".

You can specify a Copyright Note. If you have opt-
ed to display the Copyright Note, then it will be in-
serted in every image that you store (refer to 
chapter 9.1 "Inserting a Copyright Note").

If you are working in File Mode (refer to chapter 1.6 
"File Mode and Database Mode") you can specify a 
folder or create a new folder for images to be stored 
in. You can also specify a file name. For instructions 
on how to make these specifications, please refer to 
chapter 9.3 "Saving Images Manually".

If you are working in Database Mode your images 
will be stored in the database. The file name is 
generated automatically.

For automatic storage of images you can specify 
whether your images should be stored with or 
without the superimposed elements. Please refer 
to chapter 9.4 "Saving Images Automatically 
during a Laser Function" for instructions on how to 
do this.

On the other hand, saved images can no longer be 
reloaded into the PALM RoboSoftware window. 
However, the supplied PALM RoboSoftware pack-

age also includes a program, which you can use to 
observe and process your images: the PALM Infor-
mation Center. Instructions for working with the 
Information Center are the subject of the pro-
gram’s user manual.

You can integrate an image processing program 
(referred to in this document as "Imaging Soft-
ware") of your choice, e.g. Adobe Photoshop or 
ACD Systems ACDSee, into the PALM RoboSoft-
ware; this can be done in such a way that you can 
launch the imaging software from within the PALM 
RoboSoftware. Refer to chapter 3.7 "Incorporating 
an Imaging Editing Program" and chapter 1.8.2 
"Imaging Software" for instructions on how to do 
this.

9.1 Inserting a Copyright Note

You can specify a Copyright Note that will appear 
on the image on the monitor and on each stored 
image if you have opted to show it (this option can 
be switched on and off using the menu command 
"View>Copyright").

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Images" tab.

• Enter the desired text into the field "Copyright 
Info" and close the window by clicking "OK".

Note!
When you save the current image, only the 
section of the microscope image that is visible 
on the monitor will be saved, optionally with or 
without the elements within this section.

Note!
If you want to save your elements for subse-
quent use, you must save them separately 
from the images.
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9.2 Specifying Folder to Store Images In

You can specify a folder for storing all images that 
are stored in File Mode - either manually, automat-
ically or using the Time Lapse function. If you are 
storing images manually then you can choose a 
different folder at the time you store them.

To specify a folder:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Images" tab.

The name and full path of the currently set folder 
appears in the "Folder" field of the "Saving Imag-
es" section. Now you can either specify a folder via 
the "Folder" field or via the button to the right of 
the field, or create a new folder.

If you want to specify a folder in the "Folder" field:
• Enter the name and full path of a folder in the 

"Folder" field.

If you wish to select a folder using a button:
• Click on the button . 

The "Image folder" window will open. A directory 
tree structure is displayed in the window, and the 
currently set folder appears underneath in the 
"Folder" field.
• Select the desired folder or create a new folder.

• Close the "Image folder" window by clicking on 
"OK".

You are back in the "Images" register in the "Pref-
erences and Configuration" window.
• Close the window by clicking on "OK".

To select a folder other than the preset folder 
or to create a new folder:

• Click on the "Folder" icon button in the Archive 
Toolbar, or
click on menu item "New Image Folder ... " in 
the "File" menu.

The "Image Folder" window will open.

• If you want to save the image in an existing 
folder, select this in the directory tree and con-
firm your selection with "OK".

• If you want to create a new folder, select the 
folder in the directory where you want to save 
this folder; click on "New Folder" and enter a 
name. 

• Click on "OK".

The window will close. The next time you select a 
save command, the folder selected is preset as the 
save location.

Note!
If you are working in Database Mode, all your 
images will be stored in the database. In this 
case, the folder that has been specified for 
storing the images is irrelevant.

Info:
You can also enter the name of a folder that 
does not yet exist. It will be created automat-
ically when you exit the window. 

Folder

Info:
You can also decide not to select or create a 
new folder until later, when you are ready to 
save an image.
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9.3 Saving Images Manually

When images are stored manually, one image is 
stored every time you enter an appropriate com-
mand. If you are working in File Mode, the images 
are stored in a folder, and when in Database Mode 
they are stored in the linked database (refer to 
chapter 1.6 "File Mode and Database Mode").

9.3.1 Saving Images in File Mode

You can specify a folder and a name for the image 
being saved (refer to chapter 9.2 "Specifying Fold-
er to Store Images In" and text below). When you 
save images later, the specified image name will 
automatically be supplemented with a sequential 
number (... 01, ... 02, ... ).

If you want to save pictures subsequently, these 
assignments are selected automatically. However, 
you can decide whether you want to accept them. 
You can also save your images later in a different 
folder. You can also create a new folder when sav-
ing and assign different names to your images.

To enter a file name for saving images manu-
ally:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Images" tab.

• Enter a name for images to be saved in the 
"Filename" field of the "Saving Images" sec-
tion.

• Close the window by clicking on "OK".

Whenever you save images subsequently, the im-
age name you entered will be supplemented with 
a sequential number (...01, ...02, ...).

To save your image:

• Click on the "Save Image" icon button in the 
Archive Toolbar, or
click on menu item "Save image ... " in the 
"File" menu.

The "Save Image As" window opens; the pre-
defined folder and the predefined file name, with 
the additional sequential number (...01, ...02, 
...03, ...), are preselected and offered (the se-
quential number is incremented by one every time 
you save an image, refer also to chapter  "To enter 
a file name for saving images manually:").
• Select a different folder if you do not want to 

save your elements in this folder. 
• Enter a name for your image file if you do not 

want to use the preset name.

• Choose the format in which you want to save 
your image.

• Click on "Save".

The window will be closed, your image will be saved.

Note!
If you select another folder or another image 
name than the one proposed for saving, these 
settings are adopted as the default settings and 
used for all subsequent saving operations.

Info:
Please note that the image is stored with the el-
ements unless the option to display them has 
been switched off. The elements are stored in 
the same way as they are displayed on the 
screen, i.e. perhaps with their area content 
specified, with or without the element number 
and, if relevant, with changed image parameters 
(refer to chapter 3.9 "Set Image Parameters").
The Copyright Note and scale bar are only in-
cluded with the saved image if they are dis-
played on the screen.
However, other features such as Laser Mark-
ers, crosshairs, etc. are not saved.

Save Image

Note!
The name you enter is taken as a default set-
ting for all subsequent image saving opera-
tions, and thus overwrites the original default 
setting (refer also to chapter  "To enter a file 
name for saving images manually:").

Info:
You can choose between the formats "bmp", 
"tiff" and "jpg". The recommended formats are 
"tiff" of "jpg" since these formats allow addi-
tional information to be saved along with the 
image (stage position, microscope settings).
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9.3.2 Saving Images in Database Mode

No settings need to be made in order to save imag-
es in Database Mode. All images are stored in the 
database. The file name is generated by the PALM 
RoboSoftware: "manual" followed by the next num-
ber in sequence. The sequential number is incre-
mented by one every time you save an image.

To save your image:

• Click on the "Save Image" icon button in the 
Archive Toolbar, or
click on menu item "Save image ... " in the 
"File" menu.

Your image is saved in the database.

9.4 Saving Images Automatically 
during a Laser Function

When saving images automatically, and in each 
case, immediately before and/or after a UV laser 
function, the current microscope image will be au-
tomatically saved. 

If you are working in File Mode (refer to chapter 1.6 
"File Mode and Database Mode"), the images are 
saved in the specified folder (refer to chapter 9.2 
"Specifying Folder to Store Images In"). If you are 
working in Database Mode, the images will be stored 
in the database.

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens. 
• Click on the "Laser" tab.

The "Laser function" section contains four "Auto 
Image" checkboxes. You use these to specify 
whether the microscope image that is currently 
displayed on the monitor is to be saved automati-
cally before or after a laser function. You can de-
cide whether images for laser functions or LPC 
functions, or for both are to be saved.
• Click in one of the four "Auto Image" check-

boxes to enable or disable the corresponding 
function.

A tick in the checkbox indicates that the respective 
function is enabled.

If the function is enabled, images for each element 
processed with the laser will be saved every time 
the laser function is triggered. Names have been 
assigned for the images as follows: 
- "x_BeforeCut",
- "x_AfterCut", 
- "x_beforeLPC", 
- "x_AfterLPC". 

"x" stands for an element number that is assigned 
automatically by the PALM Robo Software. This el-
ement number is incremented starting from "1" for 
each save operation.

Info:
Please note that the image is stored with the el-
ements unless the option to display them has 
been switched off. The elements are stored in 
the same way as they are displayed on the 
screen, i.e. perhaps with their area content 
specified, with or without the element number 
and, if relevant, with changed image parameters 
(refer to chapter 3.9 "Set Image Parameters").
The Copyright Note and scale bar are only in-
cluded with the saved image if they are dis-
played on the screen.
However, other features such as Laser Mark-
ers, crosshairs, etc. are not saved.

Save Image
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If the images are to be saved together with the su-
perimposed elements:

• Activate the checkbox in front of the "Save Ele-
ments in Image" option.

A tick in the checkbox indicates that this function 
is enabled; every time you save an image, it is 
saved together with the associated elements.

9.5 Saving Images and Videos Using the 
Time Lapse Function

The Time Lapse function enables you to 
- record video sequences.
- save series of images. You can specify the time 

interval between images and the period over 
which images can be saved. 

If you are working in File Mode (refer to chapter 1.6 
"File Mode and Database Mode"), the images are 
saved in the specified folder (refer to chapter 9.2 
"Specifying Folder to Store Images In"). If you are 
working in Database Mode the images will be stored 
in the database.

You can either activate the Time Lapse function 
manually or define an event to activate the func-
tion automatically. 

The necessary settings can be configured in the 
"Time Lapse Configuration" window or on the 
"Time Lapse" tab in the "Preferences and Configu-
ration" window. The available settings are identical 
in the two windows.

To open a window for setting the Time Lapse 
parameters:

• Click on the "Time Lapse" icon button.

The "Time Lapse Configuration" window opens.

Or
• In the "Setup" menu, click on menu item "PALM 

Robo ... ". 

The "Preferences and Configuration" window 
opens. 
• Click on the "Time Lapse" tab.

Info:
Please note that images you have saved by 
this method cannot be reloaded into PALM Ro-
boSoftware (refer to chapter 8 "Saving and 
Printing Elements").

Info:
Time Lapse is only available if you have pur-
chased an appropriate license. Please contact 
P.A.L.M. Microlaser Technologies GmbH, if you 
wish to upgrade your system. 

Time Lapse
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To enter the settings, proceed as follows:

• Activate the desired functions using the check 
boxes and/or buttons and enter relevant infor-
mation in the fields.
All the settings are described in detail below.

• Once you have configured your settings, click 
on the "OK" button to close the window.

You should enter various items of information on 
your sample in the "Experiment" section.
- Enter a name for your series of images or video 

sequence in the "Name" field (this field MUST 
be filled in).

- You can enter a description in the "Description" 
field. 

- The "File Prefix" field contains the prefix for the 
name of your video or image files. The content 
of the "Name" field is entered automatically as 
a default; it can, however, be modified or 
added to (although the field must not be left 
blank).

The PALM RoboSoftware automatically adds 
date and time to the prefix entered in the field. 
Every video and image file thus receives a 
unique name.
If you are working in File Mode (refer to chapter 
1.6 "File Mode and Database Mode") all images 
and video sequences are saved in a folder. The 
date and time are used to create a name for 
this folder, which is created automatically in the 
specified folder (refer to chapter 9.2 "Specify-
ing Folder to Store Images In").
If you are working in Database Mode the 
images will be stored in the database.

- "Show Log-File" button: every time the Time 
Lapse function is activated the PALM RoboSoft-
ware creates a file showing the sequence of 
events for the function. This file is saved in the 
same folder as the images. Click on the button 
to open this file (the button remains disabled 
until the sequence has been completed).

Set the sequence of events for your recordings in 
the "Time Lapse Definition Data" section.
- If you tick the check box "all time data (inter-

vals and durations) in minutes" then all times 
will be expressed in minutes (rather than the 
default of seconds).

- The "Video", "Time Lapse 1" and "Time Lapse 
2" check boxes allow you to choose whether 
you wish to save a video sequence or a series 
of images. You can also tick more than one 
check box if, for instance, you wish to record a 
video and a series of images, or indeed two 
series of images with different settings.

- Enter an interval between images to be stored 
in the "Interval" field (applies only to series of 
images).

- Enter the length for a video sequence, or how 
long images should be stored in the "Duration" 
field. For series of images the number of 
images can thus be calculated from the time 
interval between individual images and the 
overall duration.

- The "Endless Mode" check box (only for series 
of images) can be used to specify that images 
should be captured at a defined time interval 
until such point as the sequence is broken off 
manually.

- The " Approx.Size (in MByte)" fields indicate 
the amount of storage required to save the 
video or image sequence with the configured 
time settings. Images are saved in "tif" format 
(with LZW compression), and videos in "avi" 
format.
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- The "Use auto focus" check box can be used to 
activate a mode in which the focus is read-
justed for each new image. Above all, this can 
be important if the stage is moved whilst the 
image is being captured and images of different 
parts of your sample are being stored.
You should be aware that it takes around 30 
seconds to adjust the focus. This means that if 
this function is chosen, then it is not an option 
to have an interval of less than 30 seconds.

- If you check the "Switch off transmitted light/
close transmitted light shutter between picture 
recording" box, then in the time between differ-
ent images being saved the microscope light is 
switched off and the shutter on the microscope 
is closed to prevent any light from reaching the 
sample. 
Please note that it takes around 10 seconds to 
switch the light off and on again. This means 
that if this function is chosen, then it is not an 
option to have an interval of less than 10 sec-
onds.

- If you check the "Close reflected light shutter 
between picture recording" box (which is only 
enabled if a fluorescence unit is installed), then 
the fluorescence shutter is closed during the 
interval between images being saved. This 
enables sensitive samples to be protected from 
too long an exposure to fluorescent light.

In the "Trigger Point Definition" area you define 
which event will be used to start the Time Lapse 
function.
- Manually: the sequence is started manually by 

clicking on the button "Start Time Lapse manu-
ally" (see below).

- Foot switch (Cut LPC): the sequence is started 
as soon as you activate the laser using the foot-
switch (chapter 10.10 "Cutting and Catapulting 
without Automatic Laser Functions" explains 
how you can set the footswitch for "Cut" or 
"LPC").

- LPC laser function: the sequence is started as 
soon as you activate an automatic LPC laser 
function.

- Scheduled: You can set a time for the function 
to be started automatically.

In accordance with the start event that has set up, 
one of the following symbols is displayed in the 
PALM RoboSoftware main window:

To start the Time Lapse function manually:

• Click on the "Start Time Lapse manually" icon 
button.

To cancel the Time Lapse function:

During video recording and the storage sequence 
a "STOP" icon button appears on the Tool Bar.

• Click on the "STOP" icon button.

The Time Lapse sequence is canceled.

Info:
You can either check the check box for micro-
scope shutter control or the one for fluores-
cence shutter control.

Manually

Foot switch (Cut LPC) or
LPC Laser function

Scheduled

Start Time Lapse manually

Stop
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10 Cutting and Catapulting

10.1 Laser Functions

With the PALM MicroBeam you can cut on the mi-
croscope and catapult parts of the sample. De-
pending on the objective of your work, you will 
need variable options of this function or combina-
tions thereof. PALM RoboSoftware gives you the 
following automatic laser functions:

Cut 

With this function, the laser cuts your sample 
along pre-drawn lines ("Figure" elements: Lines, 
rectangles and circles), so that a clearly split line 
between required and non-required material is 
generated. 

In the cut area, all biological material is destroyed 
by ablation. Thus a pure sample preparation can 
be carried out without fear of contamination.

Close&Cut

With this function, the laser also cuts your sample 
along defined lines. Unlike with the "Cut" function 
however, the start and end dot of a line element 
are connected here by a straight cut line.

JointCut

As with function Close&Cut the laser cuts your 
sample along defined lines. Start and end dot of a 
line element are connected by a straight cut line. It 
remains a joint between start and end dot. With 
this function geometrical figures can be cut. The 
cut area remains fixed within the tissue. The entire 
area can be catapulted later by a single laser pulse.

LPC

With this function, only the cells upon which you 
have drawn a "Dot" element are catapulted into 
the collecting vessel.

AutoLPC

With this function, the contents of a defined area 
of glass-mounted samples are catapulted into your 
cap. The area is therefore not catapulted in one 
piece, but with several laser pulses. The original 
structure of the material is not retained when us-
ing this function.
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Both this function and the following one 
Close&Cut+AutoLPC can only be used for glass-
mounted samples, i.e., these functions cannot be 
used if the sample is placed on a membrane (LPC 
membrane).

With glass samples only a limited amount of cell 
material per laser pulse can be catapulted out with 
one laser shot. Larger areas have to be catapulted 
with multiple laser pulses. The exact position of 
the laser pulses is calculated by PALM RoboSoft-
ware; you have to define only the border line of 
the area and the distance (LPC distance) between 
the laser pulses, as well as their orientation (diag-
onal or parallel).

The required distance between the single laser 
pulses depends on the qualities of the tissue.

Close&Cut+AutoLPC

This function combines the functions "Close&Cut" 
with "AutoLPC" (refer to appropriate sections): 
Line elements are closed and cut completely along 
the border lines; the cut area contents are then 
catapulted to the cap using multiple laser pulses.

RoboLPC

With this function, defined structures are cut out 
and catapulted intact into the cap. When cutting, 
automatically a straight line between the start and 
end dots of the border line is left as a joint. You can 
determine the length of this with the parameter 
"Distance of RoboLPC joint". A laser pulse is then 
set exactly into the center of the RoboLPC joint, 
which catapults the entire cut area into the cap.

This function is only possible when there is an LPC 
membrane between your sample and the slide.

As soon as you release one of these functions, the 
stage is moved automatically along the defined cut 
lines or to the defined dots and the laser is activat-
ed and deactivated as necessary.

AutoCircle

With the "AutoCircle" function, circular areas are 
cut out of your sample and catapulted intact into 
your cap by a laser pulse.

This function is only possible with membrane-coat-
ed samples.

Apart from these automatic laser functions, you 
also have the option of releasing the laser with the 
footswitch (refer also to chapter 10.10 "Cutting 
and Catapulting without Automatic Laser Func-
tions). This function is only available in Stage 
Mode. In this case you must move the stage with 
the mouse or the arrow keys.
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10.2 Preparations

Before you can use automatic laser functions, you 
must ascertain various parameters:
- The laser settings (energy, focus, dot density 

with AutoLPC etc.). Refer to chapter 10.5 
"Specifying Laser Settings" for instructions on 
how to do this.
It is recommended that you experiment in 
order to ascertain which settings best suit your 
working requirements. Chapter 10.6 "Finding 
Suitable Laser Settings" gives you instructions 
on finding the optimal values.

- The moving speed of the microscope stage dur-
ing the operation of the laser function. Refer to 
chapter 5 "Positioning the Stage", for instruc-
tions on how to set the speeds for moving the 
microscope stage.

- Setting the required laser function. Refer to 
chapter 10.3 "Selection of Automatic Laser 
Functions" for instructions on how to do this.

- The areas to be cut and catapulted (elements). 
For instructions on how to do this, refer to 
chapter 7 "Drawing and Measuring" and chap-
ter 10.7 "Releasing the Automatic Laser Func-
tions".
If you release the laser with the footswitch you 
do not need to have drawn any elements.

10.3 Selection of Automatic Laser 
Functions

You can select the automatic laser functions in the 
PALM RoboSoftware main window and in the "Ele-
ment List" window (chapter 7.3 "The "Element 
List" Window" includes instructions for opening 
this window). In both windows, you are offered the 
"Cut Tools" and a menu command. Apart from that 
you can establish how often the selected laser 
function should be applied to an element.

To select an automatic laser function using a 
menu command:

• Click in the PALM RoboSoftware main window 
or on item "Laser" in the menu bar in the "Ele-
ment List" window.

The "Laser" menu will open in both cases. Among 
other items, this includes a list of available laser 
functions.

• Click on the required laser function.

A tick beside an entry shows which laser function 
is currently selected.

Note!
Do not process your sample, or at least the ar-
eas important for your work, until you have as-
certained your optimal setting by experiment. 
Application of the laser with unfavorable set-
tings can cause irreparable destruction to your 
sample.

Note!
If your system is equipped with a PALM Robo-
Mover and if you want to use the functions to 
position the caps automatically, you have to 
select the desired laser function in the PALM 
RoboMover window (there you must start these 
functions, too; refer to the Manual of the PALM 
RoboMover).

Info:
The number of operations cannot be set by a 
menu command. Carry out this setting as de-
scribed below in "Cut Tools" in the main win-
dow or in the window "Element List".
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To select an automatic laser function in "Cut 
Tools":

• In the PALM RoboSoftware main window or the 
"Element List" window, click on the arrow 
beside the selection field in "Cut Tools".

A list opens displaying the available laser functions.

• Select the required laser function with a mouse 
click.

To set the number of operations in "Cut 
Tools":

• In "Cut Tools" (either in the PALM RoboSoft-
ware main window or the "Element List" win-
dow) double-click in the checkbox beside the 
selection box for the laser functions, or 
simply click on the checkbox and mark the 
available entry by dragging the mouse over it 
with the left button pressed down, or
simply click on the checkbox and delete the 
existing entry ("Del" or "Backspace" key).

• Enter the required number of operations.

10.4 Preview of the Automatic Laser 
Functions

The display of the elements on the monitor de-
pends on which laser function you have set. It 
serves as a preview of the laser functions:

Cut

Cut lines (element no. 12 in the illustration above) 
are displayed with the line thickness you specified 
(refer also to chapter 7.8 "Changing Colors and 
Line Thickness"). Elements of type "Dot" (nos. 13 
and 14) are shown as unfilled circles, elements of 
type "AutoCircle" (no. 15) are indicated by a thin 
circular line and an unfilled circle in the middle.

Close&Cut

Cut lines (element no. 12 in the illustration above) 
are shown with the line thickness specified by you; 
in addition a connecting line is shown between the 
start and finish dots of elements of type "Figure". 
Elements of type "Dot" (nos. 13 and 14) are shown 
as unfilled circles, elements of type "AutoCircle" 
(no. 15) are indicated by a thin circular line and an 
unfilled circle in the middle.



PALM RoboSoftware 3.1-0106 (EN) 99

Preview of the Automatic Laser Functions

JointCut

Cut lines (element no. 12 in the illustration above) 
are shown with the line thickness specified by you; 
in addition a connecting line (with a remaining 
small space) is shown between the start and finish 
dots of elements of type "Figure". Elements of type 
"Dot" (nos. 13 and 14) are shown as unfilled cir-
cles, elements of type "AutoCircle" (no. 15) are in-
dicated by a thin circular line and an unfilled circle 
in the middle.

LPC

"Dot" elements are displayed as filled circles with 
the diameter that you have set (nos. 13 and 14 in 
the picture above). Elements of type "Figure" are 
indicated by a thin line, elements of type "Auto-
Circle" are indicated by a thin circular line and an 
unfilled circle in the middle.

AutoLPC

The positions of the laser pulses are displayed as 
filled circles with the diameter that you have set 
(element no. 12 in the picture above). The ele-
ment's borderlines appear as thin lines, elements 
of type "Dot" as unfilled circles, elements of type 
"AutoCircle" are indicated by a thin line with an un-
filled circle in the middle.

Close&Cut+AutoLPC

As with "Close&Cut", the positions of the laser 
pulses are displayed as filled circles with the diam-
eter that you have set.

RoboLPC

Cut lines are displayed with the line thickness 
specified by you. In addition, the dot where the la-
ser pulse will focus to catapult is displayed in the 
center between the start and end point of "Figure" 
elements.

If the distance between start point and end point 
of an element should be greater than the parame-
ter "Distance of RoboLPC joint" (as shown in the 
picture above), the distance is automatically re-
duced by a straight line to the set value.
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AutoCircle

The circular cut line of elements of type "AutoCir-
cle" appear with the line thickness specified by 
you, the laser focus of the laser pulse as a filled cir-
cle with the diameter specified by you. 

10.5 Specifying Laser Settings

In order to achieve correct results with automatic 
laser functions, you must set a series of parame-
ters. Several settings are required for all laser 
functions, others only for some.

When relaunching PALM RoboSoftware the set-
tings apply that were in use when the program was 
last exited. 
- Laser energy and laser focus:

You can make independent settings for the 
"Cut" and "LPC" functions. However you can 
also link the energy and focus values for cutting 
and catapulting to each other. Set a "Delta" 
value and determine in this way the difference 
between the two values. As soon as you change 
the energy or focus for "Cut" or "LPC", the 
value for the other laser function is automati-
cally adjusted to reflect the "Delta" difference. 
The "Delta" value has to be set separately for 
energy and focus.
The set values apply to all laser functions with 
which you cut or catapult.

- Speed at which the microscope stage moves 
during an automatic laser function:
You can set various values for the cutting pro-
cess and for the speed at which catapulted dots 
are sequentially targeted (LPC). 

- RoboLPC joint:
This parameter is important for the functions 
"RoboLPC" and "JointCut" only. It is used to 
define the length of the joint that remains 
between the start and finish dots of an element 
when the element is cut out (refer also to the 
Description of the "RoboLPC" and "JointCut" 
functions in chapter 10.1 "Laser Functions"). If 
you select the "RoboLPC" or "JointCut" func-
tion, all elements of type "Figure" whose start 
and finish dots are closer together than the 
value of this parameter, are opened to this 
value (including closed elements such as rect-
angles or squares and circles or ovals). For ele-
ments whose start and finish dots lie farther 
apart (e.g., elements drawn with the Freehand 
Tool), the distance between the start and finish 
dots is shortened by a straight line to the set 
value of the "RoboLPC joint" parameter.

If you want to deselect this function, enter the 
value "0".

Note!
Should the value of the "RoboLPC joint" param-
eter be too small or at zero, then it can occur 
that automatic catapulting does not take place 
in the "RoboLPC" function, as the sample pos-
sibly will not remain fixed within the tissue 
when cut.
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- Distance between AutoLPC shots and distance 
of the AutoLPC shots from the element border-
line (only applicable in the case of AutoLPC):
These define the required distance between the 
dots which should apply when Laser pulses are 
released in the AutoLPC function, and the min-
imum distance that these dots should have 
from the border line of the element. The num-
ber and position of the individual laser pulses 
are then automatically calculated by the PALM 
RoboSoftware.

- Position of the AutoLPC shots:
You determine whether the positions of the 
laser shots are to be arranged horizontally or 
diagonally.

- AutoLPC Center shot:
With this parameter you define if a laser shot 
should be set into the center of an element. 
This makes sense when working with very 
small or narrow elements for example. If the 
distance of the AutoLPC shots to each other 
and/or their distance from the border line of the 
element is approximately as big as the element 
or bigger, possibly no LPC shot is set into the 
element without this function; i.e. the element 
would not be catapulted.

- Monitor display during an automatic laser func-
tion:
You can determine whether the elements are to 
be displayed or hidden on the monitor while the 
laser function is in operation. The default set-
ting is that the elements are not to be dis-
played.

- Position of the stage after completing a laser 
function.
You can determine whether the stage is to be 
returned to start position on completion of the 
laser function. The default setting is that the 
position is maintained as it was during the last 
laser function.

The set values can be saved and reloaded. You can 
reset all values to the factory-default settings. Re-
fer to chapter 3.4 "Saving and Loading Settings" 
and chapter 3.5 "Restoring Settings" for instruc-
tions on how to do this.

Elements as they were drawn and would be cut 
with the "Cut" function.

The same elements with laser function "JointCut" 
selected: for element 1, the distance from start 
to finish dot is increased, for element 2 it is re-
duced. Close element 3 will be opened. 

The same elements with laser function "Robo-
LPC" selected: for element 1, the distance from 
start to finish dot is increased, for element 2 it is 
reduced. Close element 3 will be opened. In the 
center of the joint the catapult point is displayed.

Info:
When comparing microscope images in the 
case of serial images before and after cutting or 
catapulting, it is advisable to return to the orig-
inal position.

Info:
It is recommended that you experiment in or-
der to ascertain which values best suit your 
working requirements. Refer to chapter 10.6 
"Finding Suitable Laser Settings" for instruc-
tions on how to do this.
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10.5.1 Energy and Focus

There are several options available for setting the 
laser energy and laser focus.
- with the "Laser Tools" (on the left side of the 

program window in default configuration),
- with the "PALM Robo Laser Settings" window 

(which you can open via a menu or keyboard 
shortcut),

- using menu commands in the "Laser" menu,
- using keyboard shortcuts.

You can combine the settings for "Cut" and "LPC": 
If you change the setting for one laser function, 
then the other laser function is automatically 
changed to compensate.

To combine and separate laser energy and 
focus for the cut and catapult functions:

• Click on the "Energy & Focus (UV-Laser) ... " 
entry in the "Laser" menu, or
press "F9" on the keyboard, or
open the context menu with a right mouse click 
on an arbitrary location within your image. Click 
here on the "Energy & Focus (UV-Laser) ... " 
entry.

The "PALM Robo Laser Settings" window opens. It 
contains two tabs for setting energy or focus. In 
the center of each tab you will find settings facili-
ties for combining the values of the cut and cata-
pult functions.

• Select the tab for the parameter for which you 
want to combine or separate settings.

• Click the checkbox beside "Auto-Change", in 
order to select or deselect a combination of 
these settings.

A tick in the checkbox indicates that the function is 
enabled.
• In the "Delta:" field, enter the value for the dif-

ference between the energy or focus values of 
the LPC functions and the Cut functions.

• Where appropriate, select the other tab and 
carry out the same process.

• Close this window by clicking on "OK".

To set the laser energy and laser focus with 
the Laser Tools:

• Open "Laser Tools" if it is not displayed (click on 
the entry "Laser Tools" in the 
"View>Menu" or press the keyboard combina-
tion Ctrl+L).

• If you have a system with an UV and IR laser, 
click the "UV" button.

The Laser Tools for the UV laser will be displayed. 

The current settings are displayed in the fields of 
the "Energy" and "Focus" blocks. All values are set 
in analog form:
• Drag the slider, or

click on the arrow buttons (or click and hold the 
mouse button down) until the required value is 
displayed in the field between the slider and the 
arrow button.

Note!
The optimal setting for energy and focus de-
pend on the objective in use on the micro-
scope. The settings that you enter always apply 
to the magnification that you have set in the 
program. As soon as you have selected another 
magnification, the values that were last used or 
the factory defaults are automatically applied. 
This also applies to combining the settings for 
"Cut" and "LPC".
Therefore, prior to setting laser energy and la-
ser focus, first select the magnification that you 
want to work with.



PALM RoboSoftware 3.1-0106 (EN) 103

Specifying Laser Settings

To set the UV laser energy and UV focus in 
the "PALM Robo Laser Settings" window:

• Click on the "Energy & Focus (UV-Laser) ... " 
entry in the "Laser" menu, or
press F9 on the keyboard.

"PALM Robo Laser Settings" window opens. It con-
tains a selection box for the magnification and two 
tabs for making energy and focus settings. On 
each tab there are sliders and arrow keys for set-
ting the parameter for the cutting and catapulting 
functions.

• Check that the magnification of the objective 
set on the microscope is also shown in the "Val-
ues for Lens:" selection box and correct the set-
ting as necessary.

• Choose the tab for the parameter you want.
• Pull the slider for the "Cut" function or the "LPC" 

function (depending on which value you wish to 
enter), or
click as often as necessary on the arrow button 
below the slider (or click once and hold the 
mouse button pressed down),
until the required value is displayed in the field 
between the slider and the arrow button.

• Where appropriate, select the other tab and 
carry out the process as just explained.

• To confirm your changes, click "OK".

The window will close.

To set laser energy and laser focus with 
menu commands or with keyboard shortcuts:

Setting with menu commands:
• Click on items "Energy/Power more" or 

"Energy/Power less" in the "Laser" menu to 
increase or reduce the laser energy.

• In the "Laser" menu, click on items "Focus up" 
or "Focus down" to set the laser focus higher or 
lower.

Setting with keyboard shortcuts:
• Use the "Page Up" and "Page Down" keys to 

raise or lower the laser energy.
• Press "Home" or "End" to increase or reduce 

the value for the laser focus.

The values that are currently set are displayed in 
the "Laser Tools".

Info:
Please note that the values for "Cut" and "LPC" 
can only be changed separately if you have de-
activated the combination (as was indicated 
earlier in this chapter).

Note!
With menu commands or keyboard shortcuts 
you change the settings for the laser functions 
that are set in Laser Tools. You also change the 
settings when the laser settings are not dis-
played; however you then have no control over 
the changes that have been carried out. There-
fore, before you use these commands, switch 
to the Laser Tools display and select the laser 
function for which you want to change the en-
ergy and focus as described earlier in this chap-
ter.
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10.5.2 Activating and Deactivating 
Autofocus

If the Autofocus is switched on, then each time an 
element is targeted during a laser function (and 
each time the lens is changed), the image is fo-
cused automatically.

Autofocus can be turned on and off in "Microscope 
Tools" or on the "Laser" tab in the "Preferences 
and Configuration" window.

In the "Preferences and Configuration" win-
dow, Autofocus can be turned on and off as 
follows:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens.
• Select tab "Laser".

• In the "Laser function" section click the "AF 
active" box to turn the function on or off.

A tick in the checkbox indicates that the function is 
enabled.

To turn autofocus on or off in "Microscope 
Tools", proceed as follows:

• If you want to hide the microscope tools, they 
should first be displayed (choose "Microscope 
Tools from "View>Menus").

• The function can be turned on or off by clicking 
the "Auto Focus" box.

A tick in the checkbox indicates that the function is 
enabled.

10.5.3 Other General Laser Settings

You can determine 
- whether the elements should be displayed on 

the monitor while you are performing the laser 
function, and 

- whether the stage is to be returned to start po-
sition on completion of the laser function.

To enter these settings, proceed as follows:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window 
opens.

• Select tab "Laser".
• In the "Laser function" section, click in the 

checkbox in front of the item "Display Elements 
during Laser function" and the checkbox in 
front of item "Return to start position after 
Laser function" to enable or disable these func-
tions.

A tick in the checkbox indicates that the function is 
enabled.

10.5.4 Special Laser Settings for the 
"AutoLPC" and 
"Close&Cut+AutoLPC" Functions

When you release the "AutoLPC" or the "Close&Cut 
+AutoLPC" function, the contents of an area ele-
ment is catapulted into the cap with single laser 
shots. Four particular settings have to be carried 
out for this laser function:
- the distance of the laser pulses to each other 

(LPC distance)
- the distance of the laser pulses from the border 

line of the element
- the arrangement of the dot configuration (diag-

onal or parallel)
- the selection, if a laser pulse should be set to the 

center of the element (AutoLPC Center Shot).

Info:
This function is only available if your micro-
scope has the autofocus facility.

Note!
These laser functions only apply for glass-
mounted samples.

Note!
The distance settings always apply to the mag-
nification that you have set in the program. As 
soon as you have selected another magnifica-
tion, the values that were last used or the fac-
tory defaults are automatically applied.
Therefore, before setting the speed, first select 
the magnification that you want to work with.
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To enter these settings, proceed as follows:

• Click on the "LPC-Parameter ... " entry in the 
"Laser" menu.

The "LPC Parameters" window opens. In the aver-
age part of the window you will see the section 
"LPC Distances".

• Enter the required value for the dot distance in 
µm in the "Distance of AutoLPC shots" field.

• Enter the required µm value for the distance of 
the points from the border of the elements in 
the field "Distance of AutoLPC shots from line".

• Activate the "AutoLPC shots diagonal" check-
box to change the arrangement of the dots.

A tick in this box indicates that the dots will be ar-
ranged diagonally. If there is no tick in the box, the 
dots will be arranged vertically or horizontally.
• Click in the box "AutoLPC Center shot", if a 

laser pulse should be set to the center of the 
element.

• Close this window by clicking on "OK".

10.5.5 Special Laser Settings for the 
"RoboLPC" Function

If you release the "RoboLPC" function, an area el-
ement will be cut out, but a small RoboLPC joint 
will be established between the start and end dots 
of the cut line. A laser pulse on this RoboLPC joint 
will catapult the area contents into the cap. This 
function requires a special setting:
- establish the length of the RoboLPC joint 

remaining after cutting.

To establish the length of the remaining joint 
for RoboLPC:

• Click on the "LPC-Parameter ... " entry in the 
"Laser" menu.

The "LPC Parameters" window opens. In the lower 
part of the window you will see the section "LPC 
Distances".

• Enter the desired value in µm for the width of 
the remaining RoboLPC joint in the "Distance of 
RoboLPC joint" field.

• Close this window by clicking on "OK".

Note!
These laser functions only make sense with 
membrane-mounted samples.

Note!
Should the value of the "RoboLPC joint" param-
eter be too small or at zero, then it can occur 
that automatic catapulting does not take place 
in the "RoboLPC" function, as the sample pos-
sibly will not remain fixed within the tissue 
when cut.
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10.6 Finding Suitable Laser Settings

Perfect cut and catapult results can only be 
achieved with optimal parameter settings. The op-
timal settings are not, however, the same for all 
samples. You must select the best suited settings 
for each type of sample by experimentation.

To achieve cut lines that are as fine as possible, 
you should enter the lowest possible energy set-
ting with which you can still achieve the required 
cutting effect (sometimes multiple cutting along 
the same line with lower energy achieves better 
results than a single cut with higher energy). In 
addition to that, the laser focus should be at the 
same level as that of your sample.

With a higher energy setting you cannot just cut 
within the laser focus, but also above or below. If 
the laser focus happens to be in the glass, smaller 
or larger glass segments are catapulted out. 

The catapult function requires a different energy 
and focus setting to that of the cut function. For 
catapulting, the laser beam is extended to an ap-
propriate value (de-focused). You can select sepa-
rate values 
- for the cut and for the catapult function, or 
- combine the values for the cut and catapult 

function. When you then set the values for en-
ergy and focus for a function, these values are 
automatically changed for the other function by 
an amount that you can set.

Note that the cutting effect of the laser is not only 
dependent on the energy and focus settings, but 
also on the speed at which the stage is moved. The 
slower you move the stage with a fixed energy set-
ting and defined focus, the greater is the effect of 
the laser, since it works with a fixed pulse frequen-
cy. This means that there are three parameters to 
set that reciprocally influence each other. Work up 
to the optimal settings successively.

Essentially there are two options for ascertaining 
the optimal laser settings for the cutting function:
- without using the automatic laser functions:

Enter Stage Mode, move the stage with the 
mouse, release the laser with the footswitch 
(refer also to chapter 10.10 "Cutting and Cata-
pulting without Automatic Laser Functions) and 
change energy and focus with keyboard com-
mands.
The advantage of this method is that you can 
cut and test various settings at will, within cer-
tain limits. You should try to move the stage 
more slowly if possible, so that you can evalu-
ate the cutting effect during the movement.

- with the automatic laser functions:
You draw an element, cut along this line with 
the automatic "Cut" function and change 
energy, focus and speed during the cutting 
operation by using keyboard settings.
The advantage of this method is that you do not 
have to work with the footswitch, mouse and 
keyboard at the same time, but with the key-
board alone. However, you will probably have 
to draw and cut several elements until you have 
found your optimal settings. 
With this method you can also set higher 
speeds but only evaluate the cut after conclud-
ing the automatic laser function.
Apart from that, you can also find settings for 
multiple cutting processes with this method, 
since the laser cuts along exactly the same line 
during each operation.

In order to find the optimal values for the catapult-
ing functions, you must draw appropriate ele-
ments and release the required automatic catapult 
functions (LPC, AutoLPC, RoboLPC or AutoCircle) 
with varying settings of the LPC energy and LPC fo-
cus. Disable the combination of "Cut" and "LPC" 
Energy, as well as "Cut" and "LPC" Focus, in order 
to be able to perform independent settings for 
these functions.

To find the optimal laser settings for the cut-
ting functions:
:

• Insert a sample that has the same qualities as 
the sample that you want to examine; select 
the required objective and adjust it into focus.

• Select the magnification set on the microscope 
in the Lens menu of PALM RoboSoftware.

• Switch on the display for Laser Tools and Speed 
Tools if these have been hidden (if necessary 

Note!
The optimal settings for energy and focus also 
depend on the objective in use on the micro-
scope. The settings that you enter always apply 
to the magnification that you have set in the 
program. As soon as you have selected another 
magnification, the values that were last used or 
the factory defaults are automatically applied.
Therefore, prior to setting laser energy and la-
ser focus, first select the magnification that you 
want to work with.

Info:
To ascertain your optimal laser settings, you 
have to know how you can set the laser focus, 
the laser energy and the speed of the stage for 
the different types of movement. If necessary, 
refer to chapter 10.5 "Specifying Laser Set-
tings" or chapter 5 "Positioning the Stage" or to 
the User Manual for instructions on how to pro-
ceed.
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click on the entries "Laser Tools" and "Speed 
Tools" in the "View>Menu" or press the key-
board combination Ctrl+L or Ctrl+E).

• Set the laser focus and laser energy at median 
values (50/50) or start with factory default set-
tings; if necessary refer to chapter 3.5 "Restor-
ing Settings" for instructions on how to reset 
the "Factory Defaults".

The further procedure depends upon whether or 
not you want to use the automatic laser functions 
to find appropriate laser settings.

a) Using the Automatic Laser Functions:

• Set the "Scroll" function for the microscope 
stage speed so that you can easily follow the 
movement with the naked eye. Move the 
microscope stage to test with the Scroll func-
tion (refer also to chapter 5.1.2 "Positioning the 
Stage with the Mouse: Scroll"). Change the 
speed during movement in order to find an 
appropriate value. Take a note of the value 
established and enter it as speed for the move-
ment type "Cut".

• Draw an arbitrary "Line" image - for example a 
spiral or a staggering line. The longer the line 
is, the longer you have the opportunity of con-
trolling and possibly changing the laser settings 
during the cutting operation.

• Set the laser function "Cut" and select the num-
ber of operations to "1" (refer to chapter 10.3 
"Selection of Automatic Laser Functions" for 
instructions on how to proceed).

• If you have drawn one or more elements, open 
the "Element List" window (press F5, for exam-
ple) and select the element to be cut with a 
mouse click. If you have only drawn one ele-
ment then that one is selected automatically.

• Start the automatic laser function (press F11 or 
release the laser using one of the other meth-
ods explained in chapter 10.7 "Releasing the 
Automatic Laser Functions").

The stage is moved below the laser; the laser is re-
leased. 
• If necessary increase the energy until the laser 

achieves a cutting effect.

You will get a cut line in the sample. This line will 
initially be unclear and wide or the sample will only 
be cut incompletely as a result of an inadequate 
setting of the laser focus and energy. 
You can change the settings during the cutting 
process as long as the cut line remains incomplete. 

If the cutting process has been completed before 
you have found your optimal settings you will have 
to draw a new element and restart the laser. If 
possible try with multiple cutting operations.
• Change the laser focus and try to aim for a thin-

ner cut line.
• If you have achieved that, then reduce the 

energy, also with the intention of getting a thin-
ner cut line.

• Now try to continue optimizing your results by 
repeatedly changing both focus and energy.

• Once you have attained the best possible 
result, you should either save or note the 
appropriate settings. Refer to chapter 3.4 "Sav-
ing and Loading Settings" for instructions on 
how to do this.

b) Without using the Automatic Laser Func-
tions:

• As described in chapter 10.10 "Cutting and Cat-
apulting without Automatic Laser Functions", 
adjust the footswitch in such a way that it can 
be used to activate the cutting function.

• Set the value for the microscope stage move-
ment speed so that you can easily follow the 
movement with the naked eye when in Stage 
Mode: Enter Stage Mode and try moving the 
microscope stage with the mouse. Change the 
speed during movement in order to find an 
appropriate value. Remain in Stage Mode.

• Release the laser with the footswitch and at the 
same time move the stage.

The laser remains in operation as long as the foot-
switch is depressed. 
• If necessary increase the energy until the laser 

achieves a cutting effect.

You will get a cut line in the sample. This line will 
initially be unclear and wide or the sample will be 
cut incompletely as a result of an inadequate set-
ting of the laser focus and energy.
• Continue cutting and change the laser focus. 

Aim for a thinner cut line.
• If you have achieved that, then reduce the 

energy, also with the intention of getting a thin-
ner cut line.

• Now try to continue optimizing your results by 
repeatedly changing both focus and energy.

• Once you have attained the best possible 
result, you should either save or note the 
appropriate settings. Refer to chapter 3.4 "Sav-
ing and Loading Settings" for instructions on 
how to do this.

Note!
If you reset to factory defaults, not only laser 
energy and laser focus are reset, but also all 
other settings that you have made (refer also 
to chapter 3 "Settings").
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10.7 Releasing the Automatic Laser 
Functions

Prior to releasing one of the laser functions, you 
must have: 
- drawn elements (refer also to chapter 7 "Draw-

ing and Measuring").
- made laser settings (energy, focus and possibly 

auto-change and LPC distances; refer also to 
chapter 10.5 "Specifying Laser Settings").

- set the stage movement speed (refer also to 
chapter 5.3 "Setting Speed").

- selected the required laser function (refer also 
to chapter 10.3 "Selection of Automatic Laser 
Functions").

- selected the elements to be processed with the 
laser.

- positioned the collection device (cap or well) 
correctly if you want to catapult. 

You will need to proceed differently depending on 
whether all the elements you have drawn (provid-
ed they are compatible with the laser function) or 
only certain of them are to be processed with the 
laser.

To select elements for processing with the 
laser, proceed as follows in the "Element 
List" window:

• Open the element list (press F5 or use one of 
the methods explained in chapter 7.3 "The 
"Element List" Window").

• Select the required laser function and the num-
ber of operations as explained in chapter 10.3 
"Selection of Automatic Laser Functions".

If you wish to process individual elements with the 
laser:
• Select the element or elements you want to 

process: 
click on the desired element. To select multiple 
elements, hold the Ctrl key down as you click 
on your selection. If you want to process all ele-
ments of one type or one color with the laser, 
click on the corresponding line in the table on 
the "Summary" tab.

If you wish to process all elements that have not 
yet been processed with the laser:
• Cancel the element selection if elements have 

been selected.

If you wish to process all elements with the laser 
(including those that have already been processed 
with the laser):
• Select all elements.

To select elements for processing with the 
laser, proceed as follows in the PALM 
RoboSoftware main window:

• Select the required laser function and the num-
ber of operations as explained in chapter 10.3 
"Selection of Automatic Laser Functions".

• Select the elements for processing with the 
laser in the main window.

• Open the context menu by right-clicking the 
mouse.

• Click on "Laser selected elements" in the con-
text menu.

Info:
If your system is equipped with the PALM 

RoboMover, all settings can be controlled via 
the software comfortably (refer to the Manual 
for the PALM RoboSoftware).

If your system is equipped with the PALM 

CapMover, the positioning of the cap is car-
ried out with a joystick (refer to the Manual 
for the PALM CapMover).

Note!
Take care that you have fully completed all set-
tings prior to carrying out any of the laser func-
tions. Incorrectly-set parameters can cause 
your sample to be destroyed.

Note!
Note that when a laser function is released only 
elements that are compatible with the function 
can be processed. For example, if you have se-
lected the "Cut" laser function, only elements 
of type "Figure" will be processed; if you have 
selected elements of other types, e.g., "Dot", 
these are ignored. If you want to process dif-
ferent element types with the laser, you must 
do this in several separate operations.
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To release an automatic laser function:

There are several options available for releasing 
the laser:
- via a menu command in the main window in the 

PALM RoboSoftware
- via icon buttons in the main window of the 

PALM RoboSoftware
- via a menu command in the "Element List" win-

dow
- via an icon button in the "Element List" window
- via a keyboard shortcut
- via an icon button in the PALM RoboMover win-

dow (if your system is equipped with a PALM 

RoboMover).

In the "Element List" Window:
• Click on the "Start Laser" icon button, or

click on the "Start Laser function" entry in the 
"Laser" menu.

In the PALM RoboSoftware main window:
• Click on the "Start Laser" icon button in "Cut 

Tools", or
click on "Laser" below "Speed Tools", or
click on the "Start Laser function" entry in the 
"Laser" menu.

With the keyboard command:
• Press F11 on the keyboard.

In the PALM RoboMover window:
(refer to the Manual for the PALM RoboMover).

After the laser function has been released, the 
stage moves automatically along the defined cut 
lines or from LPC dot to LPC dot, the laser is acti-
vated and deactivated as necessary. When all ele-
ments for processing have been processed, the la-
ser is switched off. The stage is returned to the 

starting point for the laser action if you have en-
abled this function (refer to chapter 10.5.3 "Other 
General Laser Settings" for instructions on how to 
do this); otherwise, it remains stationary at the 
spot where the last laser action took place.

If you made the corresponding prior setting, an 
image will be saved before and/or after processing 
of each element (refer to chapter 9.4 "Saving Im-
ages Automatically during a Laser Function", for 
instructions on how to make these settings).

If you have not drawn any elements, an error mes-
sage is displayed.

If you have only drawn or selected elements on 
which the selected laser function cannot be used 
(e.g., "LPC" for cut lines or "Cut" for LPC Dots), an 
error message is displayed and no laser function 
takes place.

On conclusion of the laser operation your elements 
are displayed on the monitor again (this only takes 
place during the laser operation if you have made 
the appropriate settings, refer also to chapter 
10.5.3 "Other General Laser Settings"). This dis-
play serves as a check of the laser function. Ele-
ments that have been processed with the laser are 
displayed on a green background in the "Element 
List" window.

Note!
If you want to use the PALM RoboMover to po-
sition the caps automatically, you have to se-
lect the desired laser function in the PALM 

RoboMovers window (there you must start 
these functions, too; refer to the Manual of the 
PALM RoboMover).

Start Laser
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10.8 Stop/Continue

In case of emergency you can stop all functions 
and movements in progress.

To stop all current movements with one key-
board shortcut:

• Press "Esc" on the keyboard.

To stop all current movement in main window:

• Click on the "Stop" icon button in the Tool Bar, 
or
click on "Stop" in the "Move" menu.

To stop all current movement in the "Element 
List" window:

• Click on the "Stop" icon button in the Icon Bar.

All current operations are stopped immediately.

To continue after a "Stop":

• Click on the "Continue" button in the Tool Bar, 
or
click on "Continue" in the "Move" menu.

The program will start the laser function with the 
element that was selected when the function was 
interrupted.

10.9 The "Serial Sections" Function

With the function "Serial Sections" you can trans-
fer elements, that you have drawn for a sample, to 
other samples. This method saves time when pro-
cessing consecutive tissue samples. The elements 
only need to be drawn for one tissue sample and 
are then automatically (or, if required, manually) 
transferred to subsequent tissue samples. 

When you transfer the elements, they are adjusted 
in such a way that the corresponding structures in 
the target sample cover them exactly. You can 
also mount the samples at any angle on the slide: 
Any differences in the positioning will be compen-
sated for in the course of the adaptation. Make 
sure, however, that on assembly, the samples are 
not stretched or contracted.

The "Serial Sections" function enables series of 
samples - especially those whose structures only 
become visible following a specific treatment such 
as coloring to be processed significantly more 
quickly: only a single sample needs to be treated 
accordingly. You then only need to draw the ele-
ments for this one sample and then transfer them 
to the other samples. Through the adaptation 
when transferring elements, your elements will 
also be placed on the other samples on the desired 
spots.

Note that the adaptation can only function satis-
factorily if the relative position of the structures on 
the various samples, is identical. If the tissue block 
out of which you cut the samples, contains a diag-
onal structure for example, and the other struc-
tures are vertical, the differences cannot be 
automatically compensated for. You have the pos-
sibility to correct such variations by hand after the 
transfer procedure. To keep any necessary correc-
tions small, it is recommended that the samples 
are processed in the same sequence as when they 
were cut out of the tissue block and to transfer 
each of the elements from one sample to the next 
(1 > 2, 2 > 3, ...; if necessary, after manual cor-
rection). 

The sample for which you draw the elements is re-
ferred to below as the source sample. The sample 
to which the elements are transferred is referred 
to as the target sample.

You can carry out the transfer and adaptation with 
the PALM RoboSoftware; the adaptation, if re-
quired, also manually. To begin with, an overview 
of the necessary process steps follows. Subse-
quently, the procedure will be explained in detail.

Stop

Stop

Info:
You can still use the icon button and the menu 
command when the "Element List" window is 
open.

Continue
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To carry out automatic adaptation, proceed as fol-
lows:
1. Prepare the samples: create three markings in 

your block (before cutting the tissue sam-
ples), e.g. three pinpricks. These markings 
must be clearly visible under the microscope. 
Then cut the tissue samples and mount them 
on the slides. If required, treat one sample 
(the source sample) in order to make the 
structures visible.

2. Creating reference elements on the source 
sample: Insert the first sample (your source 
sample) into the microscope and define three 
reference points on the markings made before 
cutting. 

3. Drawing and processing elements: Now draw 
the elements for all the samples which are to 
be processed with the laser and join them to-
gether with the reference points into a group.

4a. Preparing the target sample: position the tar-
get sample under the microscope and likewise 
define three reference points on its markings. 

5a. Transferring elements to the target sample: 
The PALM RoboSoftware moves the reference 
points on the source sample automatically to 
the locations of the corresponding reference 
points on the target sample and recalculates 
all the transferred elements, so that they 
match up with respective structures on the 
slide.

Similarly, for the manual adaptation:

1. -3. as with automatic adaptation.
4b. Preparing the target sample: position the tar-

get sample under the microscope. You do not 
need to define any reference points in this in-
stance.

5b. Transferring elements to the target sample: 
To do this, move the reference elements of 
the source group manually to the position of 
the corresponding structures on the target 
sample. The PALM RoboSoftware recalculates 
all the other elements to bring them into line 
with the corresponding structures on the slide.

Step 1: Preparing the samples (automatic 
and manual adaptation)

• Before cutting, create three markings in your 
sample block that are easily recognizable under 
the microscope, e.g. three pinpricks. 
The markings should form a triangle (i.e., not a 
straight line); the further away they are from 
each other, the more accurate the adaptation 
will be. Make sure that you place the markings 
exactly vertical to the cutting plane.

• Produce the tissue samples from the sample.
• Select a sample for the source sample and treat 

it, if necessary, with a coloring substance, or 
similar.

Step 2: Creating reference elements on the 
source sample (automatic and manual adapt-
ation)

• Insert the source sample into the slideholder of 
the stage.

Now you will create the reference elements.

In addition, you can 
- insert an element of the type "Reference Point" 

into the center of each marking, or 
- draw three elements, which correspond exactly 

to your markings. For this, it is advisable to use 
the freehand tool. With which you can repro-
duce the shape of the markings exactly. 
The PALM RoboSoftware then calculates the 
center of each element in succession and, at 
each of these points, automatically inserts an 
element of the type "Reference Point".

Info:
The images shown below are examples asso-
ciated with a 3-slide holder. The source sam-
ple has been inserted in position 1 and the 
target sample in position 2 ("Slide 1" and 
"Slide 2" tabs in the "Element List" window).

Info:
Before further processing, it is advisable to 
create a proof scan of the sample, with the 
help of the PALM Navigator (refer to chapter 
6 "PALM Navigator"). This makes the target-
ing of individual areas of your sample far eas-
ier.

Reference Tool (Reference Point)

Freehand Tool

Info:
It is advisable not to mix both methods. Ei-
ther set or draw three reference elements.
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The procedure is essentially the same, whether 
you draw elements with the freehand tool or set 
reference elements with the reference point tool. 
If you have drawn elements, you will create a ref-
erence element in the center of the elements using 
the "Define Group-Reference-Figure" command. 
This point is omitted if you work with the reference 
point tool (refer to the following description).

It is advisable to use the freehand tool to draw el-
ements. The subsequently necessary allocation of 
the other samples to the respective markings will 
then, as a rule, be more exact. This procedure is 
described in the following.

• Position the stage so that one of the three 
markings in your sample is displayed on the 
monitor (e.g., with the help of the PALM Navi-
gator).

• Select the desired drawing tool (the freehand 
tool is recommended) and draw an element to 
the shape of your marking.

• Position the stage on the second marking and 
draw an element here also to the shape of this 
marking.

• Proceed likewise with the third marking.
• Open the "Element List" window.

Your three elements are now listed there.
• Select the three elements.

• In the "Edit" menu, click on menu item "Create 
Group".

The three elements are joined together to form a 
group. The group appears as a fourth element in 
the "Element List" window.

Allocate a name to the group, e.g., 
"Slide 1": 
• Double click on the element group.

The "Element Properties" window will open.
• Type a name and click the "OK" button.

The next two steps are omitted if you have drawn 
elements of the "Reference Point" type. (In this 
case, continue with "Step 3: Drawing and Process-
ing Elements ... " as described on the following 
page.)

• Select the three drawn elements and click on 
the menu item "Define Group-Reference-Fig-
ure" in the "Edit" menu.

This opens the "Groups" window.
• Choose the group to which the elements belong 

and click on the "OK" button to close the win-
dow.

Info:
It is not essential to allocate a name to the 
group. As you will no doubt later draw further 
elements and create further groups, you will 
thus be easily able to retain an overview.



PALM RoboSoftware 3.1-0106 (EN) 113

The "Serial Sections" Function

The PALM RoboSoftware creates three new ele-
ments of the "Reference" type. 

Within each of the three drawn elements, the re-
spective reference element created by the PALM 
RoboSoftware, will be shown.

You have now created your reference for transfer-
ring the elements to further samples.

Step 3: Drawing and processing elements 
(automatic and manual adaptation)

• Draw the elements, which are to be processed 
on all samples.

• Add these elements to the reference group. 
(Select the elements and click on the menu 
item "Add to Group" in the "Edit" menu.)

Step 4a: Preparing the target sample 
(automatic adaptation)

Likewise, you will define three reference points or 
reference figures on the target samples. Proceed 
in exactly the same way as described for the 
source sample:
• Insert the slide, onto which you want to trans-

fer the elements, into the slideholder.
If you use a multiple slideholder, it is advisable 
to leave the source sample in place and insert 
the target sample in a vacant position.

• Position the stage successively on the three 
markings on the target sample and draw an 
element on each in the same way as you did for 
the source sample.

• If you are using a multiple slideholder, then you 
should click on the tab associated with your tar-
get sample in the "Element List" window ("Slide 
2" in the example image shown below).

• Group the three elements and allocate the 
group a name, e.g., "Slide 2".

Info:
With the command "Undefine Group-Refer-
ence-Figure" you can undo the definition of an 
element as a reference element. The original 
element, along with the "Reference"-type el-
ement created by the PALM RoboSoftware are 
preserved; just the connection between the 
two elements will be deleted.

Note!
If you transfer elements to another sample, 
as described below, only those elements 
within the group will be considered.

Note!
When creating the reference elements, 
choose exactly the same sequence as for the 
source sample. Otherwise, the references will 
not be correctly collated.
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• Select the three drawn elements and click on 
the menu item "Define Group-Reference-Fig-
ure" in the "Edit" menu (not applicable, if you 
have drawn elements of the "Reference Point" 
type).

This opens the "Groups" window.
• Choose the group to which the selected ele-

ments belong (in the example, "Slide 2"), and 
click on the "OK" button to close the window.

The PALM RoboSoftware creates three new ele-
ments of the "Reference" type for the target sam-
ple.

Step 5a: Transferring elements to the target 
sample (automatic adaptation)

Now transfer the elements which are to be pro-
cessed with the laser, from the source to the target 
sample. The reference points on the source sample 
will then be aligned with those of the target sam-
ple.
• Select the group of elements on the source 

sample and the group of reference elements of 
the target sample (in the example: "Slide 1" 
and "Slide 2"). 

• Click on menu item "Match Serial Section 
Group" in the "Edit" menu.

The "Match Serial Section Groups" window opens. 
• If you are working with PALM RoboStage I, or 

with PALM RoboStage II you have inserted the 
target sample in the same position that the 
source sample occupied before, then you 
should check the "Delete source group after 
matching elements into destination group" box. 
As, in these cases, the elements are allocated 
to the same slide position, they would appear 
double if you didn't check this box.

• Click on the group, in the table at the left of the 
window, which you want to transfer to the other 
sample.

• Click on the sample, in the table at the right, 
onto which the elements are to be transferred.

• Close this window by clicking on "OK".

Info:
In the example above, only one group of ele-
ments exists on each sample. If you have cre-
ated several groups, they will also appear in 
the tables. Make sure you always choose the 
correct group.
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The elements are copied to the target sample. At 
the same time an adaptation occurs: The refer-
ence elements are moved to the respective posi-
tion on the target sample. Any differences in the 
position and shape of the elements between the 
two samples will be balanced-out.

Now you can process your elements on the target 
sample with the laser.

Step 4b: Preparing the target sample 
(manual adaptation)

• Insert the slide, onto which you want to trans-
fer the elements, into the slideholder.

Step 5b: Transferring elements to the target 
sample (manual adaptation):

• Select the group which you want to match (in 
the example, Slide 1").

• Click on the menu item "Match Reference Point 
manual" in the "Edit" menu.

• In the main window of the PALM RoboSoftware, 
move the mouse cursor to the menu item "Goto 
Reference>Group" in the "Move" menu and 
click the item "Ref-1".

The reference element 1 will be displayed on the 
monitor.
• Drag the mouse cursor onto the microscope 

image.

The mouse cursor changes to the "Group Refer-
ence Pointer", recognizable by the attribute "R". 
With the "Group Reference Pointer" you can select 
reference elements and then move them.
• Select the reference element with a mouse click 

and then drag it to the respective marking in 
your sample.

• Proceed in the same way with the other two ref-
erence elements.

By moving the reference elements, the shape and 
position of the remaining elements will be auto-
matically matched.
• Click on the menu item "Match Serial Section 

Point manual" in the "Edit" menu.

The pointer reverts to the standard pointer.

Note!
Check the position of the matched elements if 
your tissue block contains diagonal struc-
tures. Match the position, if required the 
shape also, of such elements – by hand, if 
necessary (refer to7.7.2 "Editing Elements").

Info:
Elements which have changed shape are 
identified by an asterisk (*) following the ele-
ment type in the table in the "Element List" 
window.

Info:
This menu command is only available in the 
PALM RoboSoftware's main window.

Note!
Make sure that you do, in fact, move the ref-
erence element to the respective marking. If 
you move it to another marking, the match 
will be faulty.

Note!
Check the position of the matched elements if 
your tissue block contains diagonal struc-
tures. Match the position, if required the 
shape also, of such elements – by hand, if 
necessary (refer to7.7.2 "Editing Elements").
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10.10 Cutting and Catapulting without 
Automatic Laser Functions

Even without automatic laser functions, cutting 
and catapulting are possible. This is done by 
switching the laser on and off using the footswitch. 
However, to do so you must switch to Stage Mode 
and move the stage using the mouse (refer to 
chapter 5.1.1 "Positioning the Stage with the 
Mouse: Stage Mode"). 

You can choose whether you wish to start the cut-
ting or catapulting function when you operate the 
footswitch.

To set the function of the footswitch:

• Open "Laser Tools" if it is not displayed (click on 
the entry "Laser Tools" in the 
"View>Menu" or press the keyboard combina-
tion Ctrl+L).

• If you have a CombiSystem including an IR 
laser, then you should click the "UV" button.

The Laser Tools for the UV laser will be displayed. 
• Under "- Footer -" click the button on the left 

(below "Cut") if you want to perform cutting 
with the laser in Stage Mode, or the button on 
the right (below "LPC") if you want to perform 
catapulting with the laser in Stage Mode.

Info:
You must perform this setting before switching 
to Stage Mode.
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11 Tweezers (Option)

The PALM MicroTweezers System is an optical 
tweezers with which can you trap and move ob-
jects under the microscope. It works in conjunc-
tion with an IR laser and may be purchased as a 
Single Beam or Double Beam, with or without 3D 
Laser Beam Positioning in each case:
- Double Beam with two 3D movable IR laser 

beams:
With this system you can trap and move two 
objects independently of one another.

- Double Beam with one fixed and one 3D mov-
able IR laser beam
With this system you can also trap and move 
two objects independently of each another, 
with the limitation that one IR laser beam is 
fixed and therefore one object can only be 
trapped and moved by moving the stage in the 
x- and y-axes.

- Single Beam with 3D Laser Beam Positioning:
With this system you can trap and move one 
object by moving the IR laser beam (or by 
moving the stage).

- Single Beam, with one fixed IR laser beam:
With this system you can trap an object and 
move it in the x- and y-axes by moving the 
stage.

In all four configurations, you can lift trapped ob-
jects in the z-axis away from the plane of the slide.

Thus, in combination with PALM MicroBeam, you 
can for example trap objects, transport them to 
the UV laser, and process them with it.

The following chapters will explain how to operate 
your PALM MicroTweezers together with PALM Ro-
boSoftware. A few of the functions described are 
not available if you have purchased a Single Beam 
System and/or a system without 3D Laser Beam 
Positioning. Please contact P.A.L.M. Microlaser 
Technologies GmbH, to upgrade your system if re-
quired.

11.1 Essential Settings

Before you can work with your PALM MicroTwee-
zers System, you must make a number of prelim-
inary settings. Optimum results can only be 
achieved if the initial settings are correctly carried 
out. The settings you must make depend on the 
configuration of PALM MicroTweezers System that 
you have purchased:
- You must align the IR Laser Marker (in the Dou-

ble Beam System, both IR Laser Markers) with 
the IR laser focus.

- You must set the IR laser power and the IR 
laser focus.

If you have a system with 3D Laser Beam Position-
ing, you must also:
- calibrate the 3D Laser Beam Positioning
- set the speed with which the 3D Laser Beam 

Positioning is performed.

In addition, for systems with 3D Laser Beam Posi-
tioning you can define a Reference Position for the 
IR laser beam.

The settings for the IR laser power and focus and 
the speed with which the 3D Laser Beam Position-
ing is performed, as well as the definition of a Ref-
erence Position may have to be carried out 
individually for each sample or sample type. The 
following section describes how to proceed. 

You only need to calibrate the 3D Laser Beam Po-
sitioning and adjust the IR Laser-Marker setting if 
the results from using the laser are incorrect. For 
instructions on how to do this, refer to chapter 4.3 
"Setting the Laser Marker" and chapter 4.5 "Cali-
brating the 3D Offset".
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11.2 Setting IR Laser Power and 
Focus

There are several options available for setting the 
IR laser power and IR laser focus:
- with the "Laser Tools" (on the left side of the 

program window in default configuration),
- with the "PALM Robo IR-Laser Settings" window 

(which you can open via a menu or keyboard 
shortcut),

- using menu commands in the "Laser" menu,
- using keyboard shortcuts.

There is another option for setting the IR laser fo-
cus:
- with the scroll wheel on the mouse.

If you have installed a Double Beam System, you 
can set a different power value for each beam. You 
can also set the focus differently for each beam, or 
you can couple the focus settings together: If you 
change the focus for one IR laser beam, the focus 
of the other beam will automatically be adjusted to 
the same value.

To couple and uncouple the focus settings for 
both IR laser beams (Double Beam System 
only):

Window: PALM Robo IR laser settings
• Click on the "Energy & Focus (IR Laser) ... " 

entry in the "Laser" menu, or
press F10 on the keyboard.

The "PALM Robo IR-Laser Settings" window opens. 
This contains four tabs for setting power and fo-
cus.
• Click on the "IR-1+2-Focus" tab.

In the middle portion of the tab is a checkbox for 
coupling the focus values of both IR laser beams.

• Click the checkbox beside "Simultaneous 
Focus", in order to select or deselect a combi-
nation of these settings.

A tick in the checkbox indicates that the combina-
tion is enabled.
• Close this window by clicking on "OK".

In the Laser Tools:

• Open "Laser Tools" if it is not already displayed 
(click on the entry "Laser Tools" in the 
"View>Menu" or press the keyboard combina-
tion Ctrl+L).

• Click on the "IR" button.
• Click on the "Simultaneous Focus" checkbox to 

enable or disable the combination.

A tick in the checkbox indicates that the combina-
tion is enabled.

Note!
The optimal settings for power and focus de-
pend on the objective in use on the micro-
scope. The settings that you enter always apply 
to the magnification that you have set in the 
program. As soon as you have selected another 
magnification, the values that were last used or 
the factory defaults are automatically applied. 
This also applies for coupled focus settings.
Therefore, prior to setting IR laser power and 
IR laser focus, first select the magnification 
that you want to work with.
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To set the IR laser power and IR laser focus 
with the Laser Tools:

• Open "Laser Tools" if it is not already displayed 
(click on the entry "Laser Tools" in the 
"View>Menu" or press the keyboard combina-
tion Ctrl+L).

• Click on the "IR" button.

The Laser Tools for the IR laser will be displayed.

If you have installed a Single Beam System the 
only settings you can choose between are "IR-
Power" and "IR-Focus-1". Both values are set in 
analog form:
• Drag the slider, or

click on the arrow buttons (or click and hold the 
mouse button down) until the required value is 
displayed in the field between the slider and the 
arrow button, or
click in the text box, enter the required value 
and press Enter.

If you have installed a Double Beam System, you 
can choose between the following settings:
- IR-Power: this is used for controlling the entire 

laser output for both IR beams.
- Balance/Tr1/Tr2: this is used to distribute the 

laser output between the two beams.
- IR-Focus1/IR-Focus2: this is used to control 

the focus of laser beams IR-1 and IR-2. 

If you wish to divide the power equally between 
the two beams (50:50):
• click on the word "Balance".

If you wish to set the power of IR-Beam "1" or IR-
Beam "2" to 100%:
• Click on item "Tr1" or "Tr2". 

The power of the other beam in each case will 
then be set to 0%.

If you wish to set different power values for each 
of the two beams:
• Drag the slider (in the "Balance" field), or

click on one of the arrow buttons repeatedly (or 
click once and hold the mouse button down) 
until the desired values (percentage of the total 
laser power) appear in the fields situated 
between the slider and the arrow keys, or
click in one of the text boxes, enter the required 
value and press Enter (the value in the other 
text box will be automatically adjusted accord-
ingly).

To change the focus:
• drag the slider (in the relevant "Focus" field), or

click on the arrow buttons (or click and hold the 
mouse button down) until the required value is 
displayed in the field between the slider and the 
arrow button, or
click in the text box, enter the required value 
and press Enter.

Info:
If you have purchased a Double Beam System 
with a 3D movable IR laser beam, IR-1 is the 
3D movable laser beam, and IR-2 is the fixed 
beam.
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To set the IR focus using the mouse:

• Open "Laser Tools" if it is not already displayed 
(click on the entry "Laser Tools" in the 
"View>Menu" or press the keyboard combina-
tion Ctrl+L).

• Under "Wheel", click on the button for the IR 
laser beam whose focus you wish to change 
using the mouse (left for IR-1, right for 
IR-2).

• Rotate the scroll wheel on the mouse until the 
desired value appears in the text box of the 
Focus Calibration Tool.

.

To set the IR laser power and focus in the 
"PALM Robo IR-Laser Settings" window:

• Click on the "Energy & Focus (IR-Laser) ... " 
entry in the "Laser" menu, or
press F10 on the keyboard.

"PALM Robo IR-Laser Settings" window opens.

If you have installed a Double Beam System, the 
window will include four tabs:
- "IR-1" with tools for setting the power and 

focus of laser beam "1".
- "IR-2" with tools for setting the power and 

focus of laser beam "2".
- "IR-1+2 Power" with tools for setting the power 

and balance for both beams.
- "IR-1+2 Focus" with tools for setting the focus 

for both beams.

If you want to work with only one IR laser beam: 
• Select the tab for the desired beam (IR-1 or 

IR-2).

The power for the beam you did not select is set to 
zero automatically. You set the power and focus of 
the selected beam in the same way:
• Drag the slider, or

click on the arrow buttons (or click and hold the 
mouse button down) until the required value is 
displayed in the field between the slider and the 
arrow button, or
click in the text box, enter the required value 
and press Enter.

• Close the window by clicking on "OK".

Info:
The "Wheel" buttons can also be used to spec-
ify the focus that menu or key commands will 
set (see Page 121).
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If you want to work with both IR laser beams:
• Select tab "IR-1+2 Power".
• Use the sliders or the arrow keys to set the 

power and balance (or click in the text box and 
enter the desired value).

• Select tab "IR-1+2 Focus".
• Use the sliders or the arrow keys to set the 

focus of both IR laser beams (or click in the text 
box, enter the desired value and press Enter).

• Close the window by clicking on "OK".

If you have installed a Single Beam System, the 
window contains only one tab, "IR-1", for setting 
power and focus. Both values are set in analog 
form:
• Drag the slider, or

click on the arrow buttons (or click and hold the 
mouse button down) until the required value is 
displayed in the field between the slider and the 
arrow button, or
click in the text box, enter the required value 
and press Enter.

• Close the window by clicking on "OK".

To set IR laser power and IR laser focus with 
menu commands or with keyboard shortcuts:

Setting with menu commands:
• Click on items "Energy/Power more" or 

"Energy/Power less" in the "Laser" menu to 
increase or reduce the IR laser power.

• In the "Laser" menu, click on items "Focus up" 
or "Focus down" to set the IR laser focus higher 
or lower.

Setting with keyboard shortcuts:
• Use the "Page Up" and "Page Down" keys to 

raise or lower the IR laser power.
• Press "Home" or "End" to increase or reduce 

the value for the IR laser focus.

The values that are currently set are displayed in 
the "Laser Tools".

Info:
You can only adjust the focus values for both 
beams independently if you have deactivated 
the coupled settings option. If coupling is ac-
tive, any change made to one beam will auto-
matically be applied to the other. Enabling and 
disabling the coupled feature was dealt with 
earlier in this chapter.

Note!
With menu commands or keyboard shortcuts 
you change the settings for the laser functions 
that are set in Laser Tools. You also change the 
settings when the "Laser Tools" are not dis-
played; however you then have no control over 
the changes that have been carried out. There-
fore, before you use these commands, switch 
to the "Laser Tools" display and select the laser 
function for which you want to change the en-
ergy and focus as described earlier in this chap-
ter.

Note!
If you have installed a Double Beam System, 
then menu commands and shortcut keys are 
used to set the focus of the IR beam selected 
using the "Wheel" buttons (left IR-1, right IR-
2; see Page 120).
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11.3 Determining Suitable IR Power 
and IR Focus Settings

The settings that you require for various samples 
will vary to some degree. In order to determined 
the optimum power and focus settings, you must 
experiment on similar samples with different set-
tings. The factory defaults may serve as suitable 
starting points for your experiments. If in doubt, 
start at very low power and adjust upwards grad-
ually until you obtain the desired effects.

The IR laser focus can be set using a slide, for ex-
ample, with an area you have colored with a black 
felt pen. With sufficient power, a hole appears in 
the paint film, which should make the effect quite 
simple to assess. The more precisely the focus is 
set, the smaller the hole should be.

11.4 Defining a Reference Position

When you aligned the IR Laser Marker to the laser 
focus as described in chapter 4.3 "Setting the La-
ser Marker", you also defined the Reference Posi-
tion for the IR laser beam. If you are working with 
a PALM MicroTweezers Single Beam System with-
out 3D Laser Beam Positioning, the Reference Po-
sition is not important to you except as an 
indicator of the IR laser focus.

However, the Reference Position assumes greater 
importance in the system with 3D Laser Beam Po-
sitioning: If you have moved the IR laser beam to 
any position during your work, you can instruct the 
system to return it to the Reference Position. This 
function is useful if, for example, you have moved 
the beam into an area outside the image section 
displayed on the monitor and you are perhaps no 
longer certain of the exact location of the beam.

You can change the Reference Position at any 
time. If you have purchased a system with two 3D 
movable IR laser beams, you can define a separate 
Reference Position for each beam.

To define a reference position for the IR laser 
beam:

• Insert the slide that you colored with the black 
felt pen into the stage (you can also use a sam-
ple that you no longer need for your work).

• Switch the IR laser on.
• Set the power so that you can see the effect of 

the IR laser beam (e.g. an eroded site on the 
colored slide).

• Using one of the methods described in chapter 
11.8 "The 3D Laser Beam Positioning", move 
the IR laser beam to the location where you 
want to mark the new Reference Position and 
switch the IR laser off.

• Drag the cursor to item "Position Laser-Marker" 
in the "Laser-Marker" menu.

A submenu opens containing a list of all available 
Laser Markers.

Note!
The IR Laser Marker must always indicate the 
IR laser focus of the laser beam. Otherwise, the 
IR laser will not yield satisfactory results. 
Therefore, you should never place the position 
of the IR Laser Marker anywhere except on the 
IR laser focus.
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• Click on the name of the Laser Markers the 
positions of which you want to redefine (IR-1 or 
– depending on your system – IR-2).

The message "Click Cursor at new IR Laser-Posi-
tion!" will appear.
• Click in the center of the laser focus for that IR 

laser beam.

The message "IR-Laser-Position is set" will appear. 
This message will disappear automatically after a 
few seconds.

To move the 3D movable IR laser beam to its 
Reference Position:

• Click on menu item "Goto Reference" in the 
"Move" menu.

A submenu will open:.
• Click on item "IR-1" or "IR-2".

The selected 3D movable beam will be moved to 
its Reference Position.

11.5 Settings for the Footswitch

For the footswitch, you can specify whether the IR 
laser is only to remain active while the switch is 
being depressed or whether it is to function as an 
On/Off switch.

To set the function of the footswitch:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".
The "Preferences and Configuration" window 
opens. 

Select tab "Laser". This is divided into a number of 
sections. There are two radio buttons in the bot-
tom "Footer" section.
• Click on the "Hold" button if you want the foot-

switch to function as a pressure switch: the IR 
laser will remain activated as long as the foot-
switch is depressed, or
click on the "Switch" button if you want the 
footswitch to function as an On/Off switch: the 
IR laser be switched on or off each time the 
switch is pressed.

Note!
It is essential to ensure that you assign the cor-
rect Laser Marker to the laser beam.

Info:
Note that the Reference Position for the IR la-
ser beam has an entirely different significance 
than the Reference Position for the stage.

Info:
You can only use the footswitch when you are 
in 3D-Mode or Stage Mode (refer to chapter 
11.8.2 "Moving the IR Laser Beam with the 
Mouse: 3D-1[3D-2] Mode" and chapter 5.1.1 
"Positioning the Stage with the Mouse: Stage 
Mode"").
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11.6 Activating and Deactivating the 
IR Laser

You can specify whether the IR laser is activated and 
deactivated by the computer or by the footswitch. 
The footswitch can only be used in 3D Mode or Stage 
Mode (chapter 11.8.2 "Moving the IR Laser Beam 
with the Mouse: 3D-1[3D-2] Mode" explains how to 
switch into 3D Mode, and chapter 5.1.1 "Positioning 
the Stage with the Mouse: Stage Mode" explains 
how to switch into Stage Mode).

To activate and deactivate the IR laser with 
PALM RoboSoftware:

• Click on the "IR-Laser on/off" entry in the 
"Laser" menu, or
click on the "IR" button on the right border of 
the program window.

As soon as you activate the IR laser, the gray dot 
beside the button will turn to orange.

11.7 Moving Objects in the Z-Axis

Regardless of the configuration of your PALM 
MicroTweezers, you can lift trapped objects in the 
z-axis away from the plane of the slide by altering 
the focus of the IR laser beam. The object will re-
main trapped in the plane of the IR laser focus. 

It is simpler to alter the IR laser focus with the 
scroll wheel on the mouse. Chapter 11.2 "Setting 
IR Laser Power and Focus" includes an explanation 
of your options for displacing the IR laser focus.

If you have purchase a PALM MicroTweezers with 
3D Laser Beam Positioning, you can also move 
trapped objects in the x- and y-axes, i.e., parallel 
to the plane of the slide (please contact P.A.L.M. 
Microlaser Technologies GmbH if you wish to up-
grade your system).

Info:
If you switch from Stage Mode to 3D-Mode or 
vice versa, the IR laser will be switched off if 
you have switched the laser on using the 
PALM RoboSoftware.
On the other hand, the laser remains on if you 
switched it on using the footswitch in the 
"Hold" position (refer to chapter 11.5 "Set-
tings for the Footswitch") and are continuing 
to keep the footswitch depressed.
The laser likewise remains on if you switched 
it on with the footswitch in the "Switch" posi-
tion (refer to chapter 11.5 "Settings for the 
Footswitch").

Note!
Particularly living objects may suffer injury 
due to the radiation of the IR laser. Therefore, 
you should not activate the IR laser until you 
actually need to use it, and keep it activated 
only as while you are working with it.

Info:
You can also switch off the IR laser by clicking 
the "Stop" icon button on the Tool Bar.
However, this results not only in the IR laser 
being switched off; all other processes cur-
rently running will also be stopped. The 
"Stop" icon button should therefore only be 
used to switch off the laser in the event of an 
emergency.



PALM RoboSoftware 3.1-0106 (EN) 125

The 3D Laser Beam Positioning

11.8 The 3D Laser Beam Positioning

Using the 3D Laser Beam Positioning function, you 
can move trapped objects in both the x and y axes, 
i.e., parallel to the plane of the slide. 

The following section provides instructions for 
working with a 3D movable IR laser beam. If you 
have purchased a system with two 3D movable IR 
laser beams, you will use the same methods for 
working with both beams. You will simply need to 
operate the corresponding icon buttons and menu 
commands for the 3D Laser Beam Positioning of 
the second beam as well. In the following, desig-
nations for the second beam are enclosed in 
square holders.

The 3D Laser Beam Positioning also works when 
the IR laser beam is deactivated. This means that 
you do not have to switch the IR laser on to move 
the beam to a different site.

There are two ways to move the IR laser beam:
- with the mouse
- with the arrow keys

You can vary the speeds for both modes of move-
ment.

11.8.1 Setting the Speed of the 3D Laser 
Beam Positioning

You can set the speed separately for every type of 
IR laser beam movement:
- 3D: Speed of movement in 3D Mode.
- 3DArrow: Speed when moving with arrow keys.

If you have installed a system with two 3D mov-
able IR laser beams, the speed values set apply to 
both beams. 

For the speed setting you can select between the 
units "µm/sec." and "Percent".

You can save the speed settings together with oth-
er parameters in a settings file. Refer to chapter 
3.4 "Saving and Loading Settings" for instructions 
on how to do this.

You have the following options for setting the 
movement speed of the IR laser beam:
- via the "PALM Robo Speed" window, which you 

open with a menu command or a keyboard 
shortcut

- with the "Speed Tools" tool
- with keyboard or menu commands: (Speed 

slower/Speed faster)
For speed changes entered with keyboard or 
menu commands, you can define an increment. 
Every time the corresponding keyboard or 
menu command is entered, the speed is 
increased or decreased by this value.

You can set the speeds of both types of move-
ments in the "PALM Robo Speed" window and with 
the "Speed Tools" tool. Speed changes with 
keyboard or menu commands always refer to the 
type of movement that is currently selected in the 
"Speed Tools" tool. 

Before you initiate a movement of the IR laser 
beam, all three setting options are available for 
both movement types. The speed can be varied 
using keyboard commands during movement.

To select the unit for speed setting:

• In the "Setup" menu, click on menu item "PALM 

Robo ... ".

The "Preferences and Configuration" window with 
the "Configuration" tab opens.
• Click in Radio Button "Logic" (units: percent) or 

"Micrometer / sec" (units: µm/sec) in section 
"Metric".

• Close the window.

To change the speed using the "PALM 

RoboSpeed" window:

• Click on "Setup Speed ... " in the "Move" menu, 
or
press F8 on the keyboard.

Note!
The settings that you enter always apply to 
the magnification that you have set in the 
program. As soon as you have set another 
magnification, the values that were last used 
or the factory defaults are automatically ap-
plied. Therefore, prior to setting the speed, 
first select the magnification that you want to 
work with.
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The "PALM Robo Speed" window will open. In the 
lower section of the window you will see tabs for 
setting the speed of the different movement types. 
These last two tabs control the speed settings for 
the IR laser 3D Laser Beam Positioning.

Set speeds for both movement types in the same 
way:
• Select the tab of the movement type for which 

you want to change the speed ("3D" or 
"3DArrow").

• Enter the desired value with the slider, or
enter the desired value in the "Actual Speed:" 
field.

• Close this window by clicking on "OK".

To change the speed of the "Speed Tools" 
tool:

• Open the "Speed Tools" tool if it is not displayed 
(click on the menu item "Speed Tools" in 
"View>Menu" or press key combination 
Ctrl+E).

• Click on the arrow beside the field under 
"Selected Speed".

A list of the different movement types will open.

• Select the movement type for which you want 
to change the speed ("3D" or "3DArrow").

• Enter the desired value with the slider, or
click on one of the arrow buttons below the 
slider repeatedly (or click once and hold the 
mouse button down) until the desired value is 
reached, or
enter the desired value in the field below the 
slider.

To change the speed with menu commands 
or with keyboard shortcuts:

• If you want to reduce the speed, press key 
combination Ctrl+S, or
click on menu item "Speed Slower" in the 
"Move" menu.

• If you want to increase the speed, press key 
combination Ctrl+F, or
click on menu item "Speed Faster" in the 
"Move" menu.

You can specify a value (increment) by which the 
speed is increased or decreased when you make 
this change via key combinations.

Info:
Changes with keyboard or menu commands al-
ways refer to the type of movement that is cur-
rently selected in the "Speed Tools" tool. 
Therefore, activate the tool display before car-
rying out any speed changes with keyboard 
shortcuts or menu commands. Otherwise you 
will not be able to see which movement type 
the changed speed setting will affect.
If a movement is in progress, the selection in 
Speed Tools is automatically changed to the 
current movement type, and the speed chang-
es you make are automatically applied to the 
current motion.
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To enter an increment for changing the speed 
with a keyboard shortcut or a menu command:

• Click on "Setup Speed ... " in the "Move" menu, 
or
press F8 on the keyboard.

The "PALM Robo Speed" window will open.
• Select the tab for the movement mode for 

which you want to specify an increment ("3D" 
or "3DArrow").

• Enter an increment in the "Speed Delta: for 
faster/slower functions" field.

Close this window by clicking on "OK".

11.8.2 Moving the IR Laser Beam with 
the Mouse: 3D-1[3D-2] Mode

In 3D Mode you control the movement of the IR 
laser beam with the mouse: Each mouse action is 
translated into a movement of the IR laser beam. 
You can perform movements in any direction.

To switch to 3D Mode:

• Click on the "3D-1 [3D-2]" icon button, or
click on menu item "3D-1 Mode [3D-2 Mode]" 
in the "Move" menu, or
open the context menu and click on the item 
"3D-1 Mode [3D-2 Mode]".

To switch between "3D-1" and "3D-2" Mode 
during a movement:

• Open the context menu by right-clicking the 
mouse.

• In context menu click on that 3D Mode to which 
you want to change.

To switch from 3D Mode back to Cursor Mode:

• Click once with the left mouse button.

11.8.3 Moving the IR Laser beam via the 
Keyboard

Depending on whether you want to move IR laser 
beam "1" or IR laser beam "2" (Double Beam Sys-
tem with two 3D movable IR lasers only), you will 
need to use different key combinations.

To move the IR laser beam "1" with the key-
board:

• Press the Shift key and one of the four arrow 
keys together. The IR laser beam "1" will con-
tinue to move until you release the key. 

This allows you to move the IR laser beam "1" up, 
down, and to the left and right. If you press the 
shift key and two arrow keys simultaneously 
(e.g.,↑→), you can also move the IR laser beam 
diagonally.

To move the IR laser beam "2" with the key-
board:

• Press the Ctrl key and one of the four arrow 
keys together. The IR laser beam "2" will con-
tinue to move until you release the key. 

This allows you to move the IR laser beam "2" up, 
down, and to the left and right. If you press the 
shift key and two arrow keys simultaneously 
(e.g.,↑→), you can also move the IR laser beam 
diagonally.

3D-1, 3D-2

Info:
The cursor is not displayed in 3D-1[3D-2] 
Mode. In 3D-1 [3D-2] Mode you can alter the 
speed of the 3D Laser Beam Positioning and the 
power of the laser beam using keyboard com-
mands, and also change the focus with the 
scroll wheel on the mouse. (Note that you can 
only change the settings for the laser beam 
that is selected in Laser Tools.) Several func-
tions can also be accessed via the context 
menu. 



128 PALM RoboSoftware 3.1-0106 (EN)



PALM RoboSoftware 3.1-0106 (EN) 129

General Introductory Remarks

12 Working with Fluorescence (Option)

A supplementary fluorescence unit is available as 
an option. According to the configuration this is 
suitable for the following applications:
- Configuration "Basic": non-simultaneous appli-

cation of fluorescence and laser functions.
- Configuration "Advanced": a simultaneous 

application of fluorescence and laser functions 
is possible.

For more information about the application and the 
basic settings refer to the User Manual.

12.1 General Introductory Remarks

The procedure to use for working with fluores-
cence illumination depends on the way your sys-
tem is configured. The differences concern the 
manipulation of the microscope (motorized or 
manual version) and the fluorescence shutter or 
filter wheel respectively.

If your system is equipped with a motorized micro-
scope, you can control all the elements that you 
need to adjust specifically in order to use the fluo-
rescence illumination via PALM RoboSoftware. 
When using a manual microscope you have to 
make the settings on the microscope manually; 
the functions of the filter wheel and the shutter are 
controlled by the PALM RoboSoftware; In other 
words, you can select the desired excitation filter 
or close and open the shutter via a program com-
mand.

12.2 Settings for Working with Fluo-
rescence - Manual Microscope

In order to use the fluorescence illumination, you 
must
- switch on the fluorescence illumination (refer to 

User Manual)
- select the desired fluorescence excitation filter 

(necessary when using a filter wheel, only; 
refer to chapter 12.8.3)

- swivel in the desired reflector position in the 
microscope (refer to User Manual)

- switch the microscope light on or off as neces-
sary

- activate the timer (if you want to preset a time 
for which the excitation light should illuminate 
your sample; refer to chapter 12.7), and

- open the shutter (chapter 12.6).

12.3 Settings for Working with Fluo-
rescence - Motorized Microscope

In order to use the fluorescence illumination, you 
must
- switch on the fluorescence illumination (refer to 

User Manual)
- select the desired fluorescence filter unit (chap-

ter 12.4 "Activating a Fluorescence Settings 
Record"). With this the functions "(Excita-
tion)filter", "Reflector position", "Microscope 
light", "Timer" and "Shutter" are performed via 
a single command.
The basic settings of these functions have been 
made during installation of your PALM system. 
The PALM RoboSoftware provides you with the 
capability of saving various combinations of 
these parameters and retrieving them when 
they are needed (chapter 12.9).

Note!
Close the shutter (chapter 12.6) before 
switching on the fluorescence lamp and 
before finishing or interrupting your work. 
This will prevent unintentional exposure of 
your sample to fluorescence light.

Note!
Close the shutter (chapter 12.6) before switch-
ing on the fluorescence lamp and before finish-
ing or interrupting your work. This will prevent 
unintentional exposure of your sample to fluo-
rescence light.



130 PALM RoboSoftware 3.1-0106 (EN)

Activating a Fluorescence Settings Record

12.4 Activating a Fluorescence Set-
tings Record

You can activate a fluorescence settings record as 
follows:

• Open the drop-down list "FL:" in "Fluorescence 
Tool" and select the desired settings record.

The selected settings record is activated, i.e. all 
the settings defined in this record are implement-
ed (to change the settings, see chapter 12.9).

12.5 Freeze Mode

With the Freeze Mode of the PALM RoboSoftware 
you can display the actual fluorescence image on 
the monitor and edit it (for example, by drawing a 
freehand line or marking objects), while the fluo-
rescence light is switched off again. In this way 
sensible fluorescence samples are protected from 
fading.

To switch into and out of Freeze Mode:

• Click on menu item "Freeze Mode" in the 
"Move" menu.

With this menu command you can toggle between 
"Freeze Mode" and "Cursor Mode".

After editing the freezed image, you can exit the 
Freeze Mode to perform a laser function or to 
observe other areas with fluorescence.

Note!
In the "Basic" configuration with the manual 
microscope the "Fluorescence Tool" is not ac-
tive.

Note!
When using a manual microscope only the set-
tings of the filter wheel and the shutter are ac-
tivated. The position of the reflector revolver 
and the microscope illumination has to be 
switched on manually on the microscope.

Note!
In Freeze Mode, all functions for moving the 
stage or functions that cause a movement of 
the stage, e.g. all positioning functions as well 
as all laser functions are blocked. In this way, 
an unintentional movement of the stage is pre-
vented. 

Note!
Before switching on a laser function, a position 
with a beam splitter, suitably coated for this 
wavelength, must be swiveled into the reflector 
revolver of the microscope. For systems with 
the fluorescence configuration "Basic" this is 
the first position only. 
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12.6 Opening and Closing the Shutter

You can open and close the shutter via a menu 
command or an icon button. However, you can use 
the timer function (chapter 12.7) to preselect a 
time after which the shutter is to be closed again 
automatically after you have opened it.

To open and close the shutter on the filter 
wheel via icon buttons:

• Click on the "Shutter" icon button in "Fluores-
cence Tools".

The shutter will be opened or closed depending on 
its position before the command was sent.

To open and close the shutter on the filter 
wheel via a menu command:

• In the "Setup" menu, click on menu item 
"Shutter ... ".

The "Fluorescence Shutter" window will open. The 
window contains three fields displaying a number 
of buttons:
- "Shutter Type" field: information about the 

manufacturer
- "Shutter Error" field: if there are problems with 

the shutter, messages will be displayed here.
- "Actual state" field: this indicates whether the 

shutter is currently open or closed.
- Buttons: for opening and closing the shutter 

and to close the window.

• Click on the "Close" button to close the shutter 
or on the "Open" button to open the shutter.

• Close the window by clicking on "OK".

Note!
In the "Basic" configuration with the manual 
microscope the function "Shutter" is not ac-
tive. In this case the shutter has to be oper-
ated manually (at the microscope stative).

Shutter 
(Closed: Shutter is currently closed)

Shutter 
(Open: shutter is currently open)

Info:
There is only one button for opening and clos-
ing the shutter. Its appearance changes ac-
cording to the current status.
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12.7 Activating and Deactivating the 
Timer

PALM RoboSoftware includes a timer for your use. 
Use the timer to set the shutter to close again 
automatically after a period defined by you when 
you have opened it.

• Click on the "Timer" icon button in "Fluores-
cence Tools".

This opens the "Shutter - Timer" window.

This contains a checkbox for activating and deac-
tivating the timer and an input field for setting the 
time for which the shutter is to remain open.

A tick in the "Close shutter automatically after:" 
checkbox indicates that the timer is activated.
• Click in the checkbox to add or remove the tick. 

Enter the entire period for which the shutter is to 
be open in the "Seconds" field.
• Click in the "Seconds" field to enter the time or,

click on the left or right arrow key beside the 
field to shorten or extend the time.

• Close the window by clicking on "OK".

12.8 Fluorescence Filter

The "Fluorescence Filter" window contains infor-
mation about the installed filter wheel and the 
installed filters. You can also make changes to the 
settings there:

12.8.1 Information About the Installed 
Filter Wheel

• In the "Setup" menu, click on menu item 
"Filter ... ".

The "Fluorescence Filter" window will open. 

This window contains information about the 
installed filter wheel and the installed filters. You 
can also make changes to the settings here:
- "Filter Type" field: Information on the manufac-

turer of the filter wheel (Ludl or microscope)
- "Filter Error" field: This is where error mes-

sages are displayed in the event of problems 
with the filter

- "Actual Position" field: This shows which filter is 
currently in the fluorescence beam path. You 
can also select the desired excitation filter here 
(refer to chapter 12.8.3, for instructions on how 
to proceed).

Note!
In the "Basic" configuration with the manual 
microscope the function "Timer" is not active.

Timer

Note!
In the "Basic" configuration with the manual 
microscope the function "Fluorescence Filter" 
is not active.
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- "Filter Colors (and Names)" list: Information 
about the existing filters (up to six, if a Ludl fil-
ter wheel is installed, up to eight if a micro-
scope filter wheel is installed). 

- You can make or change any entry yourself in 
the "Color" column (refer to chapter 12.8.2 
"Specifying Names for the Fluorescence 
Excitation Filters", for instructions on how to 
proceed).
If you have installed a microscope filter wheel, 
the names that were specified in the control 
program for the microscope appear in the 
"Name" column. If you have installed a Ludl fil-
ter wheel, this column is empty.

12.8.2 Specifying Names for the 
Fluorescence Excitation Filters

You can specify names for your installed fluores-
cence excitation filters (e.g color names). If you 
subsequently select an excitation filter the names 
you specified will appear in the selection list.

• In the "Setup" menu, click on menu item 
"Filter ... ".

The "Fluorescence Filter" window will open. 
• In the table, double-click in the row of the filter 

for which you want to change the color informa-
tion contained in the "Color" column.

• Enter the desired name for the filter.
• Repeat for all filters which you want to rename.
• To confirm your change, click "OK".

The window will close. 

12.8.3 Selecting a Fluorescence Excita-
tion Filter

The fluorescence excitation filter can be selected 
separately via the drop-down list "FL".

• In the "Setup" menu, click on menu item 
"Filter ... ".

• The "Fluorescence Filter" window will open.

• Open the drop-down list "Actual Position" and 
select the desired position.
In the drop-down list all possible filter settings 
are listed. If you have entered names for the fil-
ters as described in chapter 12.8.2 "Specifying 
Names for the Fluorescence Excitation Filters", 
the names will be listed, otherwise they will be 
numbered from 1 to 6.

The filter wheel will move automatically to the 
selected filter position.
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12.9 Editing a Fluorescence Settings Record

If you need certain settings and sequences for flu-
orescence more frequently, you can 
save them as a settings record. You can create and 
save as many of these records as you wish. You 
can assign a name to each setting. These names 
will then appear in the "Fluorescence Tool" in a 
selection list in the "FL:" field. With this selection 

list you can then activate a saved settings record 
as described in chapter 12.4.

12.9.1 Creating a New Settings Record

• In the "Setup" menu, click on menu item 
"Fluorescence ... "

This opens the "Fluorescence" window. This con-
tains a table and a number of buttons. The table 
lists your saved settings, including the sequential 
number and name as well as the settings made for 
the "Filter", "Reflector", "Shutter" and "Light" 
parameters. The sequential number is increment-
ed by one automatically for each new entry that 
you create. The buttons are used for entering and 
editing the settings records.

• In the table, double click in the row with the 
entry "(new)", or
click once in the row with the "(new)" entry and 
then click on the "Change" button, or

Click on the "Insert" button.

This opens the "Fluorescence Entry" window. This 
contains several fields in which you can enter a 
name for your new settings record or in which you 
can select settings for the parameters "Filter", 
"Reflector", "Shutter" and "Light" from selection 
lists.

Note!
In the "Basic" configuration with the manual 
microscope these functions are not active.

Info:
A new entry is always added at the end of the 
list over the "(new)" row. If you have already 
created entries, you can select one of the ex-
isting entries with a click of the mouse. If you 
then create a new record using the "Insert" 
button, a new record will be inserted above 
the marked record.
You can change the order of the records as 
will be explained later.
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When you create a new settings record, every field 
is populated by default with "don't care". This set-
ting means that no change will be made to the cur-
rent setting for the respective part when you 
activate the settings record as described in chapter 
12.4.
• Enter any name for your settings record in the 

"Name:" field.
• Open the drop-down lists "Filter", "Shutter", 

"Reflector" and "Light" one after another and 
select the desired menu items. 

You can define the entries of the drop-down list 
"Filter" on your own (refer to chapter 12.8.2 
"Specifying Names for the Fluorescence Excitation 
Filters").

The entries of the drop-down list "Reflector" are 
prescribed in the control program for the 
microscope (available with the motorized micro-
scope only).

The three setting options for the shutter have the 
following effect if you activate one of the saved flu-
orescence settings records as described in chapter 
12.4:
- OPEN: the selected filter will be targeted, then 

the shutter will be opened.
- CLOSE: the shutter will be closed, then the 

selected filter will be targeted. The shutter then 
remains closed.

- CLOSE-OPEN: the shutter will be closed, then 
the selected filter will be targeted. The shutter 
is then opened again.

The setting for "Light" controls the microscope illu-
mination, not the fluorescence lamp (available 
with the motorized microscope only).

• Close this window by clicking on "OK".

An item now appears in the Fluorescence window 
with your settings.
• Repeat in the same way if you want to create 

more settings records.
• Close the "Fluorescence" window by clicking on 

"OK".

The window will close, your new items will be 
saved.
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12.9.2 Changing a Settings Record

You can change a settings record at any time. To 
do so, proceed as for creating a new record:
• In the "Setup" menu, click on menu item 

"Fluorescence ... "

This opens the "Fluorescence" window.
• Double-click on the row in the table containing 

the settings record that you want to change, or
click once in this row and then click on the 
"Change" button.

This opens the "Fluorescence Entry" window.
• Make your changes as described above and 

click on "OK" to close the window.

The window will close, the changed entry will 
appear in the table of the "Fluorescence" window.
• Close this window as well by clicking on "OK".

The window will be closed, your changed entry will 
be saved.

12.9.3 Deleting a Settings Record

• In the "Setup" menu, click on menu item 
"Fluorescence ... "

This opens the "Fluorescence" window.
• Click on the row in the table containing the set-

tings record that you want to delete.

• Click on "Delete".

The selected settings record will be deleted.
• Close the "Fluorescence" window by clicking on 

"OK".

12.9.4 Changing the Sequence of 
Entries in the List

• In the "Setup" menu, click on menu item 
"Fluorescence ... "

This opens the "Fluorescence" window.

• Click on the row in the table that contains the 
record you want to move up or down.

• Click on the "Up" or "Down" button depending 
on the direction in which you want to move the 
entry.

The entry will be moved, all entries will be renum-
bered.

12.10 Adjusting the Reflector Offset

If you have set or changed a reflector for fluores-
cence, the microscope image on the monitor may 
appear to be shifted slightly, although the stage 
has not been moved. If you now draw elements 
and then change the reflector again, your 
elements will not be positioned correctly. The 
automatic laser functions will then not process 
exactly the areas you wish. 

You must compensate for this by setting the Re-
flector Offset. With that you move all existing ele-
ments.

It may be possible that you do not see the struc-
tures of the elements with normal illumination. In 
this case you have to draw a reference element on 
a point of your sample, that is to be seen with both 
types of illumination.

To adjust the Reflector Offset:

• Draw the required elements with fluorescence 
illumination. Draw at least one element on a 
point, that is to be seen with normal illumina-
tion, also. Suitable for this is any type of ele-
ment, for example "Freehand" or "Dot" (refer to 
chapter 7.2.3 "The Freehand Tool" or chapter 
7.2.7 "The Dot Tool"). This element serves as a 
reference for the Reflector Offset.

• Switch off the reflector and the fluorescence 
illumination.

• Move the stage so that the reference element 
and the corresponding point on your sample is 
displayed on the monitor.

• If it is not yet active, select the Pointer Tool in 
the Graphic Toolbar.

• Click on menu item "New Reflector-Offset" in 
the "Setup>Calibration" menu.

Note!
Please note that on adjusting the Reflector 
Offset all existing elements are really moved, 
not only the elements drawn with fluores-
cence illumination. If you wish to draw ele-
ments under normal as well as fluorescent 
lighting you should first check whether the 
Reflector Offset is set correctly.

Pointer Tool
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All available elements are automatically selected 
and surrounded by a selection rectangle (the se-
lection rectangle is indicated by a white line). You 
will receive the following prompt: "Step 1 of 2: 
Click Selection Rectangle".
• Click on any dot within the selection rectangle 

and hold the mouse button down.

You will receive the following message: "Step 2 of 
2: Now move the Figure to the new position!"
• Move the element or elements (holding down 

the mouse button) so that your reference ele-
ment is matches the respective structure of 
your sample. When you have moved the win-
dow to the desired position, release the mouse 
button.

Then, even elements that are outside the current 
monitor section will be moved. 
The following message will appear: "New Reflector 
Offset is set!" This message will disappear auto-
matically after a few seconds.

You can restore the default factory settings for the 
Reflector Offset at any time.

To reset the Reflector Offset:

• Click on menu item "Factory Reflector-Offset" 
in the "Setup>Calibration" menu.

A prompt will appear: "Do you really want to reset 
to Factory Reflector Offsets?"
• Confirm with "Yes".

The default factory settings for the Reflector Offset 
will be restored immediately.

Info:
If you have drawn elements that are currently 
positioned outside of the monitor section, some 
or all of the borderlines of the selection rectan-
gle will also be outside the monitor section. In 
this case the border lines are not visible. 

Note!
If you click inside the rectangle and inadvert-
ently do not hold the mouse button down, the 
selected elements will not be moved to the cor-
rect position. In this case, reset the Reflector 
Offset as explained below and start the opera-
tion again.

Note!
The Reflector Offset will also be reset if you re-
store the factory default settings (refer also to 
chapter 3.5 "Restoring Settings").
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13 Control Microscope (Zeiss Axiovert 200M)

If you have purchased a system with a motorized 
microscope, you can also control settings via PALM 
RoboSoftware. For that, the "Microscope Tools" in 
the main window as well as the "Microscope Win-
dow" are available. You can open it by menu 
command or via an icon button.

The "Microscope Tools" enable you to make the 
most frequently used settings; the "Microscope 
Window" offers additional setting options.

If you are using an ApoTome on your microscope, 
its current status can be displayed on the monitor.

13.1 The "Microscope Tools"

Via the "Microscope Tools" you can make the most 
frequently used settings directly in the main win-
dow:
1 switching the Autofocus on and off (in case 

the microscope is equipped with this func-
tion). If the Autofocus is switched on, with 
each change of the objective and with each 
targeting of an element during a laser func-
tion the image is focused automatically.

2 releasing the automatic focusing. As soon as 
you click on the button, the image is focused.

3 defining the focus setting "Work Position" 
(refer to chapter 13.2.3 "Defining and Set-
ting Fixed Positions for the Focus")

4 setting the focus to any position.
This parameter can also be set using the 
mouse: keeping the right mouse button 
pressed, roughly set the focus with the 
mouse wheel; fine adjustment can be per-
formed with the mouse wheel and the left 
mouse button held down.

5-7 setting the focus to Load Position (5), Work 
Position (6) and Check Position (7) (refer to 
chapter 13.2.3 "Defining and Setting Fixed 
Positions for the Focus")

8 switching the microscope lamp on and off
9 opening and closing the shutter on the 

microscope (transmitted light shutter, 
optional)

10 setting the color temperature of the micro-
scope lighting to 3200 K

11 setting the intensity of the microscope lamp

Caution!
Set the focus to "Check Position" only if you 
have previously moved the stage to the 
Check Point as described in chapter 5.5 "The 
Check Point". Otherwise the objective will col-
lide with the slide or the stage and may be 
damaged.

1

3

4

5 6 7

8

11

2 9

10
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13.2 The "Microscope Window"

Via the "Microscope Window" you can make the 
following settings:
- Selecting an objective
- Switching the lamp on and off
- Setting the focus to any position
- Setting the speed with which the focusing is 

performed.
- Set the focus to one of three defined positions 

(Load Position, Work Position, Check Position)
- Position of the reflector
- Position of the condenser
- Aperture diaphragm and speed with which the 

aperture diaphragm is set
- Filter selection
- Opening and Closing the Shutter
- Settings for the beam path (sideport or base-

port)
- Settings for the Optovar.

To open the "Microscope Window":

• Click on menu item "Microscope Window" in the 
"View" menu.

The window "Microscope ... " opens (the 
designation of the window depends on the type of 
the microscope your system is equipped with).

13.2.1 Setting Objective, Reflector, 
Condenser and Filter

You select the magnification objective, filter and 
condenser as well as the desired position of the re-
flector in the same way.
• Open in the "Objective", Reflector", "Con-

denser" or "Filter" row (depending on which 
setting you want to change) the drop-down list 
and select the desired entry.
Click on one of the arrow buttons on the right 
side to change to the next or previous setting.

13.2.2 Setting the Focus

You can either adjust the focus almost constantly 
in small steps of about 1µm each, or you can de-
liberately target defined positions (Load Position, 
Work Position, Check Position). If your microscope 
is equipped with autofocus you can perform the fo-
cusing automatically.

These setting options are also available in the "Mi-
croscope Tools".

Additionally, in the "Microscope Window" you can 
set the speed with which the focusing is per-
formed.

To set the speed of focus setting:

• Drag the slider "Speed" to the desired value.

To set the focus:

• If you want to make small changes, click in 
"Focus" row on the left or right arrow key to 
adjust the focus up or down; If you want to 
make extensive changes, click on the left or 
right arrow key and keep the mouse button 
pressed down until the focus has reached the 
desired position.

The focus will be adjusted. In the field on the left, 
the current position is displayed.

Info:
The setting options available to you in detail 
depend on the configuration of your system. 

Info:
The entries in the lists are made in the control 
program for the microscope and can only be 
changed there.
If only the entry "<none>" is available in a 
list, this means that the corresponding part is 
not motorized in your system and therefore 
cannot be set via PALM RoboSoftware.
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To focus automatically:

• Click on the "AF" button in the "Focus" row.

13.2.3 Defining and Setting Fixed Posi-
tions for the Focus

You can target three defined focus positions: two 
of it are freely definable, the third position is pre-
scribed:
- Work Position (freely-definable): The objective 

is set so that the focus is in the same plane as 
the slide.
In this position you can view your sample on 
the monitor or in the ocular of the microscope.

- Check Position (freely-definable): The objective 
is set such that the focus is on the same plane 
as the cap, into which your samples are cata-
pulted using the LPC functions. In this position 
you can check the results of the catapulting.

- Load Position (prescribed): The objective is 
moved into the lowest possible position. In this 
position, you can, for example, move the stage 
to the check point and back or change the slide 
without any fear of hitting the objective with 
the slide.

To define the Check Position:

• Set the focus to Load Position (refer to chapter 
13.2.3 "Defining and Setting Fixed Positions for 
the Focus").

• Move the stage to the Check Point (refer to 
chapter 5.5 "The Check Point").

• Set the focus so that a catapulted sample in the 
cap is displayed sharply.

• Click on menu item "CheckPos" in the "Focus > 
Define" menu.

• Set the focus to Load Position again.
• Move the stage back from Check Point.

To define the Work Position:

• Set the focus so that your sample is displayed 
sharply.

• Click on menu item "WorkPos" in the "Focus > 
Define" menu.

To set the focus to one of the default settings:

• Click on the desired menu item in the "Focus" 
menu ("CheckPos", "WorkPos" or "LoadPos").

The focus is set to the corresponding position.

Info:
This function is only available if your micro-
scope has an autofocus facility.

Info:
The exact setting of the focus is variable for 
various objectives. However, you only have to 
define the setting of the Work Position for one 
objective: The differences with the other ob-
jectives are automatically compensated. To 
achieve this, the parfocality must be adjusted 
correctly in the microscope (see microscope 
manual).
However, if you are working with slides or 
samples of different thicknesses, you may 
have to readjust the focus.

Caution!
Set the focus to "Check Position" only if you 
have previously moved the stage to the 
Check Point as described in chapter 5.5 "The 
Check Point". Otherwise the objective will col-
lide with the slide or the stage and may be 
damaged.

Caution!
Using a non-motorized microscope: If you 
want to return the stage from the Check 
Point, you must set the Load Position manu-
ally, so that the objective does not collide 
with the slide (refer to chapter 5.5 "The Check 
Point" for instructions on moving the stage to 
the Check Point and back).

Caution!
Set the focus to "Check Position" only if you 
have previously moved the stage to the 
Check Point as described in chapter 5.5 "The 
Check Point". Otherwise the objective will col-
lide with the slide or the stage and may be 
damaged.
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13.2.4 Setting the Aperture Diaphragm 

The aperture diaphragm can be adjusted with the 
motor. The speed of the adjustment is selectable.

• Move the slider in the "Aperture" row to the 
desired position (to the left: slower, to the 
right: faster).

• Click on the left or right arrow key in the right 
border of the line to close or open the aperture 
diaphragm.

The aperture diaphragm will be adjusted. In the 
field on the left, the current position is displayed.

13.2.5 Switching the Lamp On and Off

• Click on the "Lamp" icon button, or
click on the required item "Switch Lamp ON" or 
"Switch Lamp OFF" in the "Lamp" menu.

13.2.6 Setting the Intensity of the Lamp

• Move the slider in the "Light:" row to the 
desired position or click on one of the arrow 
keys (to the left: reducing intensity, to the 
right: increasing intensity).

13.2.7 Opening and Closing the Shutter

• Choose "Open/Close Reflected Light Shutter" or 
"Open/Close Transmitted Light Shutter" from 
the "Shutter" menu.

The shutter will opened or closed respectively.

13.2.8 Setting the Beam Path

With the computer, you can set the beam paths 
that are to be cleared on the sideport and the 
baseport. The settings that you must make de-
pend on the configuration of your system (refer to 
the manual for the microscope).

• Click on the desired menu item in the "Light-
Path" menu ("Sideport" or "Baseport") and 
select the desired entry in the submenu.

The selected setting will be made.

Lamp (Lamp On)

Lamp (Lamp Off)

Info:
The "Open/Close Reflected Light Shutter" 
command is only included on the menu if your 
system is equipped with a fluorescence unit.

Note!
If you want to work with the laser, the shutter 
must be open.
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13.2.9 Setting the Optovar

With the Optovar you can set an additional magni-
fication for the microscope image (if your micro-
scope is equipped with an Optovar). 

• Click on menu item "1x (First Pos)" in the 
"LightPath > Optovar" menu.

The Optovar is set to position "1x".

13.2.10 Pre-Settings for the Microscope

You can specify a range of settings that will be 
made automatically when PALM RoboSoftware is 
launched and closed:
- Reflector
- Condenser
- Filter
- Shutter
- Lamp
- Baseport and sideport.

• In the menu bar of the "Microscope Window", 
click on "Setup".

The "Microscope Setup" window opens.

On the left there is a list of the microscope parts 
for which you can make prior settings. There are 
two groups of fields in the middle and one on the 
right, in which you can specify the setting you 
want for the respective part, which is to be select-
ed automatically when PALM RoboSoftware is 
launched or closed. Every field contains a drop-
down list containing all the possible settings for the 
respective microscope part. In addition, each in-
cludes an entry "don't care". If you select this en-
try, the setting that is currently active at the time 
PALM RoboSoftware is launched or closed, will be 
the one that is retained.

If all the current settings are to be retained when 
PALM RoboSoftware is launched or closed:
• Click on the "Don't care" button under "Star-

tup" or "Shutdown".

All entries in the fields for "Startup" or "Shutdown" 
will be set to "Don't care".

If certain settings for the individual parts of the 
microscope are to be made automatically when 
PALM RoboSoftware is launched or closed:
• Open the respective drop-down list (Reflector, 

Condenser, Filter, Shutter Reflected/Transmit-
ted, Lamp, Baseport, Sideport) and select the 
desired setting (of course the selection options 
for launching and closing of PALM 
RoboSoftware are the same).

• To close the "Microscope Setup" window, click 
"OK".

Note!
If you want to work with the laser, the Opto-
var must be in position "1x", otherwise the la-
ser will "see" a different image than you see 
in the ocular or on the monitor.

Info:
Other settings for the Optovar can only be 
made manually on the microscope.

Info:
The entries in the lists are made in the control 
program for the microscope (apart from shut-
ter and lamp) and can only be changed there.
If only the entry "<none>" is available in a 
list, this means that the corresponding part is 
not motorized in your system and therefore 
cannot be set via PALM RoboSoftware.
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13.3 Status Display ApoTome

If your microscope is equipped with an ApoTome, 
and if the ApoTome is configured in the "Micro-
scope Toolbox", a status display will appear below 
"Microscope Tools". The displays are as follows:

The ApoTome is set up in such a way that the light 
beam can pass through it unrestricted. With this 
setting you can work with the laser without risk of 
damage to the ApoTome.

The ApoTome is set up in such a way that the grid 
is positioned in the beam path.

The ApoTome controller is switched off. In this 
case the PALM RoboSoftware has no information 
on the status of the ApoTome.

Info:
The laser beam would destroy the grid. If the 
grid is swiveled in, the laser is automatically 
switched off and no laser function can be 
started.

Note!
Check the status of the ApoTome before 
switching the laser on. The grid must not be 
positioned in the beam path as it would be de-
stroyed by the laser.
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3D Laser Beam Positioning

Using the 3D Laser Beam Positioning function on the 
IR laser, you can move trapped objects in both the 
x and y axes, ie, parallel to the plane of the slide.

AutoCircle

Cutting along a circular line and catapulting the 
entire area into the center of the circle with a pulse 
of the laser.

AutoLPC

Automatic catapulting of larger areas of samples 
mounted on glass. With glass-samples only a li-
mited amount of cell material per laser pulse can 
be catapulted out with one laser shot. Larger areas 
have to be catapulted with multiple laser pulses. 
The distance between individual laser pulses de-
pends on tissue properties and is preselected in 
the "LPC Parameter" window.

Center

The center point of the microscope image displayed 
on the monitor. It may be marked with crosshairs. 
The crosshairs can be displayed or hidden with the 
"Screen Center" command in the "View" menu.

Check Point

A position of the stage. If you target the Check 
Point, the circular opening of the stage is positio-
ned within the beam path of the microscope (only 
Stage II). After catapulting the sample into the cap 
it can be observed with the microscope through 
this opening.

Check Position

Freely-definable focus setting of the microscope, 
to set by a menu command (motorized microscope 
only). The setting should be defined so that the ca-
tapulted sample in the cap is displayed sharply on 
the monitor or in the ocular.

Close&Cut

Closing and Cutting. An incompletely closed ele-
ment is automatically closed and cut completely 
according to the given conditions.

Close&Cut + AutoLPC

Closing the marking line and cutting before cata-
pulting. With critical samples, the marked area 
must first be detached from its immediate surroun-
dings by a clear cut line. Only in this way can pure 
sample preparation be assured when catapulting.

This function can only be used with glass-mounted 
samples.

Cut

Cutting along a selected line. The laser cuts pre-
cisely along the pre-drawn line, so that a clear line 
of detachment is created between required and 
unrequired material. In the cut area, all biological 
material is destroyed by ablation. Thus a pure 
sample preparation can be carried out without fear 
of contamination.

Double Beam System

The PALM MicroTweezers is available as a single 
beam or a double beam system. In the double 
beam system, the IR laser beam is split into two 
beams. Depending on the configuration, one or 
both of the beams is equipped with a 3D Laser 
Beam Positioning. This means that you can trap 
two objects and move them relatively towards 
each other. You can select different power and fo-
cus values for each of the two split beams.

Element

An element is a drawing on your monitor. Ele-
ments serve to define selected areas for the appli-
cation of laser functions, to annotate selected 
points of the microscope image, to measure length 
and areas and to define reference points. Accor-
dingly, the program distinguishes six types of ele-
ments: Figure, Dot, AutoCircle, Ruler, Text and 
Reference Point.

Figure

The element types "Line", "Freehand", "Rectangle" 
and "Circle" are known collectively as element type 
"Figure".

JointCut

As with function Close&Cut the laser cuts the 
sample along defined lines. Start and end dot of an 
open path figure are connected by a straight cut 
line. It remains a joint between start and end dot. 
With this function geometrical figures can be cut. 
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The cut area remains fixed within the tissue. The 
entire area can be catapulted later by a single laser 
pulse.

Laser Marker

There is a Laser Marker for each laser beam. Its tip 
should display the point where the laser beam 
meets the sample when released. For a fixed laser 
beam such as the UV laser and the IR laser beam 
without 3D Laser Beam Positioning, this is roughly 
the middle of the monitor; for a beam that is 3D-
movable, this point may be located elsewhere.

PALM RoboSoftware calculates the cutting func-
tions of the UV laser from the position of the Laser 
Marker. The position of the Laser Marker should 
therefore always match that of actual laser focus. 
Only then the correct results can be achieved with 
the automatic laser functions. In the same way, 
you will only be able to trap objects reliably with 
the IR laser and – if your system is equipped with 
such – move them precisely with the 3D Laser 
Beam Positioning if the position of its Laser Marker 
is correctly set. You should therefore check the po-
sition of the Laser Marker before you start work.

The position of the Laser Marker may vary with dif-
ferent objectives.

Laser Microdissection and Laser 
Pressure Catapulting (LMPC)

This technology combines microdissection, in 
which the samples are cut out with zero contact, 
with Laser Pressure Catapulting (LPC).

Laser Pressure Catapulting (LPC)

With a single laser pulse, objects marked with an 
LPC dot are aimed and catapulted into a cap. 

Load Position (Stage)

Position of the stage on which the slide holder or 
slide respectively can be changed. The stage can 
be moved to the load positon and back by a menu 
command (only Stage II).

Load Position (Focus)

Default focus settings of the microscope, which 
can be set by a menu command (motorized micro-
scope only): lowest possible position of the objec-
tive. Before the stage is moved to its Load Position 
or to the Check Point, the Load Position of the ob-
jective must be set to avoid damage to the objec-
tive or the stage and the slide respectively.

Reference Position (IR Laser)

The Reference Position of the IR laser is the point 
at which the laser beam hits the sample. The as-
sociated Laser Marker must be referenced to this 
point. When you have set the position for the Laser 
Marker, you have also defined its Reference Posi-
tion.

The Reference Position assumes particular impor-
tance with a PALM MicroTweezers System with 3D 
Laser Beam Positioning. With this configuration, 
you move the laser beam to the Reference Position 
with a menu command.

Reference (Stage)

PALM RoboSoftware uses the Reference Position of 
the stage as the point of origin for calculating the 
coordinates of your elements. 

With each start of the controller the stage is mo-
ved to the end positions in x- and y-direction. This 
position is defined as a reference point automati-
cally. The Reference Position is retained for as long 
as the controller unit remains switched on, and 
even if you shut down and restart the PALM Robo-
Software. 

RoboLPC

With RoboLPC an object is detached and 
catapulted into a cap in a single operation (only 
possible with membrane-mounted samples). The 
drawn line is completely closed. Then the laser first 
cuts along the line but leaves a narrow joint. The 
width of this joint can be preselected in the "LPC 
Parameters" window. The joint is displayed on the 
monitor with an LPC dot. Finally the sample is 
catapulted from here.

Single Beam System

The PALM MicroTweezers is available as a single 
beam or a double beam system. The single beam 
system configuration is equipped with one IR laser 
beam, and may optionally include 3D Laser Beam 
Positioning.

Work Position

Freely-definable focus setting of the microscope, 
to set by a menu command (motorized microscope 
only). The setting should be defined so that the 
sample is displayed sharply on the monitor or in 
the ocular.
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Keyboard 
Shortcuts

Icon Button/Menu Command

F1 Help > PALM Robo Help

F2 Open Imaging ...

File > Open Imaging ...

F3  Information Center

File > 
Open Information Center ...

Alt+F4 File > Exit PALM Robo

F4 Navigator Window

View > Navigator Window

F5 Element List 

View > Element List

F6 Microscope Window

View > Microscope Window

F7 Stage

Move > Stage Mode

F8 Move > Setup Speed ...

F9 Laser > 
Energy & Focus (UV-Laser) ...

F10 Laser > 
Energy & Focus (IR-Laser) ...

F11 Start Laser function

Laser > Start Laser function

Ctrl+F11 Laser selected elements 
(context menu)

Ctrl+A Edit > Select All / DeSelect All

Ctrl+C Edit > Copy

Keyboard 
Shortcuts

Icon Button/Menu Command

Ctrl+E View > Menus > Speed Tools

Ctrl+F Move > Speed faster.

Ctrl+G View > Menus > Graphic Tools

Ctrl+K Move > 
Goto Check-Point / Return

Ctrl+L View > Menus > Laser Tools

Ctrl+N File > New Elements

Ctrl+P ColorPalette On/ Off

View > Menus > Color Palette

Ctrl+S Move > Speed slower

Ctrl+U View > Menus > Cut Tools

Ctrl+V Edit > Paste

Ctrl+Y Delete all unprocessed 
elements

Edit > Delete all unprocessed 
elements

Alt+P Toggle switch between standard 
pointer and reference pointer

Alt+Enter Edit > Change

Alt+F Freeze Mode

Move > Freeze Mode

Backspace Delete last element

Edit > Delete last element

Alt+Back-
space

Edit > Undelete

Del  Delete selected elements

Edit > Delete selected elements
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Keyboard 
Shortcuts

Icon Button/Menu Command

End Laser > Focus down

Esc Stop

Move > Stop

Home Laser > Focus up

Page up Laser > Energy/Power more

Page Down Laser > Energy/Power less
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Numerics

3D Laser Beam positioning
function 145

3D Mode
exit 127
keyboard 127
select 127
set speed 125
toggle between 3D-1 and 3D-2 127

3D Offset 125
3D Mode 127
define Reference Position 122
keyboard 127
set speed 125
target Reference Position 123

A

ApoTome, status display 144

Autofocus
activate 104, 139
automatic focusing 141
deactivate 104, 139

AxioVision 11, 54

C

Calibration
3D Offset 35
movement of stage 34
reset 36

Catapult 95

Cellenger 11, 53

Center 145

Centering tool 41

Centric Attribute 60

Change color 77

Check Point 145
define 47
return to original position 47
target 47

Check Position
define 141
meaning 141
set 139, 141

Color Palette 75

Combination
IR laser focus 118

Comment
add 73
change 73

Context Menu 17

Control microscope 139

Copyright Note
specify 87

Copyright note
switch display on/off 16

Crosshairs
show/hide 15

Cursor Mode
select 40

Customize
Element List 64
User Interface 15

Cut 95

D

Database Mode
change database 10
change to File Mode 10
Information Center 8
load elements 84
PALM RoboSoftware 10
save elements 84
save images 90

Delete elements
all 68
any 69
last drawn 69

Deselect elements (element list) 68

Detail scan 51
go to overview scan 51

Index
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Double Beam system 145

Draw elements
AutoCircle 61
circle 60
dot 60
line 60
line (freehand) 59
measuring line 80
rectangle 60
Reference Point 59
resume 70
text 61

E

Element List
customize display 64
display of the element types 64
information of the elements 62
open 62
overview of functions 65

Element types
AutoCircle 58
dot 58
line 58
Reference Point 58
ruler 58
text 58

Elements
add comment 73
add elements to a group 79
center 66
change color 77
change comment 73
change/correct shape 71
copy 72
create new set 56
definition 145
deselect (monitor) 67
display 65
draw 58
edit 70
export 85
group 78
hide 65
import 85
load 83
merge 71
naming 73
number 73
print 86
process 68
remove from a group 79
reposition 70
reposition (Scroll function) 41
restore 69, 72

resume 70
rotate 72
save 81
select within a group 79
set color 74
set color for new elements 75
set dot thickness 76
set line thickness 74, 76
settings for saving (File Mode) 81
show anchor points 70
stretch 72
stretch and rotate 72
switch on and off numbering 73
types 58
ungroup 79
update numbering 73
z-Focus 25

Enabling
software components 27

Export of elements 85

F

Factory defaults 27

File Mode
change to Database Mode 10
Information Center 8
load elements 82
PALM RoboSoftware 10
save elements 82
save images 89

Fluorescence
adjust Reflector Offset 136
filter wheel 132
name of filter 133
reset Reflector Offset 137
selecting a Fluorescence Excitation Filter 133
settings 129
shutter 131
timer 132
working with fluorescence 129

Fluorescence settings
create new set 134
delete 136
edit 136

Fluorescence Tool 130

Footswitch
IR laser 123
UV laser 116

Freeze Mode 130

Functionality 7
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G

Graphic Tool
activate 59
AutoCircle 61
circle 60
dot 60
freehand 59
line 60
rectangle 60
Reference Point 59
ruler 80
text 61
types 58

Group of elements
add elements 79
forming 78
remove elements 79
select single elements 79
ungroup 79

H

Help
general 18
PALM RoboInstructor 18

I

Imaging Software
incorporating 28
start 11

Import of elements 85

Information Center
functionality 8
start 11

Initial settings 23
mode 23

Installation 9

K

Keyboard shortcuts
summary 147

L

Laser (IR)
3D Offset 125

combination focus 118
move objects in z-axis 124
set focus using the mouse 120
settings 117
switch on and off 124

Laser (UV)
continue 110
stop 110

Laser energy (UV)
link Cut and LPC 102
set 102

Laser focus (IR)
set 118
set with the mouse 120

Laser focus (UV)
link Cut and LPC 102
set 102

Laser functions (UV)
AutoCircle 96
AutoLPC 95
Close&Cut 95
Close&Cut+AutoLPC 95
Cut 95
JointCut 95
LPC 95
preview 98
RoboLPC 95
select 97
set number of operations 98
start 108

Laser Marker
change appearance 16
meaning 146

Laser power (IR)
set 118

Laser settings (IR)
find suitable values 122
footswitch 123
power and focus 118

Laser settings (UV) 100
energy and focus 102
find suitable values 106
footswitch 116
general 104

Laser Tools
IR laser settings 119
settings for UV laser 102

Lens Offset
adjust 36
reset 37

Licensing 27

Line tool 60
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Index

Linking
Cut and LPC energy and focus 102

Load elements 83

Load Position
return to original position 48

Load Position (objective)
meaning 141
set 139, 141

Load Position (stage)
define 48
targeting 48

M

Measuring 80
area 80
length of lines 80

Microscope (motorized)
Activate autofocus 141
activate autofocus 139
adjust light intensity 139, 142
Check Position, meaning 141
default settings 143
define Check Position 141
define Work Position 139, 141
Load Position, meaning 141
set aperture diaphragm 142
set beam path 142
set Check Position 139, 141
set focus 139, 140
set Load Position 139, 141
set Optovar 143
set Work Position 139, 141
speed for focus setting 140
switching the lamp on and off 139, 142
Work Position, meaning 141

Microscope Tools 139

Microscope Window 140

Mode 18
3D Mode 127
Cursor Mode 40
Stage Mode 39

N

Naming (element) 73

Navigator
launching and exiting 49
load scanned image 52
overview scan 50
save scanned image 52

scan a detail 51
scanning sample 50
show elements 51

O

Optovar 143

Overview scan
go to detail scan 51

P

PALM RoboInstructor 18

Position marking (text element) 61

Position stage 39
center elements 66
centering tool 41
in Stage Mode 39
keyboard 41
return from Check Point 47
return from Load Position 48
scroll 40
scroll bar 41
set speed 43
stop movement 42
target Check Point 47
target Load Position 48
with mouse (in Stage Mode) 39
with mouse (Scroll) 40

Preview of UV laser functions 98

Print elements 86

Program
exit 10
functionality 7
general help 18
installation 9
layout 13
operation 17
PALM RoboInstructor 18
software modes 18
standard configuration 13
start 10

Q

Quadratic Attribute 60, 80

R

Reference 146
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Index

Reference Position (3D Offset)
define 122
meaning 146
target 123

Reflector Offset
adjust 136
reset 137

Restoring deleted elements 69

Ruler 80

S

Save elements 81

Save images 89, 90
automatic during laser function 90
Copyright Note 87
create folder 88
manual 89, 90
select folder 88
specify file name 89
Time Lapse 91

Scale bar
switch display on/off 15

Scanning
detail 51
interrupt scan 51
load scanned image 52
overview 50
show elements 51
store scanned image 52

Screen Center
show/hide 15

Scroll bar
position stage 41

Scroll Rectangle
show/hide 15

Select elements (element list)
all 68
single or multiple 68
within a group 79

Select elements (monitor) 67
all 67
deselect selection 67
multiple 67
single 67
within a group 79

Serial Sections
edit elements 113
function 110
prepare samples 111

reference elements of original sample 111
reference elements of target sample 113
transfer elements automatically 114
transfer elements manually 115

Set color 74
color window 74
current elements 77
for new elements 75

Set dot thickness 76

Set Laser Marker 32

Set line thickness 76

Set magnification 32

Set RoboLPC joint 105

Set speed (3D Offset) 125
increment 127
keyboard commands 126
menu commands 126
PALM Robo speed window 125
Speed Tools 126
units 125

Set speed (stage) 43
increment 45
keyboard commands 45
menu commands 45
PALM Robo speed window 44
Speed Tools 44
units 43

Settings 23
adjust Reflector Offset 136
automatic saving 26
fluorescence 129
initial settings 23
Laser Marker 32
Lens Offset 36
magnification 32
reset calibration 36
reset Lens Offset 37
reset Reflector Offset 137
restore (factory defaults) 27
save elements (File Mode) 81
save images (automatic) 90
slideholder 24
UV laser 100

Short-term alarm 28

Single Beam system 146

Slideholder
settings 24

Software modes 18
3D Mode 127
Cursor Mode 40
Stage Mode 40

Speed Tools 44, 126
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Index

Stage
reference 146

Stage Mode
exit 40
invert movement 39
select 40
set speed 43

Status Bar 14

Status display 21

T

Time Lapse function 91
cancel 93
settings 91

Toolbars
reposition 15
show/hide 15

Tools
Fluorescence Tool 130
Laser Tools 119
Microscope Tools 139
show/hide 15
Speed Tools 44, 126

U

User Interface
customize 15

V

Video sequence
Time Lapse 91

W

Window
colors 17, 74
Element List 62
Laser Marker layout 16
LPC parameters 105
microscope window 140
PALM Robo information 20
PALM Robo IR laser settings 120
PALM Robo laser settings 103
PALM Robo speed 44, 125
states 21
System Info 20

Work Position
define 139, 141
meaning 141
set 139, 141

Z

z-Focus 25


